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Chapter 1. Managing people
In IBM® Cognos® Analytics, you can manage user authentication and access to content and product
features.

The administrator that configures your Cognos Analytics application does the initial security setup.
This setup includes configuring authentication providers to take advantage of the existing security
infrastructure in your organization. Each authentication provider that is configured for use with Cognos
Analytics is referred to as a namespace or an external namespace.

In addition to namespaces that represent the external authentication providers, IBM Cognos Analytics
has a built-in, internal namespace that is named Cognos. The Cognos namespace simplifies the process
of managing access permissions and deploying content. Finally, if the Easy install option was used to
install IBM Cognos Analytics, you can create users in the Cognos Users namespace.

Cognos Analytics can also be configured for anonymous access where users are not required to provide
user ID and password to access the application. For information about enabling anonymous access, see
the IBM Cognos Analytics Installation and Configuration Guide.

Important: Your environment might have a large number of users. As a best practice, the users should be
grouped into folders, and each folder should contain a maximum of 1000 users.

The Users, Groups, and Roles administration capability is required to manage accounts. For more
information, see “User capabilities” on page 126.

The Cognos namespace and the Cognos Users namespace
The Cognos namespace includes predefined objects to help you quickly set up initial security. The Cognos
Users namespace allows you to create and manage users who are not part of an authenticated external
namespace.

You use the predefined objects and other features of the Cognos namespace for ongoing security
management.

The Cognos namespace can contain groups and roles. A group is a collection of users. Users can either be
members of an authenticated external namespace or of the Cognos Users namespace, if the Easy install
option was used to install IBM Cognos Analytics. Members of groups can be users and other groups. A
role is a collection of capabilities that identify the tasks that a user can perform. Members of roles can be
users, groups, and other roles. A user can belong to several groups or roles. When a user is a member of
more than one group, access permissions are merged.

The following diagram shows the structure of groups and roles in the Cognos namespace.

Role

User

Group

Group Group RoleUser

Figure 1. Structure of groups and roles

You can create groups and roles in the Cognos namespace. The Cognos Users namespace is available
only if the Easy install option was used to install IBM Cognos Analytics. If available, you can create users
in the Cognos Users namespace.



Predefined and built-in objects in the Cognos namespace
Initial access permissions are applied to all predefined objects. You can modify the permissions from the
object properties.
Anonymous

This user is for the initial configuration where anonymous access is enabled and users are not
prompted to provide credentials. When anonymous access is disabled in Cognos Configuration, a user
logs in using their own credentials.

All Authenticated Users
This group represents users who are authenticated by authentication providers. The membership of
this group is maintained by the product and cannot be viewed or altered.

Everyone
This group represents all authenticated users and the Anonymous user account. The membership of
this group is maintained by the product and cannot be viewed or altered. You can use the Everyone
group to set default security quickly. For example, to secure a report, you grant read, write, or execute
permissions to the report for the Everyone group. After this security is in place, you can grant access
to the report to other users, groups, or roles, and remove the group Everyone from the security policy
for this report.

Analysis Users
Members of this role have the same access permissions as Consumers. They can also use the IBM
Cognos Analysis Studio.

Analytics Administrators

Members have the same access permissions as Analytics Explorers. They can also access:

• Manage > Data Server Connections
• Data source connections in the Administration Console
• IBM Cognos Software Development Kit.

This role is available only after a custom installation.

Analytics Explorers

Members have the same access permissions as Analytics Users. They can also access Planning
Analytics For Microsoft Excel, Cognos Framework Manager, Cognos Cube Designer and Dynamic Query
Analyzer, Transformer, and TM1 Writeback to bundled FLBI TM1 server.

This role is available only after a custom installation.

Analytics Users

Members have the same access permissions as the Analytics Viewer members. They can create new
reports, dashboards, stories, new jobs, data server connections, or data modules. They can execute
reports, respond to prompts, upload files. They can also access Cognos for Microsoft Office, Cognos
Workspace, Cognos Insight, Cognos Event Studio, Cognos Query Studio, and Cognos Analysis Studio

This role is available only after a custom installation.

Authors
Members of this role have the same access permissions as Query Users and Analysis Users. They can
use Reporting, Query Studio, and Analysis Studio, and save public content, such as reports and report
outputs.

Consumers
Members of this role can read and execute public content, such as reports.

Directory Administrators
Members of this role can administer the contents of namespaces. In the Cognos namespace, they
administer groups, accounts, contacts, distribution lists, data sources, and printers.
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Analytics Viewers

Members have the same access permissions as Query Users and Analysis Users. They can use
Reporting, Query Studio, and Analysis Studio, and save public content, such as reports, dashboards,
and stories.

This role is available only after a custom installation.

Library Administrators
Members of this role can access, import, and administer the contents of the Library tab in IBM Cognos
Administration.

Mobile Administrators
Members of this role can administer IBM Cognos Analytics Mobile Reports.

Mobile Users
Members of this role can access IBM Cognos content, such as reports, through IBM Cognos Analytics
Mobile Reports.

Modelers
Members of this role have access to the web-based modeling capabilities.

Portal Administrators
Members of this role can administer the Cognos portlets and other portlets. This includes customizing
portlets, defining portlet styles, and setting access permissions for portlets.

PowerPlay Administrators
Members of this role can administer the public content, for which they have full access. They can also
administer and use IBM Cognos PowerPlay.

PowerPlay Users
Members of this role have the same access permissions as Consumers. They can also use IBM Cognos
PowerPlay.

Query Users
Members of this role have the same access permissions as Consumers. They can also use the IBM
Cognos Query Studio.

Readers
Members of this role have read-only access to IBM Cognos software. They can navigate some portions
of the content store, view saved report outputs in the portal, and use some report option such as
drill-through.

Report Administrators
Members of this role can administer the public content, for which they have full access. They can also
use IBM Cognos Analysis Reporting and IBM Cognos Query Studio.

Server Administrators
Members of this role can administer servers, dispatchers, and jobs.

System Administrators

Members of this role are considered root users or super users. They may access and modify any
object in the content store, regardless of any security policies set for the object. Only members of the
System Administrators role can modify the membership of this role.

The initial configuration for this role includes the Everyone group. You must modify the initial security
settings for this role and remove the group Everyone from its membership. If you do not change the
initial configuration, all users have unrestricted access to the content store.

Tenant Administrators
Members of this role can perform tenant administration tasks. This role is used in a multitenant IBM
Cognos environment. In the initial configuration, this role has no members and capabilities. Only
System Administrators can add members and assign access permissions and capabilities for this role.
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Standard roles
The table in this section lists the predefined standard Cognos roles. Standard roles each have specific
capabilities that allow users to perform different tasks in IBM Cognos Analytics.

References:

• For a list of default capabilities assigned to each standard role, see “Initial access permissions for
capabilities” on page 136.

• To modify the membership of standard roles, see “Securing System Administrators and standard roles”
on page 126.

• Another type of role is a license role. Based on license entitlements, there are four license names:
Analytics Administrator; Analytics Explorer; Analytics User; and Analytics Viewer. For more
information, see “License roles” on page 176.

Table 1. Predefined Cognos standard roles

Standard role Description

Analysis Users Members have the same access permissions as Consumers. They
can also use the IBM Cognos Analysis Studio.

Authors Members have the same access permissions as Query Users and
Analysis Users. They can use Reporting, Query Studio, and Analysis
Studio, and save public content, such as reports and report outputs.

Consumers Members can read and execute public content, such as reports.

Directory Administrators Members can administer the contents of namespaces. In the Cognos
namespace, they administer groups, accounts, contacts, distribution
lists, data sources, and printers.

Library Administrators Members can access, import, and administer the contents of the
Library tab in IBM Cognos Administration.

Mobile Users Members can access IBM Cognos content, such as reports, through
IBM Cognos Analytics Mobile Reports.

Mobile Administrators Members can administer IBM Cognos Analytics Mobile Reports.

Modelers Members can use the modeling user interface to create and manage
data modules.

Portal Administrators Members can administer the Cognos portlets and other portlets. This
includes customizing portlets, defining portlet styles, and setting
access permissions for portlets. Portal administrators can also
upload extensions that allow users, for example, to add images to
reports or dashboards.

Planning Contributor Users Members can access the Contributor Web client, Contributor Add-in
for Microsoft Excel, or Analyst.

Planning Rights Administrators Members can access Contributor Administration Console, Analyst,
and all associated objects in the application.

Query Users Members have the same access permissions as Consumers. They
can also use the IBM Cognos Query Studio.
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Table 1. Predefined Cognos standard roles (continued)

Standard role Description

Readers Members have read-only access to IBM Cognos software. They can
navigate some portions of the content store, view saved report
outputs in the portal, select cells in saved report outputs in Cognos
Viewer, and use Cognos Viewer context menu to perform actions,
such as drill-through.

Report Administrators Members can administer the public content, for which they have full
access. They can also use IBM Cognos Analytics - Reporting and IBM
Cognos Query Studio.

Server Administrators Members can administer servers, dispatchers, and jobs.

System Administrators Members can access and modify any object in the content store,
regardless of any security policies set for the object. Only members
of the System Administrators role can modify the membership of this
role.

Creating and managing groups and roles
You can create new groups and roles in the Cognos namespace. These roles are not dependent on the
authentication providers and can be managed only in IBM Cognos Analytics.

You can add users, groups, or roles from multiple external namespaces and from the Cognos Users
namespace, if available, as members of the Cognos groups and roles.

Before you begin
When you plan to add entries from multiple namespaces as members of the Cognos groups and roles, log
on to each namespace before you start this task.

About this task
When you delete a Cognos group or role, users' access permissions based on it are no longer active. You
cannot restore access permissions by creating a group or role with the same name.

You need the Users, Groups, and Roles administration capability to manage accounts. For more
information, see “User capabilities” on page 126.

Note for Cognos Analytics on Demand users:

• The Standard built-in groups and roles in the Cognos namespace do not exist.
• You cannot change the capabilities of a user, group, or role. Capabilities are determined by the user's on

Demand subscription level.

Procedure
1. Click Manage > People > Accounts.
2. Click the Cognos namespace to open it.

3. Click the new group  or new role  icon, type a unique name for it in the space that is provided,
and press the enter key. The group or role is added to the list of entries in the Cognos namespace.

Tip: You can also create groups and roles within folders. Click the new folder  icon to create a new
folder.
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4. Add members individually to the new group or role in the following ways:
a) Locate the new group or role in the Cognos namespace. To quickly find the entry:

• Type text in the  Find field.

Note: You can click the Search Method icon  to find entries that either contain, start with, or
are an exact match with the text that you type.

• Click the Type  icon to narrow the view of entries.

b) From the group or role More  menu, click View members, and click  Select.
c) In the Add members panel, click the required namespace and locate the user, group, or role that

you want to add. You can add members from any namespace or multiple namespaces that you are
logged in to. If necessary, use the search and filter functions to find the user, group, or role to add.

d) Select the required users, groups, or roles. You can control-select multiple entries. Click OK. The
selected entries are displayed on the Members tab.

5. To perform a bulk import of multiple members to the members tab, follow these steps:

a) Click  Import.
b) In the Bulk import users panel, enter one or more member names, separated by semicolons (;).

Use the format namespace/[account | group | role]

Tip: To specify account, enter the user's given name that appears in the Name column after you
select People > Accounts > namespace_name.

c) Click  Import.
d) Click Done.

6. To remove a member, point to its name, and click the remove  icon.

The group or role now includes members. It can also be added to another group or role.

What to do next
The group or role More  menus provide options to manage these entries. In Properties, on the
Permissions tab, you can set access permissions for the groups and roles. The View members option
allows you to add or remove members of a group or role, and the Add to option allows you to add the
entry to another group or role, or to a folder. With the Copy or move option, you can copy or move the
entry to another location in the namespace. To delete the group or role, use the Delete option.

Creating and managing users
You can create users in the Cognos Users namespace if the Easy install option was used to install IBM
Cognos Analytics.

Procedure
1. Click Manage > People > Accounts.
2. Click the Cognos Users namespace to open it.

3. Click the new user  icon, and in the New user dialog box, type the required information, including
the user ID and password. Click OK.

The user name is added to the list of entries in the Cognos Users namespace. You can now add the
user to a folder, group, or role. The user can log on to IBM Cognos Analytics with the user ID and
password that you assigned for him or her.
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What to do next
A user's More  menu provides options to manage the user entry. In Properties, on the General tab
in the Advanced properties section, you can change the user password. Also in Properties, on the
Permissions tab, you can set access permissions for the user. The Add to option allows you to add the
user to a group, role, or folder. To delete the user, use the Delete option.

Customizing roles
If you are using the roles that are predefined in the Cognos namespace, you can customize themes, home
pages, and report parameters that are unique to each Cognos role.

Note: Only Cognos roles are customizable. You cannot customize a role unless it belongs to the Cognos
namespace - as either a predefined Cognos role, or one that you created yourself. For more information
about Cognos roles, see the IBM Cognos Analytics Administration and Security Guide.

You can specify that a customized home page, or a particular report or dashboard, be displayed when
a user with a particular Cognos role opens IBM Cognos Analytics. You may want to remove default user
interface features for roles. In addition, you can customize parameters that can be used across reports
and tailor them for each user role.

Before setting customized themes and home pages (other than a dashboard or report) you must have
created and uploaded custom themes or home pages. For more information, see Chapter 9, “Customizing
Cognos Analytics across all roles,” on page 195.

To customize individual roles, from Manage > People > Accounts, click a namespace to view the list of

roles for the namespace. If you click a role's More  menu and select Properties, the slide-out panel for
that role has a Customization tab.

Note: If you want to set customizations across all roles, you use the Managing > Customization slide-out
panel. For more information, see “Applying themes, extensions, and views” on page 223.

Setting a default home page
Click  next to the default home page. You can now browse for a dashboard or report to be the default
home page, or you can select a view in the list of views to be the default home page for all users in this
role.

Hiding menu options for a feature
You can hide some menu options for a feature from users in specified roles. Click  next to Features. A
list of views is displayed. This list includes both the built-in views and any custom views that have been
uploaded. Click a view to see a high-level grouping of features for the view. Click  next to a grouping to
drill-down to a lower level of features. You can deselect or select any feature in this list, or drill-down to
another set of features to choose from. Click Apply to save your changes. You can revert your changes by
clicking Reset to defaults.

Important: When you hide a menu item for a feature via customization, you do not change any user's
capability to perform or not perform the action of the menu item. In some cases, a user can access the
same functionality from a different location in the user interface. In other words, hiding a menu item does
not apply security rules to a feature. To apply role-based security, you must assign capabilities. For more
information, see “User capabilities” on page 126.

To customize the navigation menu in reporting, expand Reporting > Collections > Report.

Setting a default theme
Click  next to the default theme. You can select a theme in the list of themes to be the default theme for
all users in this role.
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Creating a custom folder
Click  next to Custom folder to set a custom content folder for users who have this role. When a user
with this role logs in, the custom folder is displayed on the navigation bar below Team content.

Setting the default location for uploaded files

Click  next to Default upload location to specify a folder in Team content as the default location for
uploaded files for users who have this role.

Setting the default data source to be used by the Assistant
Click  next to Default source to specify an asset in Team content that the Assistant can use as a
default data source for the selected role.

Setting default parameters for roles
Click Settings next to Parameters. A list appears of parameters that you customized. Choose the
parameters that you want to configure for the role. Then select the default values that you want to appear
for all users in this role. Click Apply then OK when you are done.

For more information, see "Using customized parameters" in the IBM Cognos Analytics Reporting Guide.

Resolving conflicts when a user has multiple roles
A user may have multiple roles which can have different default themes or home pages. To resolve this
issue, when setting customizations for a role, click Advanced and set a priority for the role ranging from
0 to 10. In the case of a conflict the customizations for the role with the highest priority are used. The
System Administrators role has a hard-coded priority of 1000.

Example 1: Removing the Export to PDF feature from the Analysis Users role
In this example, the administrator removes the Export to PDF option in the application bar from Analysis
users who want to share dashboard content.

Procedure
1. Check the default behavior.

a) Log on as an Analysis user and open a dashboard.

b) Click the Share button in the application bar.
The Share pane opens.

c) Click the Export tab.
The Export to PDF options appear, as shown in the following diagram.
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2. Remove the Export to PDF feature for Analysis users.
a) Log on as an administrator.
b) Go to Manage > People > Accounts, and click the Cognos namespace.

c) Click the More button  next to the Analysis Users role.
d) Click  Properties.
e) Click the Customization tab.

f) Click the chevron button  after Features.

g) Click the chevron button  before Dashboard to expand the list.

h) Click the chevron button  before Application bar to expand the list.

i) Click the chevron button  before  Share to expand the list.
j) Deselect the Export to PDF check box.

The Cognos Analytics window appears as follows:
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k) Click Apply.
3. Confirm that the feature was removed.

a) Log on as an Analysis user and open the same dashboard.

b) Click the Share button  in the application bar.
The Share pane opens with no Export tab, as shown in the following diagram.

Results
The feature that you selected was removed for the role that you specified.

Note: Affected users must log out and then log back in before the change is reflected in their view of the
product.
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Example 2: Restricting users from viewing the on-demand toolbar
The administrator can disable the on-demand toolbar from selected users, groups, or roles.

About this task
For information about hiding the on-demand toolbar for a specific report, regardless of who is viewing it,
see "Disabling the on-demand toolbar" in the IBM Cognos Analytics Reporting Guide.

Important: Turning off the on-demand toolbar will cause certain aspects of certain reports to become
unavailable in HTML view. For example, if a report has both drill-through and drill-down enabled, only
drill-through will be available to anyone looking at the report who has their on-demand toolbar disabled
by either

• the following administration procedure
• the procedure to disable the toolbar for a specific report

Procedure
1. Log on as an administrator.
2. Go to Manage > People > Accounts, and click the Cognos namespace.

3. Click the More button  next to the Authors role.
4. Click  Properties.
5. Click the Customization tab.

6. Click the chevron button  after Features.

The Features panel appears. However, you're not sure where in the Features tree to find the on-
demand toolbar.

Tip: You can use the Search field to find the feature that you want to enable or disable.

7. In the Search field , type on-demand.

The search results show that you can control the on-demand toolbar appearance in reports and/or
dashboards.

8. Deselect the check box next to Reporting > Collections > On-Demand Toolbar.
9. Click Apply.
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Results
The on-demand toolbar does not appear for Reporting users who belong to the Authors role.

Note: Affected users must log out and then log back in before the change is reflected in their view of the
product.

Example 3: Disabling a modeling feature for a role
You can choose to make certain modeling features unavailable to selected roles.

For information about all Cognos Analytics modeling features, see "Data modeling in Cognos Analytics" in
the IBM Cognos Analytics Data Modeling Guide.

In the following example, you do not want modelers to use newly uploaded files that reside on their local
computers. You can prevent them from uploading local files to Cognos Analytics. As a result, any modeling
that they perform on uploaded files will use only files that were previously uploaded to Cognos Analytics.

Procedure
1. Log on as an administrator.
2. Go to Manage > People > Accounts, and click the Cognos namespace.

3. Click the More button  next to the Modelers role.
4. Click  Properties.
5. Click the Customization tab.

6. Click the chevron button  after Features.

The Features panel appears.

7. Click the chevron buttons  for Data module > Navigation Bar > New.
8. Deselect the check box next to Upload files.
9. Click Apply.

Results
The Upload files option is no longer available on the New menu for users who belong to the Modelers
role.

Note: Affected users must log out and then log back in before the change is reflected in their view of the
product.

Example 4: Disabling the Run all at once option in jobs
You can prevent users from creating a job in which every report is run at once.

For information about jobs, see "Creating a job to schedule multiple entries" in the IBM Cognos Analytics
Getting Started Guide.

Example

In this example, you want to prevent reports in a job from running simultaneously to improve your
server performance. You decide to disable the Run all at once option in jobs created by people in the
Analytics Explorers role.

Procedure
1. Log on as an administrator.
2. Go to Manage > People > Accounts, and click the Cognos namespace.

3. Click the More button  next to the Modelers role.
4. Click  Properties.
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5. Click the Customization tab.

6. Click the chevron button  after Features.

The Features panel appears.

7. Click the chevron buttons  for Jobs > Collections.
8. Deselect the check box next to Run all at once.
9. Click Apply.

Results
The Run all at once option is no longer available in the Run options panel of jobs created by users in the
Analytics Explorers role.

Note: Affected users must log out and then log back in before the change is reflected in their view of the
product.

Example 5: Hiding an item in the New menu
You can hide one or more menu items in the New menu.

For example, you want to remove the New menu items Data module and Exploration for users with the
Modelers role.

Procedure
1. Log on as an administrator.
2. Go to Manage > People > Accounts, and click the Cognos namespace.

3. Click the More button  next to the Modelers role.
4. Click  Properties.
5. Click the Customization tab.

6. Click the chevron button  after Features.

The Features panel appears.

7. Click the chevron buttons  for Explore > Navigation Bar > New.
8. Deselect the check boxes next to Data module and Exploration.
9. Click Apply.

Results
The items Dashboard and Story no longer appear in the New menu.

Note: Affected users must log out and then log back in before the change is reflected in their view of the
product.

Authentication providers
User authentication in IBM Cognos Analytics is managed through authentication providers. Authentication
providers define users, groups, and roles that are used for authentication. User names, IDs, passwords,
regional settings, personal preferences are some examples of information stored in the providers.

In the Cognos Analytics user interface, authentication providers are represented by namespaces .

Cognos Analytics supports the following types of authentication providers:

• Active Directory
• OpenID Connect
• Custom Java Provider
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• OpenID Connect Authentication Proxy
• IBM Cognos Series 7
• LDAP
• SAP
• SiteMinder

Authentication providers are configured in IBM Cognos Configuration, under the Security >
Authentication category. After the provider namespace is added there, and the IBM Cognos service
is restarted, the namespace name is displayed in Manage > People > Accounts, and users can log on to
Cognos Analytics using that namespace. For more information about configuring authentication providers,
see the IBM Cognos Analytics Installation and Configuration Guide.

You cannot create users, groups, or roles in authentication providers' namespaces from Cognos Analytics.
However, you can add users, groups, and roles from these namespaces to groups and roles in the Cognos
namespace.

Multiple namespaces
If multiple namespaces are configured for Cognos Analytics, at the start of a session you must select
one namespace. However, this does not prevent you from logging on to other namespaces later in the
session. For example, if you set access permissions, you may want to reference entries from different
namespaces. To log on to a different namespace, you do not have to log out of the namespace that you
are currently using. You can be logged on to multiple namespaces simultaneously.

Your primary logon is the namespace and the credentials that you use to log on at the beginning of the
session. The namespaces that you log on to later in the session, and the credentials that you use to do
that, become your secondary logons.

When you delete one of the namespaces, you can log on using another namespace. If you delete all
namespaces except for the Cognos namespace, you are not prompted to log on. If anonymous access is
enabled, you are automatically logged on as an anonymous user. If anonymous access is not enabled, you
cannot access the logon page. In this situation, use Cognos Configuration to enable anonymous access.

Managing OpenID Connect namespaces
Use the OpenID Connect namespace type to implement OpenID Connect authentication for IBM Cognos
Analytics.

Cognos Analytics supports the following OpenID Connect identity providers:

• ADFS (Active Directory Federation Services)
• Azure AD (Active Directory)
• Generic
• Google
• IBM Cloud Identity
• IBMid (IBM identity provider)
• MS Identity
• OKTA
• Ping
• SalesForce
• SiteMinder

IBMid is the IBM Identity Service, a cloud-based identity access and management solution that provides
identity and single sign-on services for IBM applications.
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After an OpenID Connect namespace is configured in IBM Cognos Configuration, all OpenID Connect
users have access to Cognos Analytics. When the users log on, their names are automatically shown in the
namespace.

Note: To set up an OpenID Connect namespace successfully, ensure that the Content Manager computer
can access the OIDC IDP (Identity Provider). In some cases, if there is a proxy between the Content
Manager and the IDP, Content Manager will not be able to connect.

As a system administrator, you might need to restrict the number of users who can access the product
based on the number of licenses or other factors. To do that, perform the following optional steps:

• Add a limited number of users to the OpenID Connect namespace.

See step“3” on page 15 below.
• Add groups to the OpenID Connect namespace.

See step “4” on page 16 below.
• Add the OpenID Connect users to groups or roles in the Cognos namespace.

By using the Cognos groups and roles, you can quickly assign the required access permissions for
different users.

• In IBM Cognos Configuration, under Security > Authentication, set the Restrict access to members of
the built-in namespace property to true.

Only members of the built-in Cognos namespace can now access Cognos Analytics.

Procedure
1. Log on to IBM Cognos Analytics as a system administrator.
2. Log on to the OpenID Connect namespace.
3. To add user accounts to the OpenID Connect namespace:

a) Navigate to Manage > People > Accounts, and open the OpenID Connect namespace.
b) To add an individual user account, follow these steps:

• Click the New user icon .

The Add users panel appears.
• Enter a unique name in the Unique identifier field.

For example, enter the user's email address.
• In the Preferred Name field, enter the name that you want to appear in the namespace list.
• Click Add.

The Preferred Name value appears in the namespace list.
c) To add multiple user accounts at once, you can import a .csv file specially formatted with account

information:

• Ensure that you created the .csv file that contains your user information.

For more information, see “Creating a .csv file containing user account information” on page 16.

• Click the Import icon  and then select Import users.
• Double click the .csv file that has the user information.

The file is uploaded and the defaultName values from the .csv file are listed in the OpenId
Connect namespace.

The same .csv file can be imported many times. If a defaultName value already exists in the
namespace, the user account is updated. You can also repeat the import if previously imported
entries look incorrect.
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Repeat this step for other files, if you have multiple files.
4. To add groups to the OpenID Connect namespace:

a) Navigate to Manage > People > Accounts, and open the OpenID Connect namespace.
b) To add individual groups, follow these steps:

• Click the New group icon .
• Enter the name of the new group.

The group name is listed in the namespace.
c) To add multiple groups at once, you can import a .csv file specially formatted with group

information:

• Ensure that you created the .csv file that contains your group information.

For more information, see “Creating a .csv file containing group information” on page 17.

• Click the Import icon  and then select Import groups.
• Double click the .csv file that has the group information.

The file is uploaded and the defaultName values from the .csv file are listed in the OpenId
Connect namespace. The same .csv file can be imported many times. If a group already exists
in the namespace, the group is updated. You can also repeat the import if previously imported
entries look incorrect.

Repeat this step for other files, if you have multiple files.
5. Add the OpenID Connect users to groups or roles in the Cognos namespace.

a) Open the Cognos namespace, and find the group or role to which you would like to add users from
the OpenID Connect namespace.

b) From the group or role context menu , select View members.

c) Click Select.
d) In the Add members panel, select your OpenID Connect namespace, and then select the

appropriate users. You can select multiple users at once.
e) Click Add. The selected users are displayed on the Members tab.
f) Repeat the steps to add the OpenID Connect users to other Cognos groups or roles.
g) To import users from a .csv file, click Import, and select the file. For more information, see

“Creating a .csv file containing user account information” on page 16.

The same .csv file can be imported many times. If a user account already exists in the namespace,
the account is updated. You can also repeat the import if previously imported entries look incorrect.

Repeat this step for other files, if you have multiple files.

6. Delete an entry by clicking Delete in the context menu  next to the specific group, role, or folder.

Results
Users who use the OpenID Connect namespace to log on to Cognos Analytics are redirected to an
external logon page where they can type their credentials. If the credentials are accepted, the users can
access Cognos Analytics.

Creating a .csv file containing user account information
The .csv file that contains the list of users to be imported into the OpenID Connect namespace must be
properly formatted for the import to be successful.

The .csv file must use these formats:
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• UTF-8 character encoding
• Windows CRLF for line breaks

The first row in the file is the header. This row must contain the email column, and can contain
the following, optional columns: defaultName, businessPhone, faxPhone, givenName, homePhone,
mobilePhone, pagerPhone, postalAddress, surname, userName.

Tip: All of the column names are properties of the account class in IBM Cognos Analytics. The names are
case sensitive, and must be typed exactly as specified in this document.

All other rows in the file contain values corresponding to the columns specified in the first row.

Here is an example of a .csv file with two users:

• Row 1: email,defaultName,givenName,surname
• Row 2: Andy.Bergin@ca.ibm.com,Andy Bergin,Andy,Bergin
• Row 3: Kirsten.Vaughan@ca.ibm.com,Kirsten Vaughan,Kirsten,Vaughan

You can add all your users to one .csv file, or you can create multiple files with fewer names in each file.

After the file is imported, the defaultName for the user is set in the following way:

• If defaultName is specified in the .csv file, the name is used.
• If defaultName is not specified in the .csv file, but givenName and surname are specified, the default

name is set as givenName surname.
• If defaultName, givenName, and surname are not specified, the email is used as the default name.

Multiple users can have the same first and last names. To avoid potential conflicts, specify a different
defaultName for the users, or do not specify surname and givenName for them. You can also modify
the surname by adding a unique character or number to it, such as Simpson1 or Simpson2.

Note: Properties are automatically updated from the namespace provider when the user logs in.
Therefore, if the namespace supports properties such as timeZone or localePreference, they are saved in
the account proxy when the user logs in.

Creating a .csv file containing group information
A group .csv file contains the list of groups to be imported into the OpenID Connect namespace. This file
must be properly formatted for the import to be successful.

The .csv file must use these formats:

• UTF-8 character encoding
• Windows CRLF for line breaks

The first row in the group .csv file is the header. This row must contain both the type and defaultName
columns. The header row can also contain the following, optional column: tenantID.

Tip: All of the column names are properties of the group class in IBM Cognos Analytics. The names are
case sensitive, and must be typed exactly as specified in this document.

All other rows in the file contain values corresponding to the columns specified in the first row.

Here is an example of a .csv file with two groups:

• Row 1: type,defaultName
• Row 2: group,Reviewers
• Row 3: group,Data-Scientists

You can add all your groups to one .csv file, or you can create multiple files with fewer groups in each file.

Chapter 1. Managing people  17



Finding users, groups, and roles
As an administrator, you often need to locate the users, groups, or roles that you manage.

In the Namespaces view in Manage > People > Accounts, you see all namespaces that are configured for
use with IBM Cognos Analytics, the Cognos namespace, and the Cognos Users namespace, if applicable.
You can navigate only the namespaces that you are logged in to, and the Cognos and Cognos Users
namespaces.

Searching for entries
A namespace might contain thousands of users and numerous groups, roles, and folders, and the only
way to find these entries is by using the search capability in Accounts. You must search for entries in one

namespace at a time so you need to select the namespace first, and then type text in the  Find field.

You can click the Search Method icon  to find entries that either contain, start with, or are an exact
match with the text that you type. The search is also used when you add members of groups and roles,
specify access permissions, and so on.

Filtering entries
You can filter on users, groups, and roles to narrow your view of entries. When using with search, specify
the filter criteria for faster response. Click the filter  icon and select or clear the filter options.

Sorting entries

Click the Sort icon . You can then specify that search results are sorted by name, by date modified, or
by type. You can also choose whether the results appear in ascending or descending order.

Tip: As search results appear, you can change your options for search method, filtering, and sorting. The
results update dynamically with each change that you make.

Paging
If your namespaces have many entries, and you enabled account entries to be loaded by pages, you can
navigate more quickly between pages to find the entries you want.

Creating contacts, distribution lists, and folders
Create contacts and distribution lists for people who can be recipients when reports are delivered by
email.

Use distribution lists if you want to send a report to more than one recipient at a time. Distribution lists
contain a collection of users, groups, roles, contacts, or other distribution lists.

If a recipient is not part of the IBM Cognos security system, you can create a contact for this person. The
contacts you create can also be assigned as contacts for reports. You can create folders to organize your
entries in a logical way.

Note that if you choose the email recipient from a list, such as a group, role, or distribution list, you must
have read access to both the list and the recipient's email account. Otherwise, the report delivery fails.

Creating contacts
If a recipient is not part of the IBM® Cognos® security system, you can create a contact for this person.

Procedure
1. Click Manage > People > Contacts.
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2. Click the New icon , and then click Contact .
3. Enter the name and email address of the person.
4. Click Create.

The contact name appears in the Contacts panel.

What to do next
As you would with a user name in the Cognos Users namespace, you can click a contact's More icon ,
click Properties, and then have these options:

• On the General tab under Advanced, you can disable or hide the contact.
• On the Preferences tab, you can specify the contact's default format, their time zone, and the language

of their Cognos Analytics content.
• On the Permissions tab, you can set access permissions for the contact. For more information, see

“Setting access to capabilities” on page 171.

You can also add the contact to a distribution list.

Creating distribution lists
Use distribution lists if you want to send a report to more than one recipient at a time.

Distribution lists can contain a combination of users, groups, roles, contacts, or other distribution lists.

Procedure
1. Click Manage > People > Contacts.

2. Click the New icon , and then click Distribution list .
3. Enter a name for the distribution list.
4. Click Create.

The distribution list name appears in the Contacts panel.
5. To add users, groups, roles, contacts, or other distribution lists to the distribution list, follow these

steps:
a) Click the distribution list name.
b) Click the Members tab.

c) Click the Add icon .
d) Locate the entry in the Cognos or Cognos Users namespace. To quickly find the entry:

• Type text in the  Find field.

Note: You can click the Search Method icon  to find entries that either contain, start with, or
are an exact match with the text that you type.

• Click the filter  icon to narrow the view of entries.

• Click the Sort icon . You can then specify that search results are sorted by name, by date
modified, or by type. You can also choose whether the results appear in ascending or descending
order.

Tip: As search results appear, you can change your options for search method, filtering, and sorting.
The results update dynamically with each change that you make.

e) Select the entries. You can control-select multiple entries.

Tip: You can add members from any namespace or multiple namespaces that you are logged in to.
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f) Click Add.

The selected entries are displayed on the Members tab.

g) To remove a member, point to its name, and click the remove  icon.

What to do next
If you click a contact's More  menu, and then click Properties, you have these options:

• On the General tab under Advanced, you can disable or hide the distribution list.
• On the Members tab, you can edit the list of members.
• On the Permissions tab, you can set access permissions for the distribution list. For more information,

see “Setting access to capabilities” on page 171.
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Chapter 2. Managing content
The most common reasons for you to backup and restore content are when you want to move content
from a test environment to a production environment as part of the application development process, or
to prepare to upgrade to a new version of the product.

The Configure and manage the system administration capability is required to manage content.

Deployment planning
The process of backing up and restoring content is called a deployment. For security settings to work
when you deploy content, the source environment and the target environment must use the same
namespaces for policies, users, roles, and groups to work correctly. The Cognos namespace is included
when you create a backup. Ensure that the other required namespaces are configured in the target
environment before restoring the content.

If the deployment is part of an upgrade, before you create a backup you can run a consistency check
to find and fix inconsistencies within the content store or between the content store and external
namespaces. You run a consistency check from the Administration console > Configuration > Content
administration > New consistency check.

Backing up content
To protect sensitive information, all backups are encrypted. When you restore the content, you must
provide the password set when the backup was created.

The backup is saved as an archive file (.zip) in the Deployment files location specified in Cognos
Configuration. The default location is install_location\deployment. To deploy the content store in a
different instance of IBM Cognos Analytics, such as the computer used for the production environment,
copy the archive file to the deployment files location on the target computer to make the file available to
restore.

A backup includes the following content.

• public folders
• packages
• reports
• data sources
• distribution lists and contacts
• printer configuration
• access permission settings
• the Cognos namespace
• deployment specifications

Personal entries for each user, such as reports and folders from the user's My Content, are not included in
the backup.

Restoring content
To restore content, the backup file you want to use must be in the Deployment files location specified
in Cognos Configuration. The default location is install_location\deployment. You must provide the
password that was set when the backup was created.

When you restore content, the contents of the target content store are removed and replaced by the
contents of the source content store.
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Chapter 3. Managing data access
IBM Cognos Analytics supports data servers, data modules, packages, data sets, and uploaded files as
sources of data.

Data servers
A data server defines the physical connection to a database or a cube.

A data server connection specifies the parameters that are needed to connect to the database or cube,
such as the location of the database and the timeout duration. Authentication information can also be
included in the connection.

IBM Cognos Analytics supports multiple relational and OLAP data servers. The list of supported data
server types might change from release to release. For information about the currently supported types,
see the Supported Software Environments (www.ibm.com/support/docview.wss?uid=ibm10735235)
website.

If you include database authentication information, such as the Cognos Analytics credentials or a signon,
for the connection, users need not enter database authentication information each time the connection
is used. The signon that is produced when you create a data server connection is by default available
to the Everyone group. You can modify the signon permissions from the properties of the data server
connection.

Data server versus data source
In the legacy IBM Cognos Administration user interface, the equivalent of Data server is Data source
that has the JDBC connection specified.

Data sources do not appear in Manage > Data server connections until you enable web-based modeling
for the data source connections. To do that, go to Manage > Administration console > Configuration
> Data source connections, and select the Allow web-based modeling check box on the connections.
Only data sources with JDBC connections have this check box.

Creating a data server connection
A data server connection specifies the parameters that are needed to connect to the database or the cube
that the connection represents.

Each data server can have one or more connections. The connection names must be unique.

Before you begin
Most data server connections require a database vendor-supplied JDBC driver. Use a version of the JDBC
driver that is compatible with Java™ Runtime Environment version 8. Copy the driver to the Cognos
Analytics installation_location\drivers directory, and restart the query service. Restarting the
full IBM Cognos service is not necessary.

To create data server connections, you need the Data Source Connections administration capability.
Certain roles, such as Analytics Explorers and Analytics Users, have this capability by default. For more
information, see “Setting access to capabilities” on page 171.

About this task
The Manage > Data server connections user interface does not have the required controls to define the
following connection features:

• Connection command blocks
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• Db2 LUW, Db2 for z/OS, Db2 Warehouse, IBM Big SQL trusted connections
• Db2 for z/OS identity propagation
• ORACLE lightweight connections (command blocks are required)

To define connections that include these features, use the Administration console. For more information,
see the IBM Cognos Analytics Administration and Security Guide.

Note: Data server connections that are created in Manage also appear in Administration console
> Configuration > Data Source Connections as data source connections. Users with the required
capabilities and access permissions can view the connections here, and edit the connections that they
created in Manage.

Procedure
1. Click Manage > Data server connections.

2. In the Data server connections pane, click the Add data server icon  .
3. Select the data server type from the list of supported types.

For example, select IBM Db2 to create a connection to an IBM Db2 database or IBM Planning
Analytics to create a connection to an IBM Cognos TM1 database.

4. In the field New data server connection, type a unique name for the connection.
5. Beside Connections details, click Edit and enter the connection details for the type of connection that

you are creating.

For most connections, you must specify the JDBC URL. You can view the syntax and example URL
under connection details. You might need to ask the database administrator for more details, or check
the database vendor documentation.

In the Connection properties box, type the supported property name. For information about the
supported JDBC properties, see “Cognos-specific connection parameters” on page 41.

For IBM Planning Analytics connections, specify the TM1 database host and HTTP port number. To
use an SSL connection, select the Use SSL check box.

6. Under Authentication method, specify how to access the data server.
You can select one of the following options.
Connect anonymously or Integrated security

Choose the Connect anonymously option when anonymous access to the data server is allowed.

Choose the Integrated security option when the TM1 database is configured for Integrated
Security mode 4 or 5. This option is applicable for IBM Planning Analytics connections only.

Prompt for the user ID and password

Choose this option when the user must be prompted for database credentials with each use.

Use an external namespace

Choose this option to secure the connection against a namespace that is configured for Cognos
Analytics. Use the drop-down menu to select one of the available namespaces.

Cognos Analytics logs on to the data server with the credentials that are used to authenticate
to the selected namespace. The namespace must be active, users must be logged on prior to
accessing the data server connection, and the authentication credentials that are used for the
namespace must be relevant for the data server authentication.

Typically, this authentication method is used in the following situations:

• You want Cognos Analytics to pass through to the database the user ID and password that is
presented to the portal during authentication.

• You want Cognos Analytics to use Kerberos authentication.
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• You want Cognos Analytics to use JSON Web Token (JWT) authentication.

The query server determines the credential information that is provided by the external
namespace, and chooses which connection method to attempt.

Use the following signon

Choose this option to assign a signon for the connection.

Select the signon from the drop-down list, or create a new signon by clicking the add icon . In
the New data server connection window on the Credentials tab, type a user ID and password.

To restrict the signon to particular users, roles, or groups, on the Permissions tab, click the add

icon , and specify the access permissions for the signon.
7. Click Test to verify that the data server connection works, and then click Save to save the new data

server connection.

Results
The new connection name is displayed in the Data server connections panel. To edit the data server
connection, including adding or modifying its signon, click the connection name.

Note: The following message may appear:

MSR-GEN-0026 The schema "schema_name" is either empty, or not accessible using the current signon

This message could mean, as stated, that the schema is empty (has no objects) or that the user does not
have access to it. However, the message could also mean that the schema simply has no TABLE objects,
such as TABLE, VIEW, or a SYNONYM to a TABLE/VIEW object, yet still contains other object types. In this
scenario, the produced message is incorrect.

What to do next
To use a data server as a source for reports, dashboards, explorations, and other Cognos Analytics
content, create data modules that are based on the connection.

For relational data server connections, you must preload the schema metadata to make the schema
available to create data modules in the modeling component. For more information, see “Loading
metadata” on page 45.

For IBM Planning Analytics connections, you can create data modules directly from the connection user
interface. For more information, see “Creating data modules from Planning Analytics cubes” on page 58.

Data server types - connection details
Some data server types require unique parameters when you configure their connections.

This section describes connection details for some of those data server types.

IBM Planning Analytics data server connections
If you plan to connect to an IBM Planning Analytics data server, you can optimize how Cognos Analytics
manages the data by performing the tasks in this section.

Connecting to Planning Analytics data servers from CA on Demand
 From an IBM Cognos Analytics on Demand environment, you can connect to a TM1 data server that

is in a Planning Analytics on Cloud Hosted environment.

Note: There are two types of Planning Analytics on Cloud: Hosted and On Demand. Only the Hosted
Planning Analytics on Cloud environment is supported if you are connecting from Cognos Analytics on
Demand.
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To do so, create a data server connection, selecting IBM Planning Analytics as the data server type.

Important: This topic describes how to set the authentication method in Cognos Analytics to match the
authentication method used in the TM1 data server. However, the TM1 database administrator must also
secure the TM1 server using the dedicated Cognos Analytics instance that is associated with the users'
Planning Analytics tenant. Contact the TM1 database administrator to determine the URL of the TM1
database server.

Users and groups are separately managed and configured in Cognos Analytics on Demand and Planning
Analytics on Cloud. Therefore, security groups in Cognos Analytics on Demand cannot be used in Planning
Analytics on Cloud.

The Cognos Analytics on Demand user ID must be included in the Planning Analytics on Cloud
subscription.

For more information, see "Planning Analytics security overview" in the IBM Planning Analytics TM1
Operations Guide.

Procedure
1. Click Manage > Data server connections.

2. In the Data server connections pane, click the Add data server icon  .
3. Select IBM Planning Analytics from the list of supported types.
4. In the field New data server connection, type a unique name for the connection.
5. Under Authentication method, select Integrated security, where the TM1 database is configured for

Integrated Security mode 4 or 5.
6. Beside Connections details, click Edit and enter the connection details:

a. In the TM1 database host field, enter the URL of the TM1 database server, for example:

https://prodsupport.planning-analytics.ibmcloud.com/api/v0/tm1/GO_New_Stores

b. In the HTTP port number field, enter -2
c. Leave the Use SSL check box unchecked.

7. Click Test  to ensure the connection is valid.
8. Click Save.

Ensuring that root members in a Planning Analytics data source match those in the
TM1 client

 If you import a TM1 data source into Cognos Analytics and select the data source type as IBM
Planning Analytics, the list of root members in the metadata tree may look different than the list that
appears in TM1 client.

Solution
You can enable the REST API tm1.RootMembers(). This REST API returns root members from the
Planning Analytics data source that match the root members returned from the TM1 Client.

Important: You must be using a Planning Analytics server version of 2.0.6 or later.

Follow these steps:

1. Stop the IBM Cognos Analytics service.
2. Go to installation_location\configuration
3. If the file xqe.config.custom.xml does not yet exist, copy the file xqe.config.xml and rename

it xqe.config.custom.xml
4. Edit xqe.config.custom.xml:

26  IBM Cognos Analytics Version 11.1: Managing User Guide



a. Immediately after the <queryExecution> line, add the following line:

<paUseRootMembers enabled="true"/>

b. Save xqe.config.custom.xml.
5. Start the IBM Cognos Analytics service.

Disabling filler members in a Planning Analytics package
 You can disable automatic generation of filler members so that a Planning Analytics package

imported to Cognos Analytics shows the same characteristics as it does in the TM1 client.

In Cognos Analytics, by default, filler members are generated to fill gaps due to restricted access from the
root of the hierarchy down to members whose data are visible to the user. In IBM Cognos TM1 however,
the default behavior is that filler members are not generated.

Example 1: Filler members enabled
When filler members are enabled, the caption of a filler member in the data tree is the caption of the
parent member with a caret character (^ ) appended. If access to a root member is not granted to the
user, the root member's caption is a caret character (^ ) only.

A metadata tree with filler members enabled is shown in the following image:

A chart for the same cube appears as follows:
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Example 2: Filler members disabled
Note: Since access to the root member is restricted for the cube in example 1, if filler members are
disabled, the user cannot see any members at all in the data tree.

A chart from the same cube appears as follows:

Procedure
To ensure that a data source displays the same characteristics in both TM1 client and Planning Analytics,
follow these steps:

1. Stop the IBM Cognos Analytics service.
2. Go to installation_location\configuration
3. If the file xqe.config.custom.xml does not yet exist, copy the file xqe.config.xml and rename

it xqe.config.custom.xml
4. Edit xqe.config.custom.xml:

a. Immediately after the <queryExecution> line, add the following line:

<!-- Set the paUseFillerMember enabled attribute value to false to turn the Filler Member 
OFF -->
<paUseFillerMember enabled="false"/>

b. Save xqe.config.custom.xml.
5. Start the IBM Cognos Analytics service.

Problems derived from duplicate (ambiguous) names in Planning Analytics cubes
When a Planning Analytics server has elements of a different type, such as a member, level, or subset,
that share a name, the Cognos Analytics query service is not able to handle these elements properly. The
queries become ambiguous.

The following queries can become ambiguous.

• The query includes a name that is shared by a subset, a member, or a level.

Most likely, the response to this query doesn’t contain the requested object. If the query response
is not what is expected, the query service detects the problem, and produces an internal error that
starts with the following message: XQE-GEN-0010 Found an internal error: '!mapSuccess
- reportName=

• The query references a name that is shared by a member and a level in a cube.

The query response corresponds to the member, not the level. However, a report or dashboard author
querying for the ambiguously named level sees instead a single member that has the same name as the
requested level.

The solution to this type of problems is to give unique names to all members, levels, and subsets within
the cube dimension.
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Salesforce connection editor
 The Salesforce connection editor is available from both Manage > Data server connections and

from the Administration console.

The following diagram shows the Edit Salesforce connection pane:

When you create a new connection, the default URL includes the default instance name
login.salesforce.com and the API Version 49.0.

For example:

jdbc:sfdc://https://login.salesforce.com/services/Soap/u/49.0;

Optional name and value pairs can be specified in the URL or as part of the Connection properties.

For example:

jdbc:sfdc://https://login.salesforce.com/services/Soap/u/49.0;QUERYBATCHSIZE=1000;

Names are case insensitive. If a duplicate name occurs, the last once parsed from the URL or Connection
properties is used. Unrecognized names or invalid values result in an error message.

Chapter 3. Managing data access  29



Salesforce connection properties
The following table describes the properties that you can append to the connection string.

Connection property Description

CONNECTION_TIMEOUT If a connection has not completed in the specified amount of time,
it will automatically time out.

The default value is 60 seconds.

A value must be an integer value in the range of 0 (zero) to
2147483647.

Incorrect values will result in an error.

MAX_RETRIES If a network error is returned when a connection is attempted, it
will be retried up to the maximum value specified.

The default value is 1 (one).

A value must be an integer value in the range of 0 (zero) to
2147483647.

Incorrect values will result in an error.

WAIT_BETWEEN_RETRIES If a connection is retried, the system will pause for the specified
number of seconds between each retry.

The default value is 0 (zero).

A value must be an integer value in the range of 0 (zero) to
2147483647.

Incorrect values will result in an error.

PROXY_ENABLED If a proxy server will be used between Cognos Analytics and
Salesforce

The default value is false

A value must be either false or true.

Incorrect values will result in an error.

PROXY_HOST The hostname of the proxy server that will be used when
PROXYENABLED is true.

A valid hostname which can be accessed that hosts the proxy
server.

Incorrect values will result in an error.

PROXY_PORT The port number the proxy server that will be used when
PROXYENABLED is true.

The default value is 80.

A valid port number.

Incorrect values will result in an error.

PROXY_USERNAME Specifies a username used with the proxy server that will be used
when PROXYENABLED is true.

Incorrect values will result in an error.

30  IBM Cognos Analytics Version 11.1: Managing User Guide



Connection property Description

PROXY_PASSWORD Specifies a password used with the proxy server that will be used
when PROXYENABLED is true.

Incorrect values will result in an error.

QUERY_BATCH_SIZE Specifies the batch size used by the Salesforce query API.

The default value is 500.

A value must be an integer value in the range 200 to 2000.

CONCURRENT_CALLS_LIMIT Specifies the maximum number of concurrent requests.

The default value is 25.

A value must be an integer value in the range 1 (one) to to
2147483647.

USER_CONCURRENT_CALLS_LIMIT Specifies the maximum number of concurrent requests for a user.

The default value is 10.

A value must be an integer value in the range 200 to 2000.

Note: Previous versions of Cognos Analytics provided a connection editor that is only available from
the Administration console. These connections can only be used Framework Manager packages. While
connections using this editor will continue to work, this connection editor will be deprecated in a future
release of Cognos Analytics. Applications should migrate to using the new connection editor.

Metadata described by these connections would include non-groupable columns, while the new editor
will exclude them by default.

Progress DataDirect Autonomous REST connections
 The Progress DataDirect Autonomous REST connection queries JSON responses from API

endpoints that are accessed via the HTTP protocol. The connection generates a configuration file that
translates the endpoint's JSON content into database tables (schemas) in Cognos Analytics. You can
create dashboards and reports that use this REST API endpoint data as their data source.

To create or edit a connection to a Progress DataDirect data server, go to Manage > Data server
connections. Your connection can access either a single URL or multiple endpoint URLs.

For details about how to configure a connection and the supported options: See the Progress®

DataDirect® Autonomous REST Connector for JDBC™ User's Guide for Partners.

The connection string that you enter must include either a 'Sample=REST_API_endpoint' or
'Config=configuration_file' name-value pair that specifies the endpoints to be queried. You may
also need to specify an API key in your connection. If you do, ensure that the permissions to the data
server connection apply only to the people who require access using this API key.

• The Sample method allows you to easily obtain data from a single endpoint URL. However, if you are
working with large amounts of data in a complex schema, this method can slow performance. The
reason for this is that the driver must build the endpoint-to-schema mapping on its own.

For more information, see "Sample" on page 99 of the Progress® DataDirect® Autonomous REST
Connector for JDBC™ User's Guide for Partners.

• The Config method allows you to define the endpoint to schema mapping at configuration time and
provides these advantages:

– It greatly reduces the work performed by the driver at runtime, returning results more quickly.
– It can issue multiple REST API endpoint requests in a single connection.
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– It tailors the REST API results for schema mapping. This allows for customized table names, column
names, and data type mapping.

For more information, see "Config" on page 73 of the Progress® DataDirect® Autonomous REST Connector
for JDBC™ User's Guide for Partners.

Before you begin: Read the topic "Setting up the driver" on page 10 of the Progress® DataDirect®

Autonomous REST Connector for JDBC™ User's Guide for Partners.

Sample parameter
Specify the Sample parameter in the JDBC URL of a REST API connection. The REST response is a tabular
schema that you can import to Cognos Analytics as a data module.

The JDBC URL field appears when you create a data server connection and select Progress Data Direct
Autonomous REST connection as the connection type.

For more details: Read the topic "Using the Sample property method" on page 19 of the Progress®

DataDirect® Autonomous REST Connector for JDBC™ User's Guide for Partners

Syntax
jdbc:ibmcognos:autorest:Sample='endpoint_URL'

The endpoint URL
The endpoint URL is a REST API location that returns data that you can use in Cognos Analytics. It
can contain many optional connection properties to accommodate various types of API responses and
authentication. For example, its properties support many OAuth 2.0 authentication flows which vary
based on the security needs of each web service.

Example URLs
The following connection performs an HTTP GET on the URL http://worldtimeapi.org/api/
timezone/America/Toronto. The JSON response returned from the endpoint is represented as a table
with columns that correspond to the fields in the response.

jdbc:ibmcognos:autorest:Sample=http://worldtimeapi.org/api/timezone/America/Toronto

When a URL includes characters that are used by the driver, you must enclose it in single quotes. The
following URL includes a query string in which the name-value pair includes an equal sign (=).

jdbc:ibmcognos:autorest:Sample='http://myWebSite/resources?type=dog'

Note: For additional examples, see “Examples using the Sample parameter method” on page 35.

Config parameter
Specify the Config parameter in the JDBC URL of a REST API connection. Unlike the Sample method,
the Config method creates a connection that references a local configuration file. You can customize
this .json configuration file so that the schema translation is preconfigured. This allows you to achieve
high performance when you retrieve large amounts of data.

The JDBC URL field appears when you create a data server connection and select Progress Data Direct
Autonomous REST connection as the connection type.

For more details: Read the topic "Using the input REST file method" on page 20 of the Progress®

DataDirect® Autonomous REST Connector for JDBC™ User's Guide for Partners

Syntax
jdbc:ibmcognos:autorest:Config="path_to_local_configuration_file";ServerName=Endpoint_URL
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where:

• path_to_local_configuration_file is the path, enclosed in double quotes, to a central location to which
you uploaded the configuration file.

For more information, see “Store .json files in a central location” on page 35.
• Endpoint_URL is a REST API location that returns data that you can use in Cognos Analytics. It can

contain many optional connection properties to accommodate various types of API responses and
authentication. For example, its properties support many OAuth 2.0 authentication flows which vary
based on the security needs of each web service.

For more details: See the topic "Input REST file syntax" on page 117 of the Progress® DataDirect®

Autonomous REST Connector for JDBC™ User's Guide for Partners.

API key
If the Data Direct data server you are connecting to uses OAuth 2.0 authentication, you must specify
values for the key and secret key in the connection string.

An endpoint may require an API key before it can accept requests. A site may use a process to generate
a token that must be part of the HTTP request header. The driver provides name-value pairs that can be
used to set header variables. The key can be specified several ways:

• in the URL or connection properties
• in the optional Key field
• via a Cognos Analytics session variable

For example, if a site generates an API key that is to be passed as a bearer token and you prefer to keep
the key hidden, use the optional Key field. If the key is a bearer token, enter the value Bearer, followed
by a space, followed by the API key from the site.

For more details: See the topics "ClientId" and "ClientSecret" on pages 71 and 72 respectively of the
Progress® DataDirect® Autonomous REST Connector for JDBC™ User's Guide for Partners.

Tips for creating REST API connections
This section provides tips to help you save time when you create a DataDirect Autonomous REST
connection.

Research the API that you want to connect to
Before you define a connection to a particular API endpoint, review the documentation of the API to find
answers to these questions:

• What is the format of the URL and query string?
• What is the format of the JSON responses returned?
• What limits may an endpoint impose in terms of requests in a period?
• What methods are used to authenticate requests, such as via an API key?
• Does the connection provide endpoints that are designed for analytical applications?
• What is the endpoint response time?
• How are the responses mapped by the driver?

Try these tools
You can research the endpoints' behavior using the following tools:

• Curl
• Postman
• a web browser
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Is the endpoint appropriate?
A candidate endpoint may not be appropriate for a connection from Cognos Analytics if the connection
exhibits any of these behaviors:

• It does not use HTTP for the protocol.
• It does not return JSON responses.
• It uses a proprietary query specification language expressed in the body/query string.
• Its JSON representation cannot be transposed into a schema used by the driver.
• Its endpoints may not have been designed with analytical applications in mind.

For example, a business user may intend to build a dashboard which summarizes information about
multiple locations over several business days. If the URL was designed to return information for a single
location and day, it may need to be enhanced.

Map Boolean values to type VarChar or Integer
Cognos Analytics does not support returned Boolean values, for example, true or false values. As a result,
if your JSON output contains Boolean values, you cannot use the Sample method. Instead, use the
Config method to map Boolean values to either text (for example, VarChar) or Integer.

For information about the data types that are supported by Cognos Analytics, see "Supported SQL data
types" in the Cognos Analytics Data Modeling Guide..

Indicate nested data objects in the name of the top-level table
Some API calls return data objects that are nested under a top-level table. You can adopt a naming
convention for the top-level table that indicates the following:

• the data is nested
• the name of the nested object whose data you want to use in Cognos Analytics

For example, a top-level table might contain call-level attributes such as success, return code, error
message, and also an array (or object) called data. In this example, data contains the data that you are
interested in. You name the top-level table ObjectResults and name the nested array Object. This
way, when you create a data module, you can ignore the ObjectResults tables and bring in to your
module only the various Object tables.

For more details: Read the topic "Columns with nested objects" on page 143 of the Progress® DataDirect®

Autonomous REST Connector for JDBC™ User's Guide for Partners

Add comments
You can add comments to Progress DataDirect REST API configuration files. To do so, type // at the
beginning of each comment line. Use comments to document the content of your configuration file as well
as any nuances of the APIs that you call.

For example, you want to retrieve two subsets of data from the same API. However, when you try to
retrieve all the data in one call, the API times out because there is too much data. To solve this issue, you
decide to make two separate calls to the API, each one retrieving a different subset. You add a comment
that explains why your schema makes two calls instead of one.

Use column name overrides
You can change the column names of your JSON output to something that makes more sense to your
end users and analysts. To override a column name, edit your configuration file and insert your new
name, enclosed in angle brackets. That is, change "old-column-name" to "old-column-name<new-
column-name>".
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For example, you typically use underscores in your schemas. However, the API that you call returns
concatenated names. You decide to rename them to use underscores. You edit the configuration file and
change this text:

"fieldNumberOne":"VarChar(64)" 

to this:

"fieldNumberOne<field_number_1>":"VarChar(64)" 

Relink associated data modules after any connection update
When you save a new version of your DataDirect Autonomous REST connection, you are updating a
schema. As with any schema change, you must relink any data module that uses that data server
connection.

For more information, see "Relinking sources" in the Cognos Analytics Data Modeling Guide.

Store .json files in a central location
Ensure that you store your .json files in a central location available to everyone in your Cognos
Environment. Following are some examples of storage locations, depending on which Cognos Analytics
offering you are using:

If you are using Cognos Analytics on Cloud Hosted:
Your administrator can give you access to an SSH File Transfer Protocol (SFTP) dropbox in the root file
system.

If you are using Cognos Analytics for Cloud Pak for Data or Cognos Analytics On Demand:
You can host your configuration file on a public URL or in a Cloud Object Store location. For more
information, see Chapter 10, “Managing cloud storage,” on page 237.

If you are using Cognos Analytics on Premises or Cognos Analytics on Cloud Hosted:
Your configuration file can be stored

• in a Cloud Object Store (COS) location
• in a file system location on each Cognos Analytics application tier server
• on a network drive location that is accessible to each Cognos Analytics application tier server

Examples using the Sample parameter method
Following are two examples that use the Sample parameter to create a REST API connection. The first
example uses a fictional API provider. The second uses a real API provider.

Example that uses a fictional API provider
In this example, you create a REST API data server connection to an API provider using the Sample
parameter. Your connection retrieves a Panel data object. The Panel object contains List tables that
contain Card tables. You will use your new connection to create a data module In Cognos Analytics that
references the Panel schema.

1. You go to the web site of the API provider and research its API requirements. You make a note of the
required inputs to the API, including the URL syntax and authentication parameters.

You discover that:

• The API uses OAUTH1 authentication.

For more details: See the topic "Authentication" on page 42 of the Progress® DataDirect®

Autonomous REST Connector for JDBC™ User's Guide for Partners.
• You would like to access the Panel API.
• You will use the SAMPLE method to query the API.
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2. You register with the company's API service and obtain unique information that you will use in your
Panel API call.

• You obtain a panel id that identifies the schema instance that will be returned to you.
• You obtain your own security key and security token.

3. In Cognos Analytics, you build a data server connection to the API.

a. You follow the steps in Creating a data server connection, specifying values as follows:

• In the Select a type pane, you click Progress Data Direct Autonomous REST connection.
• In the JDBC URL field, you type the following:

jdbc:ibmcognos:autorest:sample='HTTP://company_api_url/panel_id?
fields=all&key=your_security_key&token=your_security_token'

where:

– The sample method uses single quotes around its entire value.
– The panel_id is sent to you when you registered with its API service.
– fields=all specifies that all fields in the data are to be returned.
– key= and token= are prefixes to the security key and security token values that you were

assigned when you registered with the API service
– The Driver class name field is auto-filled with this text:
com.ibm.cognos.jdbc.autorest.AutoRESTDrive

• Under Authentication method, you select Connect anonymously.
b. You save the new connection.

4. You verify that the metadata was loaded.

a. You click the Schemas tab.

The AUTOREST schema appears in the list, confirming that all of the tables from the API service
were loaded into Cognos Analytics.

b. You click the More icon  next to the AUTOREST schema.

The names of the tables appear. You can use these tables to create a data module.
c. If you need to refresh the data, you click Load metadata.

5. You create a data module, based on the connector that you built.

a. In the Cognos Analytics Welcome page, you click New > Data module.

b. In the Select sources dialog box, you select the Data servers and schemas icon .
c. You select the connector that you just built.

You are prompted to select a connection.
d. You select Panel Info and then click OK.
e. You select the Autorest schema that was returned by your connection.

Auto-generated table names appear.

Tip: The last table in the list is named Configuration. To create a connection that uses the Config
parameter, you can copy data from any similar Configuration table into a customized configuration
file. For more information, see “Example using the Config parameter method” on page 37.

f. You select all the tables in the list, and then click OK.

A Grid view appears of the tables that you imported. You notice that one of the tables contains the
Panel info. This name was auto-generated from the JDBC URL value that you entered when you
created the API connection.

g. You examine the data module and modify it, if required.
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h. You click Save to save the data module.

The data module  is created in the location that you chose.

Example that uses a real API provider
This example shows the Edit Progress DataDirect Autonomous REST connection panel, configured for
a real working connection using GitHub. In the JDBC URL field, the HTTP location and the token id are
redacted for privacy reasons. See the following figure:

Note:

• The Authentication method field in the left panel is set to Connect anonymously. This is because the
authentication information for this example is specified in the JDBC URL field.

• In the JDBC URL value, both the SAMPLE value and the SecurityToken value are enclosed by single
quotation marks (').

Example using the Config parameter method
In this example, you create a REST API connection to a fictional API provider using the Config
parameter. This connection method references a configuration file that calls several endpoints and maps
the results into a custom database schema. You then edit the configuration file to optimize future data
retrieval via the connection.

Tip: Step “4” on page 38 of this example describes modifying the configuration file used in the
connection. You can also use the Cognos Analytics modeling tool to make changes to objects, for
example, to modify label names.

Procedure
1. You use a configuration file, for example, my_config.json, to specify the data you want returned by

the REST API service.
2. You store the file my_config.json in a central location available to everyone in your Cognos

Analytics environment.

For more information, see “Store .json files in a central location” on page 35.
3. You create a connection using the Config parameter:

a) You follow the steps in “Creating a data server connection” on page 23, specifying these values:

• In the Select a type pane, you click Progress Data Direct Autonomous REST connection.
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• In the JDBC URL field, type the following:

jdbc:ibmcognos:autorest:config="path_to_my_config.json";ServerName=url_endpoint

where:

– path_to_my_config.json is the path to your configuration file, which is stored in a central
location.

– The path to your configuration file is enclosed in double quotes.
– You determine the url_endpoint by visiting the web site of the API provider.
– The panel_id, security key, and security token are not explicitly included in the API call.

Instead, they are defined in the configuration file, which is encrypted.
– The Driver class name field is auto-filled with this text:
com.ibm.cognos.jdbc.autorest.AutoRESTDriver

• Under Authentication method, you select Connect anonymously.
b) You save the new connection.

4. You examine my_config.json in a text editor and modify the file, if required:

• You can rename the schema name and panel name to be more intuitive.
• You may notice that multiple API calls are made when using this configuration file.
• If you want to ignore some members or rows in a table, you can comment them out using double

slashes (//).
• For each main table object, you replace actual values with a corresponding data type.
• You may notice nested tables within the configuration file. For example, each nested table may

appear as an array, denoted by a pair of square brackets ([]), under its parent table.
• You might want to rename an original table name. For example, you want to rename labels

to cardLabels. Using the configuration file syntax, you replace the code labels with
labels<cardLabels>.

For details about how to modify a configuration file: Read the topic "Modifying the relational view"
on page 21 of the Progress® DataDirect® Autonomous REST Connector for JDBC™ User's Guide for
Partners.

5. You create a data module based on the connection.

Tip: See step “5” on page 36 in "Example that uses a fictional API provider".
6. In the data module, you select the Relationships view.

The table relationships are shown graphically. These relationships were generated in Cognos Analytics
from the corresponding information in the configuration file.

What to do next
You can use this data module as the data source when you create, for example, a or .

Microsoft Azure Analysis Services
The Microsoft Azure Analysis Services data server connection is supported on IBM Cognos Analytics
on premises on Microsoft Windows only. Follow these guidelines when you create the data server
connection.

• Specify Prompt for the user ID and password or Use the following signon for the authentication
method.

• Specify the server name shown in the Microsoft Azure portal for the Server name. Do not use the
management server name.

• Specify the Language field in the following format: ll or ll-cc, where ll is the ISO language code and
cc is the ISO region or country code.
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For more information about Microsoft requirements, see Client libraries for connecting to Azure Analysis
Services (https://docs.microsoft.com/en-us/azure/analysis-services/analysis-services-data-providers).

Notes:

• Driver version must be Microsoft Analysis Services OLE DB Provider (MSOLAP) 15.1 or higher
• Compatibility level must be 1400 or higher
• Framework Manager does not support Microsoft Azure Analysis Services data server connections

Microsoft Analysis Services and Microsoft Azure Analysis Services - Language
code
Use the following format in the Language field for the Microsoft Analysis Services or Microsoft Azure
Analysis Services data server connection:

ll or ll-cc, where ll is the ISO language code and cc is the ISO region or country code. The region or
country code is optional.

Snowflake connections
You can configure a connection to Snowflake using the Snowflake JDBC driver so that it passes a JSON
Web Token (JWT) when authenticating to the database.

To enable a Snowflake connection, complete these tasks:

1. Choose an identity provider namespace that can return claims in the JWT that Snowflake requires.
2. Configure Cognos Analytics to use the OpenID Connect authentication provider.

For more information, see "OpenID Connect authentication provider" in the IBM Cognos Analytics
Installation and Configuration Guide.

3. Specify the connection settings:

a. Select the OpenID Connect namespace that you configured as an identity provider.

Tip: This allows the JWT token to be passed.
b. Select Use an external namespace as the authentication method.
c. Include the Snowflake name-value pair authenticator=oauth in the connection URL.

For more information, see “Creating a data server connection” on page 23.

For information about Snowflake JWT authentication, see the Snowflake documentation.

SingleStore
A connection to SingleStore supports using the MariaDB Connector/J JDBC driver. In previous Cognos
Analytic releases, connections required the MySQL Connector/J JDBC driver.

Note: "SingleStore" is the rebranded name of the company formerly known as "memSQL".

Due to changes introduced in MySQL Connector/J version 8, connections will fail. SingleStore
recommends that applications use the MariaDB Connector/J JDBC driver. To convert existing connections
to use MariaDB Connector/J, change the URL to the format supported by MariaDB and alter the driver
class name to refer to the MariaDB driver class name.

Data catalogs
 IBM Cognos Analytics can be connected to a catalog such as Watson Knowledge Catalog (WKC).

Watson Knowledge Catalog is an extension to IBM Cloud Pak for Data that provides self-service access to
data assets for knowledge workers who need to use those data assets to gain insights.

For more information, see these topics:

• What is IBM Watson Knowledge Catalog? (https://www.ibm.com/cloud/Watson-knowledge-catalog)
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• Watson Knowledge Catalog overview (https://www.ibm.com/support/knowledgecenter/
SSBRA9_addon/wsj/catalog/overview-wkc.HTML)

A Catalog in WKC can reference one or more connected assets that refer to data sources. Cognos
Analytics can import and re-use the connection details. Currently, only details for connected assets that
correspond to databases supported by Cognos Analytics are imported.

Notes about WKC connections in Cognos Analytics
• Cognos Analytics displays WKC schemas and tables the same way that it displays data for other types of

data server connections.
• Cognos Analytics administrators do not manage the connection details of a connected WKC asset.

Connection details are managed by the database administrator in WKC.
• You can create Cognos Analytics connections to multiple catalogs.

Before you begin
To connect to a Watson Knowledge Catalog, you must first add the WKC certificate to your Cognos server.
To do so:

• Follow the steps in "Import the CA certificates into IBM Cognos components" in the IBM Cognos
Analytics Installation and Configuration Guide.

Important: Self-signed certificates are not supported for CA/WKC integration in 11.1.7 and later. The
CPD/WKC certificate that is imported into Cognos Analytics must be signed by a trusted root authority.
To confirm that your certificate is signed by a trusted root authority, enter the WKC URL into a browser
and verify that there is a padlock to the left of the URL.

If you import a self-signed certificate and try to create an External Catalog connection to WKC, the
following message may appear:

MSR-WKC-2404 Invalid connection string, user name or password

If your certificate is self-signed, replace it with a trusted TLS certificate by following the steps in Using
a custom TLS certificate for HTTPS connections (https://www.ibm.com/support/producthub/icpdata/
docs/content/SSQNUZ_latest/cpd/install/https-config-openshift.html).

• Restart your IBM Cognos services.

Connecting to a Watson Knowledge Catalog
1. Click Manage > Data server connections.

2. In the Data server connections pane, click the Add data server icon  .
3. Select External Catalog as the type.
4. In the Edit External Catalog connection panel, enter the following text in the Server URL field:

jdbc:wkc:url_for_wkc_server

where url_for_wkc_server is the URL to the IBM Cloud Pak for Data main landing page for the CPD
instance with WKC installed.

For example, if your CPD URL is https://wkc-cpd.test.cloud.ibm.com, then the Server URL
value would be:

jdbc:wkc:https://wkc-cpd.test.cloud.ibm.com

Tip: Leave the Connection properties field blank.
5. In the Authentication method section, select Use the following signon.
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Tip: This is the only valid authentication method for an External Catalog connection type.

6. Click the plus sign icon .
7. On the Credentials tab, enter a valid Watson Knowledge Catalog user ID and password.

Tip: Specify a username and password that you want to connect to WKC with. The user credentials are
the credentials that are defined in the CPD instance. You can choose to use the CPD admin userid or
another CPD userid with access to WKC.

8. Click Test to ensure that the connection works.
9. Click Save to save the connection in Cognos Analytics.

Cognos-specific connection parameters
You can specify some optional, Cognos-specific parameters for JDBC connections.

You can specify these parameters when creating or updating JDBC connections for data sources in IBM
Cognos Administration or IBM Cognos Framework Manager, or when creating or updating data server
connections in the Manage > Data server connections administration interface.

In different connection editors, these parameters can be specified as Connection properties or JDBC
Connection Parameters.

ibmcognos.fetchBufferSize
This parameter is used to set the JDBC driver fetch size for data source connections in IBM Cognos
Analytics.

When the query service in IBM Cognos Analytics executes queries by using JDBC, the fetch size value
that is passed to a JDBC driver is calculated dynamically. Support for fetch sizes depends on database
vendors. The vendors also decide what the fetch size means, and what the fetch size is when it is used
internally in the driver and server. For more details, refer to your vendor’s JDBC documentation.

The query service computes a value for a query by using the following formula:
maximum( (bufferSize / ‘row-size’), 10)

The default value for buffer size is 100 kilobytes (KB). The row size is computed from the size of the
columns that are projected by the result set in a query. Queries that project columns with large precision
or project many columns use a smaller fetch size than those projecting fewer columns or columns with
smaller precision.

If the retrieval of a result set can be significantly improved by using a larger buffer size, a Cognos
administrator can specify the connection property ibmcognos.fetchBufferSize. The query service
automatically adjusts the value if it is lower than 10 kilobytes or greater than 10 megabytes.

If ibmcognos.fetchBufferSize > 1024 * 10240 then bufferSize = 1024 * 10240

If ibmcognos.fetchBufferSize < 10240 then bufferSize = 10240

Larger fetch sizes are not always recommended because they can potentially increase the memory
consumption by the JDBC driver and not lead to improved performance. Always review the
database vendor documentation and recommended practices before using large values for the
ibmcognos.fetchBufferSize property.

ibmcognos.decfloat
When this parameter is specified, the query service is directed to use a decimal float type, DECFLOAT
128, which accurately represents values with precision of up to 34 digits. When a column with large
precision is detected, it is internally changed to DECFLOAT and the data type in the model or report is
described as DECIMAL(0,0).

To enable this feature, specify the connection parameter ibmcognos.decfloat=true for the database
connection that is used by the query service. In existing models, the columns must be remapped to
DECIMAL(0,0) instead of double.
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For the query service to read the rows that are returned by a query, the JDBC driver must return the
column values using a specific Java data type. In previous releases, it was possible for a database such as
ORACLE to return a numeric column where the precision caused the query service to use the double data
type. When the values that were returned by a query had precision greater than 16 digits, the conversion
could result in an inaccurate value.

For example, if an ORACLE column was defined as NUMBER (without stating precision), or an
aggregate such as SUM was computed that ORACLE returned as a NUMBER, the returned value of
1234567890123456789 might be converted to the value of 1.23456789012345677E18. The two values
are not the same.

If the database does not return large values, do not use this parameter and ensure that the models do not
include columns with the DECIMAL(0,0) data type. This allows the query service to use a data type that
requires less memory than the DECFLOAT type.

ibmcognos.qualifier_list
This parameter is used to disambiguate metadata when dynamic queries are executed. It assigns a list of
one or more qualifiers to data sources that are defined in IBM Cognos Analytics.

The following examples show the syntax to use when specifying the ibmcognos.qualifier_list
parameter, and the values that can be assigned for it:

• ibmcognos.qualifier_list=CATALOG1.SCHEMA1, CATALOG2.SCHEMA2
• ibmcognos.qualifier_list=SCHEMA1, SCHEMA2
• ibmcognos.qualifier_list=CATALOG1.SCHEMA1, SCHEMA2
• ibmcognos.qualifier_list=CATALOG1, CATALOG2

A period in the qualifier is used to separate the catalog and schema components. If no period is present
and the database supports schemas, the value is treated as a schema. Otherwise, the value is treated as a
catalog, if the database supports catalogs.

The query service searches the list in the order specified, and uses the column metadata that it finds for
the first qualifier that matches. If no match is found, an ambiguous metadata error is thrown.

The administrator should confirm that the list of qualifiers that are provided for this parameter is identical
in order and content to any search list that the user’s database session might have defined. The qualifier
list is applied only when the session attempts to disambiguate metadata that is returned by a JDBC driver.
Qualified names in dynamic SQL statements reflect the values assigned to catalog or schema properties
that the package data source used during query planning.

ibmcognos.authentication
This parameter is used to configure data source connections when using Kerberos authentication.

For the different data source connection types, specify ibmcognos.authentication=java_krb5, and
then add the properties that are required by the JDBC driver for Kerberos authentication, if they are
required. The following examples show how to specify this parameter for some data source connections:

• For Teradata connections, specify ibmcognos.authentication=java_krb5;LOGMECH=KRB5;
• For SAP-HANA connections, specify ibmcognos.authentication=java_krb5;
• For Microsoft SQL Server connections, specify
ibmcognos.authentication=java_krb5;authenticationScheme=JavaKerberos;
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ibmcognos.maxvarcharsize
The query service can use a larger default VARCHAR precision value than the default value that is
supported by the database. This parameter is used to override the database default VARCHAR precision
value for the query service.

To specify this parameter, use the following syntax, where N is an integer value greater than zero that is
supported by the database vendor:

ibmcognos.maxvarcharsize=N

The SQL standard uses the CLOB data type and the national character large object type (NCLOB) to
hold large character values. Different databases support the CLOB data type or their own versions of
this type with similar characteristics. The CLOB data type imposes several restrictions on the types of
SQL constructs that can be used in queries. Also, database vendors might impose additional restrictions
on how CLOB columns must be handled in the client interfaces, such as JDBC. To avoid CLOB-related
restrictions, the query service automatically converts CLOB columns into VARCHAR columns by using the
CAST function. As a result, the first N characters of the CLOB type are returned as VARCHAR to the query
service.

Tip: The automatic CAST function is not performed when a JDBC driver describes the column data type as
a VARCHAR (Variable Character field) and not as a CLOB (Character Large Object) data type, and when the
column reference has a user-specified CAST function surrounding it.

If the length of a CLOB in a row is larger than the CAST precision data, truncation occurs.

In some cases, a database vendor might support a larger precision if specific database configuration
settings, such as page and row size, or server settings, are satisfied. If such preconditions are satisfied, a
larger value can be specified on a data server connection. If the preconditions are not satisfied, when you
use a value greater than the one that is supported by the database, the SQL statements fail to execute.
Before using larger VARCHAR precision values, refer to the database vendor documentation, and verify
the value with the database administrator.

The query service uses the following default VARCHAR precision values for the different databases:

Table 2. Default precision VARCHAR values in the query service

Database Default VARCHAR precision

Db2 iSeries 32739

Db2 ZSeries 4096

Db2 LUW 8168

Exasol 2000000

Informix Dynamic Server 255

MariaDB 21845

MemSQL 21845

MySQL 65535

Oracle 4000

Pivotal Greenplum 2000000

PostgreSQL 2000000

SAP Hana 5000

SQL Server varchar(max)

Teradata 32000
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Table 2. Default precision VARCHAR values in the query service (continued)

Database Default VARCHAR precision

Other vendors 1024

If the ibmcognos.maxvarcharsize value is higher than the Java Integer max (2147483647), or not an
integer at all, the value is ignored.

If the ibmcognos.maxvarcharsize value is lower than both the default 1024 and the vendor VARCHAR
size, the lowest of these 2 values is used instead of the ibmcognos.maxvarcharsize value.

ibmcognos.maxRowsRetrieved
The ibmcognos.maxRowsRetrieved property on a data server connection can be used to set the
maximum number of rows that are returned in an SQL query.

This property is applicable for the dynamic query mode (DQM) only, and can be used to prevent users
from executing queries which retrieve large numbers of rows from the database server.

Use the following syntax to specify this property, where N represents the maximum number of rows to
return:

ibmcognos.maxRowsRetrieved=N

The N value must be an integer greater than 0 and less or equal to 2147483647.

An exception is thrown if an invalid value is detected. By default, no limit is applied to the number of rows
that are returned.

Not setting this property, or setting it to 0, means that there is no limit.

Note: If the queried database offers workload management features, use these features instead of this
property.

ibmcognos.typeinsqldisabled
When this property is specified, queries that are based on typed-in SQL are not allowed by the
connection. This property is needed for data modules with security filters to prevent security
vulnerabilities that typed-in SQL can introduce.

If you try to create an SQL-based table after this property was specified, the table will not be created. If
you specify this property after an SQL-based table was created, the query execution is stopped.

These restrictions apply to all data modules that are based on connections that have this property
specified. To bypass these restrictions, create a separate data server connection for data modules with
security filters, and specify this property only for this connection. Other connections to the same data
server that do not have this property specified can process queries based on typed-in SQL.

UDA.CONVERT_TIMESTAMP_LITERAL_TO_DATE_LITERAL
This entry is specific to Oracle only. When the boolean value is set to true, then UDA converts the
TIMESTAMP literal with 0 time value to a DATE literal. Oracle uses index scan on a DATE column.

Because the Oracle DATE column contains the date and time parts, UDA reports the Oracle DATE datatype
as TIMESTAMP.

Cognos Analytics treats the Oracle DATE column as a TIMESTAMP, and generates a TIMESTAMP literal in
the filter.

When you compare the DATE column and the TIMESTAMP literal, then the Oracle optimization adds an
internal function on the DATE column to make the comparison compatible. This impacts the performance
of Oracle.
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Syntax
UDA.CONVERT_TIMESTAMP_LITERAL_TO_DATE_LITERAL= "database_name: boolean_value"

Data type
Boolean

Default
False

Loading metadata
After a data server connection is created, you need to load the metadata from the database schemas or
catalogs. Only schemas where metadata was loaded can be used to create data modules. The loaded
metadata is saved to the content store.

When you load metadata, IBM Cognos Analytics examines the data servers for information, such as
primary and foreign keys, approximate number of rows in each table, or distinct values in certain columns.
Based on this information, data is prepared for use in data modules. For example, relationships between
tables are inferred automatically, and intelligent default settings are assigned for Aggregation and Usage
properties. This process is also referred to as smart data preparation.

About this task
Loading metadata doesn’t take long for some data server schemas, but it can take a while for schemas
with thousands of tables. If the schema contains tables that don’t have any analytical value, exclude them
so that no time is wasted retrieving their metadata.

When specifying the load options, you can include a sample of statistical data that is retrieved from the
underlying data server. This data is used by the Cognos Analytics AI to do better automation, and make
better visualization suggestions.

Tip: The term schema in the Cognos Analytics user interface also represents the term catalog. Both terms
denote a logical classification of database objects.

Procedure
1. Click Manage > Data server connections.

The slide-out panel displays a list of data server connections.
2. In the Data server connections panel, click a data server name.

Tip: Ensure that the connection represents a relational database.

The data server properties panel is displayed. The panel contains 3 tabs: General, Connections, and
Permissions.

3. Click the Connections tab, and then click the data server connection name.

The connection properties panel is displayed. The panel contains 4 tabs: General, Settings, Schemas,
and Permissions.

4. Click the Schemas tab.

The list of database schemas is displayed. The check mark in the Status column indicates that the
schema was loaded before. The Load information column indicates how many tables are loaded. If
the schema is not loaded, this information is not available.

By default, the list doesn’t include the system and administration schemas for several types of data
servers. These types of schemas are not loaded by default. For example, the PUBLIC schema in
ORACLE is not displayed. To view the system and administration schemas for a data server connection,
select the Show system schemas checkbox.

Tip: The set of system and administration schemas that are not displayed for specific (not all) vendors
is defined in the install_location\configuration\moser\import.xml file.

5. From the schema context menu , click one of the following options:
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• Load options

Use these options to specify which load options to select, and which schema tables to load.

– On the Load options tab, select or clear the following checkboxes (these checkboxes are
selected by default):
Retrieve primary and foreign keys

Select this checkbox to facilitate automatic detection of relationships between tables.
Clearing this checkbox reduces the time and memory usage by the system when the data is
loaded. However, fewer joins might be created.

Retrieve sample data
Select this checkbox to retrieve a statistical sample of data from each selected table.
By default, 1000 rows of the data per table is retrieved. You can modify this value, and
specify up to 10000 rows. Too many rows might have negative impact on the system
performance; too few rows might not gather enough information.
Clearing this checkbox reduces the time and memory usage by the system when the data is
loaded, and might be the right choice in some situations.
For more information, see “Data sampling” on page 47.

– On the Tables tab, select or deselect the tables to load.

Use the Exclude tables option to exclude tables that aren’t used in your dashboards or
explorations, which reduces the time and memory usage when queries run. You can also exclude
tables that cause errors, or those that you cannot access.

Use the Include tables option to select a fixed set of tables for metadata loading. This option is
helpful if you want to refresh the loaded metadata, but do not want to automatically include any
newly defined tables.

• Load metadata.

This option loads all tables in the schema by using the default load options.
• Clear metadata

This option is available only if the schema metadata was loaded before. Use this option to remove
the previously loaded metadata from the content store. However, this option should be used with
caution because it can break reports, dashboards, or explorations that are based on data modules
that use the schema, and delete security filters from the data modules.
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Results
When loading is finished, the Status column indicates that the schema is loaded. The Load information
column indicates how many tables are loaded.

What to do next
If the schema was loaded for the first time, it can now be used to create data modules. If this is a
subsequent reload of the schema metadata, the data in the associated data modules is refreshed.

Data sampling
Data sampling is a way for the IBM Cognos Analytics artificial intelligence (AI) to learn about the data
in the underlying data server. This data is used by the AI to do better automation, and make better
visualization suggestions.

Without the sample data, some Cognos Analytics features don’t work. For example, the relationships
diagram in Explore is displayed only if the sample data is available. Otherwise, it's not displayed.

When loading the schema metadata or enriching a package, a sample of statistical data can be retrieved
from the underlying data server. To enable this functionality, select the Retrieve sample data checkbox in
the related dialog box.

By default, 1000 rows of a statistical sample of the data per table (query subject for packages) is
retrieved from the underlying data server. This sample data is used by the Cognos Analytics AI to infer
characteristics, or "advanced metadata", that help the AI in its automation choices and visualization
suggestions.

An example of a characteristic that can be inferred from the sample data is the approximate number of
unique values in each field. This information helps the AI make visualization type recommendations. For
example, a bar chart is recommended only if there are not too many unique values to display as bars. A
bubble chart is more appropriate for data fields that have hundreds of unique values.

The type and amount of data that is retrieved with the data sample is not always the same, and is
influenced by the following factors:

• User's permissions to query specific tables or columns in the table.
• Data security that constraints the rows that the user can see.
• Data masking that might change the data that the user can see.
• Expressions might be dynamic because of macros.
• Data server connections might be dynamic because of macros or security on the connections.

Disabling data sampling
To disable data sampling for all tables in the data server, clear the Retrieve sample data checkbox in the
metadata loading or package enrichment user interface.

If data sampling is disabled, the Cognos Analytics AI doesn’t know as many characteristics about the
data. It still knows some characteristics by looking at the data server metadata, but not as many as it
would know if it had access to the sample data. Using the example above, without sampling, a bar chart
might be recommended even for data fields that have too many unique values to be appropriate for this
visualization type. In summary, the visualization recommender works without the characteristics inferred
from the sample data, but it doesn’t work as well.

Here is a list of features that are negatively affected when data sampling is disabled:

• Forecasting
• Assistant
• Relationship diagram
• Decision tree visualization
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• Spiral visualization
• Driver analysis visualization
• Sunburst visualization
• Natural language details
• Insights in visualizations
• Correlated insights
• Recommended visualizations in Explore
• Related visualizations
• Recommended visualizations in dashboards

For more information, see the IBM Cognos Analytics Exploration and Dashboards and Stories guides.

Disabling data sampling is justified in the following situations:

• Errors occur when the sample data is retrieved.
• The negative performance impact on the system is too significant.

Instead of disabling data sampling entirely, you can keep the Retrieve sample data checkbox selected,
but exclude some tables from the process. Both the metadata loading and package enrichment user
interfaces include options to deselect tables. For example, you could exclude tables that generate errors.
You can also reduce the number of sample rows that are retrieved.

Reference and troubleshooting
When creating and maintaining data server connections in IBM Cognos Analytics, you might encounter
issues with JDBC drivers, data server version support, authentication, and so on.

The connection information is different for each type of data server. For more information, see the
database vendor documentation.

Managing multiple connections to the same data source
When a data source with multiple connections is queried, an ambiguous connection condition can result.
You can ensure that ambiguous connection conditions do not occur.

About this task
You can create more than one connection to the same data source. The data source is then associated
with more than one connection definition. When a Cognos Analytics user queries a data source, the query
engine must connect to it. The query engine obtains information about the data source from the content
service. However, if the response includes information about two or more connections, the result is an
ambiguous connection condition.

When an ambiguous connection condition occurs, the user is prompted to select the connection that the
query engine will use.

As administrator, you can prevent ambiguous connection conditions from occurring. This ensures that a
user won't be prompted during a query operation. You can achieve this in two ways:

• by modifying who can use the data source connection
• by modifying the status of the data source connection

Note: After you modify a data source connection using one of these methods, it can take several minutes
for the Dynamic Query server to apply your changes. Applications that use the Compatible Query engine
apply your changes immediately.
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Example: Modifying user access to a connection
The data source dsone includes the connections connone and conntwo. The user userone runs a
report on the data source dsone. While the report is running, userone is prompted to choose which
connection they want to use.

To ensure that userone does not encounter this ambiguous connection condition again, you edit the
userone's access to the connone connection:

1. Click Manage > Data server connections.
2. In the connection list, click connone.
3. Click the Permissions tab.
4. Select Override parent permissions.

5. Click the add icon , and specify access for a group or role to which userone does not belong.
6. Remove access for roles and groups that include userone by clicking the Remove selected item icon

.
7. Click Apply.

The next time userone runs the report, the query engine again requests information about the data
source dsone. However, now the response returns only the connection conntwo, as this is the only
connection that userone can access.

Example: Modifying a connection's status
The data source dsone includes the connections connone and conntwo. The user usertwo runs a
report on the data source dsone. While the report is running, usertwo is prompted to choose which
connection they want to use.

To ensure that any user, including usertwo, does not encounter this ambiguous connection condition
again, you decide to disable the connone connection:

1. Click Manage > Data server connections.
2. In the connection list, click connone.
3. Click Advanced.
4. Select the Disable this entry check box.

The next time any user runs the report, the query engine again requests information about the data
source dsone. However, now the response returns only the connection conntwo, as this is the only
connection that any user can access.

Query service warnings related to unknown data types
When the query service encounters the Unknown data type while processing queries, it might return a
warning.

The query service allows expressions to reference in-database functions whose signature (input and
output types) is unknown to IBM Cognos Analytics. As queries are validated and planned, the query
service checks the data type information. If the data type is Unknown, a warning might be returned.

A known issue exists with the IBM JCC (JDBC) driver and Db2 where the expected response from JDBC
DatabaseMetadata.getFunctionColumns method is not returned. Consequentially, the return type
of the function is unknown to the query service from the model, which results in a warning.

To work around this issue, you can enclose the in-database function in another function that is known to
the query service, such as CAST. For example, CAST( myUDF ( ... ) , integer ). Then, the query
service uses the data type information that is returned by that function.

Note: It's not mandatory to import a function into a Framework Manager model before a function can be
referenced in an expression. By importing a function, the metadata, including the data type, about the
function is made available to the query service.
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Cloudera Impala JDBC drivers
IBM Cognos Analytics supports connections to Cloudera Impala data servers that use JDBC drivers
version 2.5.34 and later. JDBC drivers earlier than 2.5.34 are not supported.

When attempting to connect to Cloudera Impala, the query engine checks the version of the JDBC driver.
If the version is earlier than 2.5.34, an error message is returned.

To avoid potential issues, replace older versions of JDBC drivers for Impala in the Cognos
Analytics environment with newer versions. The driver can be downloaded from the Cloudera
website (www.cloudera.com/downloads/connectors/impala/jdbc/2-5-34.html). For more information,
see Cloudera documentation.

Stalled queries in the Pivotal HDB engine
Queries might become stalled in the Pivotal HDB engine because of a defect in the Pivotal optimizer.

To resolve the problem, the Pivotal administrator can change the server defaults, or add the following
command block for the connection in IBM Cognos Administration.

<commandBlock>
  <commands>
   <sqlCommand>
    <sql>select disable_xform('CXformExpandNAryJoinDP')</sql>
   </sqlCommand>
  </commands>
</commandBlock>

If a table was created in HDB with partitioning, the Pivotal JDBC driver returns metadata for each partition
of the table. Currently, there is no means in the Pivotal software to prevent it from returning the extra
metadata. A modeler in IBM Cognos Analytics does not need to include that additional metadata for
queries to work.

Denodo 5.5 and 6.0 data servers
The Denodo 5.5 and 6.0 data server types are supported through the Denodo JDBC driver.

The minimum supported version of Denodo 5.5 is update 20160322 that must have Denodo hot fix
#26682 applied. Previous versions of Denodo 5.5 are not supported.

The initial release of Denodo 6.0 GA requires Denodo hot fix #26681 to be applied.

Denodo requires a 6.0 JDBC driver when accessing a 6.0 server, and a 5.5 JDBC driver when accessing a
5.5 server.

Denodo 5.5 JDBC drivers do not prevent connections against a 6.0 server. If this situation occurs, the 6.0
server might throw exceptions while running queries or attempting to import metadata.

Data servers no longer supported in Cognos Analytics
The list of supported data servers is continuously evaluated. New data servers are added, and some of the
previously supported data servers are removed.

All data server connections that were defined in previous releases of Cognos Analytics remain in the
content store until they are manually deleted or changed to a supported type where applicable. These
connections are visible in the product administration interfaces. When such connections are opened in
IBM Cognos Administration, they appear in the connection editor of type Other type. This connection
editor provides a limited interface to view or edit the connections, and to access the associated signons.

Each data server connection in the content store is represented by a string with various custom names
and values. This string is visible in the connection editors in Cognos Analytics. For example, when testing
a connection, a string such as the following one is displayed:

^User ID:^?Password:;LOCAL;PG;DSN=MyDataSourceName;
UID=%s;PWD=%s;MyODBCDSN@ASYNC=0@0/0@COLSEQ= 
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The connection type in the string is shown after the value LOCAL. In the above example, the connection
type is PG.

If your current version of Cognos Analytics is using connections to data servers that are no longer
supported, in some cases you can change the connections to the supported types.

Cognos Analytics 11.1.3
Pivotal HDB data server is no longer supported in Cognos Analytics.

The associated data server type in the administration interfaces, Pivotal Greenplum and HDB, is changed
to Pivotal Greenplum.

Cognos Analytics 11.0.8
The following data servers are not supported as of the 11.0.8 release:

• Hitachi Advanced Data Binder Platform (JDBC)
• IBM Domino (JDBC)
• MongoDB Connector for BI version 1

Update any version 1 connections to use MongoDB Connector for BI version 2.2.1. Also, update existing
Cognos models while connected to version 2.2.1. This will ensure that the model metadata reflects
differences in data types and scale that were introduced in MongoDB Connector for BI 2.2.1.

Cognos Analytics 11.0.6
The following data servers are not supported as of the 11.0.6 release:

• Actian Matrix (ODBC and JDBC)

Generic ODBC connection types can be used to refer to an ODBC DSN that uses an ODBC driver on
Microsoft Windows operating systems to access an Actian Matrix server. You will not be able to use an
existing JDBC connection.

• Actian Vector (ODBC)

Generic ODBC connection types can be used to refer to an ODBC DSN that uses an ODBC driver on
Microsoft Windows operating systems to access an Actian Vector server.

• IBM® IMS™ (JDBC)

Cognos Analytics 11.0.3
The following data servers are not supported as of the 11.0.3 release:

• IBM Cognos Finance - connection type CL
• Microsoft SQL Server Analysis Services 2005 and 2008 (ODBO) - connection types YK and M8

Applications on Windows operating systems should use the ODBO client that is released with the
supported Microsoft Analysis Services version. Applications on non-Windows platforms can use an
XMLA (connection type X8) connection. The ODBO clients releases with SQL Server Analysis Services
2005, 2008 and 2008 R2 are no longer supported. Connections for versions 2012 (connection type
M12) and 2014 (connection type M14) are both supported. New connections that reference the 2012 or
2014 clients should only be used for version 2012 and 2014 of the corresponding SQL Server Analysis
Services servers.

As of Cognos Analytics 11.0.0, only dynamic query mode servers support SQL Server Analysis Services.
The compatible query mode does not support SQL Server Analysis Services.

• Microsoft SQL Server 2005 and 2008 Native Clients, and OLE DB (connection type OL and
Provider=SQLNCLI or SQLNCLI10)
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Older versions of the Microsoft SQL Server client libraries are no longer supported ( https://
msdn.microsoft.com/en-us/library/cc280510.aspx). For applications that must access SQL Server via
OLE DB, you can use Native Client connections that include the Provider=SQLNCLI11. These
connections are parallel to the current SQL Server Native Client version 11 that is supported with SQL
Server 2016, 2014, and 2012. Alternatively, connections that use the Microsoft ODBC driver for SQL
Server can be used.

• SAP ECC

Cognos Analytics 11.0.2
The following data servers are not supported as of the 11.0.2 release:

• Composite (ODBC)

Composite (connection type CS): Generic ODBC (OD) connection types can be used to refer to an ODBC
DSN which may be using a an ODBC driver on Window operation systems to access Siebel servers.
Dynamic query mode supports several technologies, including Cisco Information Server and Denodo via
JDBC that could potentially be used to provide federated access to Siebel systems.

• IBM Cognos Now! - Real-time Monitoring Cube (connection type LA)

There is no alternative connection type.
• IBM Cognos Planning - Series 7 (connection type CR)

There is no alternative connection type.
• IBM Cognos Virtual View Manager (ODBC)
• IBM Red Brick® (ODBC)
• Progress OpenEdge (ODBC)
• Siebel
• Sybase Adaptive Server Enterprise (CT-Lib)

Errors related to mismatched SQL and Java data types
A table column might use a vendor data type which the JDBC driver does not directly support and
attempts to return as another data type such as VARCHAR.

For example, a table includes a column of type ARRAY and a column of type STRUCT which the JDBC
driver describes as a VARCHAR. Effectively, to IBM Cognos Analytics, those columns and VARCHAR data
types and any operation the vendor supports involving a VARCHAR are supported. Cognos Analytics may
generate a SQL statement including operations, such as COUNT, DISTINCT or ORDER BY referencing
those columns. The statement may not execute if the vendor does not support those operations on the
data type of the column (for example, ARRAY).

These types of errors might occur when both of these conditions are true:

• You import schema metadata from a database, for example, to create data modules,
• The options to retrieve sample data are turned on.

For more information, see “Loading metadata” on page 45. Similar errors might occur when you create
and test model query subjects in Framework Manager.

To avoid errors that are related to mismatched data types, try these solutions:

• Read the related database vendor documentation to find out how a JDBC driver defines the SQL data
types that are supported by the database.

• Define in-database views or expressions that convert the mismatched data types into types that are
recognized by Cognos Analytics.

For more information, see "Unknown types" in the IBM Cognos Analytics Data Modeling guide.
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Updates by release
Cognos Analytics supports many different data servers. In different releases, data servers are added,
changed, or removed.

To view an up-to-date list of data servers that are supported for specific versions of Cognos Analytics, go
to the IBM Cognos Analytics 11.1.x Supported Software Environments page. In the release section, for
example 11.1.3, click one of the following links to view a detailed report about supported data sources:

• Under Requirements by type, click the Software link. On the Supported Software tab, go to the Data
Sources section. All supported data sources are listed in the table.

• Under Requirements by platform, click the operating system name, such as Linux. On the Supported
Software tab, go to the Data Sources section. All data sources that are supported for the chosen
operating system are listed in the table.

Cognos Analytics 11.1.7 - new features
IBM Cognos Analytics supports Microsoft Analysis Services 2019 connections and JWT authentication
with Db2 data server.

Microsoft Analysis Services 2019 (ODBO and XMLA)
Cognos Analytics supports the Microsoft Analysis Services 2019 data server (ODBO and XMLA).

Existing connections that are moved to this server might lose signons.

Reports that were created against previous versions of the data server still work after they are switched to
use the new client and server. The client and server versions must match.

Similar to other Microsoft Analysis Services MSOLAP versions, the Microsoft Analysis Services MSOLAP
client must be installed to the same location as the report server. For this version of Microsoft Analysis
Services, the MSOLAP version 15 client is required.

To create a connection to the new data server from the Manage > Data server connections
administration interface, select the generic Microsoft Analysis Services data server type, and then select
2019.

Support for JWT authentication with Db2 data server connections
A connection to a Db2 data server using the IBM JCC JDBC driver can be configured to pass a JSON Web
Token (JWT) when authenticating to the database.

To use this functionality with a Db2 data server connection, Cognos Analytics must be configured to
use an OpenID Connect authentication provider. To provide the token, the connection settings must
specify the OpenID Connect namespace that was configured as an identity provider. The identity provider
namespace must be capable of returning claims in the JWT that Db2 requires.

When setting the Db2 data server connection, choose the Use an external namespace authentication
method. For more information, see "Creating a data server connection" in Managing IBM Cognos Analytics.

For information about configuring an OpenID authentication provider, see "OpenID Connect
authentication provider" in IBM Cognos Analytics Installation and Configuration Guide.

For information about which Db2 and IBM JCC versions support JWT authentication, refer to the Db2 and
IBM JCC documentation.
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Cognos Analytics 11.1.5 - new and changed features
The Microsoft Azure Analysis Services data server was added, and a new default driver class name was
introduced for the Google BigQuery connections.

Microsoft Azure Analysis Services data server
The Microsoft Azure Analysis Services data server connections are supported for IBM Cognos Analytics
on premises, on Microsoft Windows only.

Changes to the Google BigQuery data server connections
New connections to the Google BigQuery data server in Cognos Analytics use the
com.simba.googlebigquery.jdbc42.Driver driver class name by default.

Before the BigQuery JDBC driver version 1.2.2.1004 was introduced, Google provided two BigQuery JDBC
drivers, each of them using a distinct driver class name. New Google BigQuery connections in Cognos
Analytics used the com.simba.googlebigquery.jdbc41.Driver driver class name by default.

As of version 1.2.2.1004, Google provides a single BigQuery JDBC driver, which references the driver
class name com.simba.googlebigquery.jdbc42.Driver. New connections to Google BigQuery in
Cognos Analytics now use this driver class name by default.

If you have existing Google BigQuery connections that refer to the
com.simba.googlebigquery.jdbc41.Driver driver class name, you must update them to
com.simba.googlebigquery.jdbc42.Driver to use the BigQuery JDBC driver 1.2.2.1004 or later.

Cognos Analytics 11.1.4 - new and changed features
The IBM Weather Company data server was added, and changes were made to the Presto and
Salesforce data servers.

IBM Weather Company data server
Use the IBM Weather Company data server to make The Weather Company data available for use in
Cognos Analytics.

Presto JDBC driver name change
The Presto driver class name for version 300 and higher has changed from
com.facebook.presto.jdbc.PrestoDriver to io.prestosql.jdbc.PrestoDriver. If you
prefer to use the older driver, such as version 215 or 214, you must manually change the driver class
name back to com.facebook.presto.jdbc.PrestoDriver.

Salesforce connection URL change
The Salesforce data server connection now uses the https://login.salesforce.com URL.

If your Cognos Analytics environment includes a Salesforce data server connection, you must manually
update the URL endpoint to https://login.salesforce.com.

For more information, please refer to the following Salesforce article: Salesforce.com API Endpoint
retirement.
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Cognos Analytics 11.1.3 - new and changed features
The changes affect Pivotal Greenplum and SAP BW data server connections, as well as connections that
use type 2 JDBC drivers.

Connect to an open source Greenplum server using the PostgreSQL JDBC driver
You can use the PostgreSQL JDBC driver to connect to an open source Pivotal Greenplum server.

To create a data server connection to an open source Greenplum server, version 5 or later, use the
PostgreSQL JDBC driver and connection editor. When you test the connection in the administration
interfaces, the sub-type of Greenplum is displayed when the connection is successful.

To create a data server connection to a proprietary Greenplum server, use the Pivotal Greenplum JDBC
driver and connection editor.

SAP BW 7.5 client is required for SAP BW data server connections
The client SAP NetWeaver RFC library 7.20 that was used with previous versions of Cognos Analytics is no
longer supported. SAP NetWeaver RFC Library 7.50 is now the supported library.

Changed location for type 2 JDBC driver libraries
When using type 2 JDBC drivers, you need to copy the accompanying non-JAVA libraries to the Cognos
Analytics install_location\drivers directory.

In previous releases, the install_location\BIN64 directory was used to store the libraries.

This change is a result of java.library.path now using the install_location\drivers directory
in the path.

Type 2 JDBC drivers might still be used with SQL Server and Oracle databases.

Cognos Analytics 11.1.2 - new features
IBM Cognos Analytics supports two new versions of Microsoft Analysis Services data servers, and JWT
authentication with SAP HANA data server.

Microsoft Analysis Services (HTTP XMLA)
Cognos Analytics supports the Microsoft Analysis Services (HTTP XMLA) data server.

Existing connections to Microsoft Analysis Services 2017 servers still work. Reports that were created
against previous versions of the server work after they are switched to use the new server.

To create a connection to the new data server from the Manage > Data server connections
administration interface, select the generic Microsoft Analysis Services data server type, and then
select HTTP XMLA. When creating the connection from the Manage > Administration console interface,
Microsoft Analysis Services (HTTP XMLA) is available in the list of data server types.

Microsoft Analysis Services 2017 (ODBO)
Cognos Analytics supports the Microsoft Analysis Services 2017 (ODBO) data server.

Existing connections that are moved to this server might lose signons.

Reports that were created against previous versions of the data server still work after they are switched to
use the new client and server. The client and server versions must match.

Similar to other Microsoft Analysis Services MSOLAP versions, the Microsoft Analysis Services MSOLAP
client must be installed to the same location as the report server. For this version of Microsoft Analysis
Services, the MSOLAP version 14 client is required.
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To create a connection to the new data server from the Manage > Data server connections
administration interface, select the generic Microsoft Analysis Services data server type, and then select
2017. When creating the connection from the Manage > Administration console interface, Microsoft
Analysis Services 2017 (ODBO) is available in the list of data server types.

Support for JWT authentication with SAP HANA data server connections
A connection to an SAP HANA data server that uses the SAP HANA JDBC driver can be configured to pass
a JSON Web Token (JWT) when authenticating to the database.

To use this functionality with an SAP HANA data server connection, Cognos Analytics must be configured
to use an OpenID Connect authentication provider. To provide the token, the connection settings must
specify the OpenID Connect namespace that was configured as an identity provider. The identity provider
namespace must be capable of returning claims in the JWT that SAP HANA requires.

When setting the SAP HANA data server connection, choose the Use an external namespace
authentication method. For more information, see Creating a data server connection..

For information about configuring an OpenID authentication provider, see "OpenID Connect
authentication provider" in IBM Cognos Analytics Installation and Configuration Guide.

Cognos Analytics 11.0.9 - new and changed features
The changes improve IBM Cognos Analytics server performance and ensure compliance with supported
database products.

Teradata JDBC connections - improved query concurrency
Dynamic query mode was changed to ensure that only one query can be running against a Teradata
JDBC connection. This change improves query concurrency, as described in the multi-threading section
of the Teradata JDBC Driver Reference (https://teradata-docs.s3.amazonaws.com/doc/connectivity/jdbc/
reference/current/jdbcug_chapter_2.html#BGBEFIH4).

Database administrators who monitor their database workloads might notice an increase in the number of
database connections comparing to previous releases of Cognos Analytics.

Snowflake connections - changed driver class name
In prior releases of Cognos Analytics, the default driver class name for new Snowflake
connections was com.snowflake.client.jdbc.SnowflakeDriver. Starting with Cognos
Analytics version 11.0.9, the default driver class name for new Snowflake connections is
net.snowflake.client.jdbc.SnowflakeDriver.

Existing connections will continue to reference the Snowflake driver class
com.snowflake.client.jdbc.SnowflakeDriver. When Snowflake removes that class name from
the driver, those connections will require the Driver class name property to be changed to
net.snowflake.client.jdbc.SnowflakeDriver.

Tip: To edit a data server connection, go to Manage > Administration console. On the Configuration tab,
select Data source connections. Find the data server connection and open it. You cannot edit existing
connections from Manage > Data server connections.

Amazon Redshift connections - changed driver class name
In previous releases of Cognos Analytics, the default driver class name for new
Amazon Redshift connections was com.amazon.redshift.jdbc41.Driver, which required the
RedshiftJDBC41.*.jar file.

Starting with Cognos Analytics version 11.0.9, the default driver class name for new Amazon Redshift
connections is com.amazon.redshift.jdbc.Driver. This driver class name is used by Amazon JDBC
driver version 1.2.1 or higher. The associated driver file is RedshiftJDBC.jar.
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You can update existing connections by changing the Driver class name property to
com.amazon.redshift.jdbc.Driver.

Tip: To edit a data server connection, go to Manage > Administration console. On the Configuration tab,
select Data source connections. Find the data server connection and open it. You cannot edit existing
connections from Manage > Data server connections.

PostgreSQL connections can be used with Amazon Aurora PostgreSQL
Starting with this release, you can use the existing PostgreSQL connection editor and JDBC driver to
create and maintain data server connections to Amazon Aurora PostgreSQL.

Cognos Analytics 11.0.8 - new features
IBM Cognos Analytics added support for the following data servers: MongoDB Connector for BI 2.2.1,
Spark SQL 2.1 Thrift server, Azure SQL Data Warehouse, Amazon Redshift, and Amazon Athena.

MongoDB Connector for BI 2.2.1
Cognos Analytics supports MongoDB Connector for BI version 2.2.1 through the MySQL JDBC driver that
is required by MongoDB. MongoDB Connector for BI 2.2.1 does not use Postgres JDBC driver and server
technology to access MongoDB 3.x servers.

MongoDB Connector for BI version 1 is no longer supported. Update any version 1 connections to use the
new version. Also, update existing Cognos models while you are connected to version 2.2.1. This ensures
that the model metadata reflects differences in data types and scale that were introduced in MongoDB
Connector for BI 2.2.1.

Spark SQL 2.1 Thrift server
Cognos Analytics supports the Spark SQL 2.1 Thrift server through the SIMBA (Magnitude) JDBC driver for
Spark SQL.

Azure SQL Data Warehouse
Connections to Azure SQL Data Warehouse are maintained by using the Microsoft SQL Server connection
editor.

Amazon Redshift
By default, the Amazon Redshift users must copy a version of the RedshiftJDBC41*.jar file to the
Cognos Analytics install_location\drivers directory. While there is no requirement to use a 4.0
or 4.2 driver, you can edit the default driver class name to correspond to the driver class names
that are supported by Amazon. Amazon JDBC drivers, starting with version 1.2.1, support the generic
com.amazon.redshift.jdbc driver. This driver can be used instead of the previous driver class names.

Amazon Athena
Cognos Analytics supports Amazon Athena through the Amazon Athena JDBC driver. A connection must
specify a valid Amazon S3 location by using the Amazon Athena s3_staging_dir connection property from
which the driver retrieves query results.
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Cognos Analytics 11.0.7 - new and changed features
MemSQL and Presto are added as supported data server types, and MariaDB has its own connection
editor.

MemSQL
Starting with this release, MemSQL data server types are supported. To maintain a connection for this
data server, use the MySQL connection type and Connector/J JDBC driver.

Presto
Starting with this release, Presto (version 0.167 and later) data server types are supported. Both the
Presto and Teradata Presto JDBC drivers can be used. Connections to this data server are maintained by
using the Presto or Teradata Presto connection editor, depending on which JDBC driver is used.

Tip: Current releases of Presto have limited support for fixed-length character types (CHAR), which
can result in incorrect results. To avoid this limitation, generate expressions that use a varying length
character type.

MariaDB
Starting with Cognos Analytics 11.0.7, MariaDB data server has its own connection editor that supports
MariaDB Connector/J JDBC driver.

In previous releases, connections to MariaDB were defined by using the MySQL connection editor and
MySQL Connector/J JDBC driver.

The MariaDB Connector/J driver returns version details. This enables dynamic query mode to use the SQL
enhancements that are introduced in MariaDB 10.2.4. When connections are defined by using the MySQL
JDBC driver, these features cannot be used and more local processing might occur in the dynamic query
mode.

Data modules
Data modules contain data from data servers, uploaded files, data sets, other data modules, and from
relational, dynamic query mode packages.

Data modules are created in the web modeling component in IBM Cognos Analytics, and saved in Team
content or My content. You can use multiple input sources for a single data module.

Tip: If you create a data module using data from an uploaded file and you want the data to be available
to other users, then store both the data module and the file in Team content. This ensures that another
user can run a report that references the data. This restriction applies to report authors and consumers.
Administrators can run reports that use data from any user's My content folder.

Data modules can be used as sources for reports, dashboards, stories, explorations, notebooks, data sets,
and other data modules.

For more information, see the IBM Cognos Analytics Data Modeling Guide.

Data modules that are sourced from IBM Planning Analytics cubes are created in the administration
component. For more information, see “Creating data modules from Planning Analytics cubes” on page
58.

Creating data modules from Planning Analytics cubes
After successfully establishing a connection to an IBM Planning Analytics TM1 database server, you can
browse its cubes and use them to create data modules.

Data modules that contain Planning Analytics cubes can be used to create reports, dashboards, stories,
and other Cognos Analytics content in the same way as packages that contain Planning Analytics cubes
are used.
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Before you begin
A successful connection of type IBM Planning Analytics to the TM1 database server must already be
created. For more information, see “Creating a data server connection” on page 23.

About this task
The following restrictions apply when you create a data module from a Planning Analytics cube:

• Only hierarchy member subsets are supported
• The following Planning Analytics subsets are not supported:

– Multi-hierarchy member sets

Tip: You can modify a Planning Analytics data source that has multiple measure hierarchies so that
reporting results are valid. See “Example: Modifying a PA data source to have only one measure
hierarchy” on page 60.

– Control subsets with "}" in the first position in the subset name
– Rollup subsets created in Planning Analytics views. These subsets are tuple sets, not member sets.
– Subsets with an invalid MDX expression or an empty member set

Procedure
1. In Manage > Data server connections, locate an existing IBM Planning Analytics data server

connection.
2. Click the data server to open its properties.
3. On the Connections tab, click the connection to access its properties.
4. Click the Cubes tab.

The list of cubes that the connection includes is displayed.

5. From a cube context menu , click Create data module.
6. Type the module name, and save it to a location in Team content or My content.

Tip: In Team content, you must save items inside folders.

A message at the top of the application page confirms that the data module was successfully created.
7. If the database contains more cubes, repeat steps 5 to 6 to create a data module for any of the

remaining cubes.

Results
The data modules are created in the location that you specified.

What to do next
Use the data modules to create dashboards, explorations, and other Cognos Analytics content against
Planning Analytics cubes.
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Example: Modifying a PA data source to have only one measure hierarchy
This example begins with a report on a Planning Analytics data source with multiple measure hierarchies
that originally yields invalid results. To resolve the issue, you remove the additional measure hierarchies
so that only one hierarchy remains.

Problem
In Cognos Analytics, you run a report on a Planning Analytics data source that uses multiple measure
hierarchies. However, in the report output, the values in one measure are incorrectly repeated in another
measure.

Here is the expected result, as obtained in Planning Analytics:

Here is the actual result in Cognos Analytics:

Cause
The measure values are repeated because Cognos Analytics does not support PA data sources that use
more than one measure hierarchy.

Solution
To resolve this issue, remove the additional measure hierarchies so that only one hierarchy remains.

1. In Architect, locate the measure dimension by checking the properties of the cube.

2. Check the existing hierarchies of that dimension by using the }HierarchiesProperties Control Cube.
3. Use the HierarchyDestroy function in a TI process to remove all the additional hierarchies from the

measure dimension.
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Tip: Ensure that you also remove the Leaves hierarchy.
4. In Cognos Analytics, run the report again on the modified PA data source.

The report output now appears as expected.

Packages
A package is a subset of a model, which can be the whole model, that is made available to the IBM
Cognos Analytics application.

Relational packages are created in IBM Cognos Framework Manager, and OLAP packages in IBM Cognos
Cube Designer and in IBM Cognos Administration. For more information, see the chapter on publishing
packages in the IBM Cognos Framework Manager User Guide.

Not all types of packages can be used in all Cognos Analytics components. Only Reporting can use all
types of packages traditionally supported in earlier versions of Cognos Analytics.

For dashboards and stories, the following packages are supported:

• Relational, dynamic query mode packages.
• Relational, compatible query mode packages if there is a JDBC connection defined for each data source

in the package.
• Dimensional OLAP packages that are based on PowerCubes, dynamic cubes, TM1 data sources,

dimensionally modeled relational (DMR) data sources, and other data sources.

The modeling component supports only relational, dynamic query mode packages as sources for data
modules.

For more information, see the IBM Cognos Analytics Data Modeling Guide.

Note: Cognos Analytics doesn’t support Framework Manager namespaces, which are containers that
organize and uniquely qualify content in a model. The namespaces are shown as folders when Framework
Manager packages are viewed in data modules, dashboards, and other content.

Enriching packages
To optimize the user experience in IBM Cognos Analytics components, such as dashboards and
explorations, Framework Manager packages must be enriched.

The enrichment process associates the Cognos Analytics data characteristics, such as Time and
Geographic location, to query items in the packages. The information from the enrichment process
complements the information, such as the data type, column name, or Usage property value, that is
derived from the package metadata.

An enriched package includes the data characteristics that are required for the artificial intelligence (AI)
based functionality in the product, such as visualization recommendations or intelligently set default
values on column properties. For example, to display the relationships diagram in Explore, an enriched
package must be used. Otherwise, the relationships diagram isn’t displayed.

Tip: You can't enrich a package that includes dimensionally modeled (DMR) relational objects. Query
subjects that include prompts can be enriched, but data isn’t retrieved.

The enrichment process can be time and memory-intensive so it should be performed only when the
original package has changed. Consider reenriching the package after the following changes to the
package:

• Names of query subjects, query items, and namespaces are changed.
• Data types on query items are changed. For example, number changed to string.
• New query items are added.
• Filters or expressions are changed that significantly alter the values that the query subject would return.
• A deployment archive is imported into a new environment that uses different data from the source used

for a previous enrichment.
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When a package is republished, existing enriched metadata isn’t removed or refreshed.

Before you begin
To minimize the impact of the enrichment process on the system, consider creating smaller packages that
include only a subset of purpose-specific query subjects, and enriching only the smaller packages. For
example, a package used by advanced report authors might expose many query subjects where many of
the query subjects aren’t relevant when creating dashboards or explorations. You can create a smaller
package off the original package, and include only those query subjects that you need in your dashboards
and explorations. Enriching this smaller package requires less time and memory.

About this task
You can enrich a package metadata by using the automatic or manual process. The automatic process
evaluates all query items of all selected query subjects in the package, and automatically applies the
data characteristics to them. To minimize the impact on the system, you can deselect namespaces or
individual query subjects to exclude them from the enrichment process. In the manual process, you
explicitly apply the data characteristics to individual query items.

When enriching a package, you typically start with the automatic process. Use the manual process to
enrich only a small subset of query items or to override values that were set incorrectly by the automatic
option.

The automatic enrichment includes the option to retrieve sample data. When this option is selected, the
Cognos Analytics query engine connects to the data source and reads a sample of its data. The enrich
dialog box allows the sample size to be changed. Setting the sample size to a low value, or not sampling at
all, reduces the amount of information that the enrichment can gather. The amount of sampled data also
depends on the signons that are used to access the package underlying data sources. An ideal signon can
access the tables, views, and columns that the query subjects are based on, and a representative number
of rows and values in the queried tables and views.

To access the Enrich package functionality, you need write permissions for the package.

Procedure
1. Locate the package or its shortcut in Team content or My content.

2. From the package or shortcut context menu , select Enrich package.

Tip: If a package was used as a data module source, you can enrich the package in the modeling user
interface, from the Sources pane.

3. Select one of the following options.

• Enrich automatically

Most of the time, start with this option. The status information shows you the dates when the
package was last published and enriched (if it was enriched before).

– In the Select tables panel, you can deselect the query subjects that you don't want to be
evaluated by the enrichment process. By default, all visible query subjects in the package are
evaluated.

This option gives you the opportunity to exclude the query subjects that aren’t used in your
dashboards or explorations, and therefore reduce the time and memory usage by the system
during the enrichment process.

– To enable data sampling, select the Retrieve sample data checkbox, and specify the number of
rows of data to be retrieved.

The data sample includes some deeper data characteristics that support the product functions
that are behind the optimized user experience in dashboards, explorations, and other
components. Extracting too many rows might impact the system performance. No data sampling,
or too few rows might not provide enough information. Clearing this checkbox reduces the time
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and memory usage during the enrichment process, but the expected information might not be
gathered.

For more information, see “Data sampling” on page 47.
– Click Run.

Depending on the number of query subjects involved, the enrichment process can take some
time, potentially even hours. After the process is finished, an information message shows you the
results of the process. Even if only a certain percentage of the query subjects were enriched, you
might have enough data to support the AI-functions in your dashboards and explorations.

– Click Close.
• Enrich manually

Use this option to enrich individual query items.

– Expand the package. Then, expand a query subject, and select one or more query items.
– From the Define data representation drop-down menu, select the option that you want the data

in the query to represent, either Time or Geographic Location, and their specific values. The
Default value allows to propagate settings from the source.

– Click OK.

Data sets
Data sets are customized collections of data items that you use frequently. As you make updates to the
data set, the dashboards, stories, or explorations that use that data set are also updated the next time
you run them.

You can create data sets from packages or data modules, and use as sources to create dashboards,
stories, explorations, and data modules.

You can't create a report directly from a data set. However, to use the data from the data set in a report,
create a data module from the data set, and then use the data module as a source for your report.

The data set mechanism is based on the Cognos Analytics report foundation. You add data to a data set in
a similar manner as you add data to a list report. You can switch between Page design and Page preview
modes. The Query view provides an alternative way to modify the data sets. In this view, you can copy
and paste queries from existing reports, manage advanced filters and prompts, and rename queries.

Here is an example of a data set in the Page preview mode.
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Creating data sets
Create data sets to group customized collections of data items that you use frequently.

If a data set is based on a package with multiple data server connections or signons, the connection or
signon that you choose is saved with the data set. If the package connection information changes later,
users might see the ambiguous connection message. To avoid this message, edit the data set choosing
the new connection or signon, and save the data set using the Save as option. Select yes when asked
whether you want to overwrite the data set. The data set is saved with the new connection or signon and
its subsequent refreshes use the new information.

Before you begin
The package or data module that you plan to use as a source for your data set must already be saved in
Team content or My content.

About this task
The list in the data set can be associated with only one query. If you want to add data items from different
queries to your data set, you can create a custom query in the Queries view that contains data items from
different queries.

When creating or editing data sets, you can reuse queries from Cognos Analytics reports. For more
information, see “Reusing report queries in data sets” on page 67.

Procedure
1. Locate the package or data module in Team content or My content.

2. From the package or data module context menu , click Create data set.

The data set editor is opened in the Page design mode.
3. Drag the data items from the Insertable objects pane to the work area. The items appear as columnar

data in a similar fashion to a list report.

To preview data in the data set, switch from the Page design mode to the Page preview mode.
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4. For relational data or for data modules, select the Summarize detailed values, suppressing
duplicates, for relational data sources checkbox.

If you aren't sure if this checkbox must be selected, clear it and then select it again to see how the
data is aggregated. Condensed data with fewer rows usually leads to better performing reports and
dashboards. A reason for not aggregating the data in your data set is that you lose some details in
the process, and the data from one system might not match the data from another system. This is
especially true for calculations, such as an average.

5. Select Row suppression if you want to hide rows with no data or zeros.

Suppressing rows without data gives you a more concise view of your data set.
6. Refine the data in the data set by using the options in the on-demand toolbar

.

To view the toolbar, click any column.

To add filters to the columns or individual items of the data set, click the item, and then click the filter

icon  in the toolbar. You can add a customized filter or use one of the predefined filters.

To sort the values, click the sort icon , and select from the available sort options.

To view the column expression, click the More icon , and select Edit Query Expression.
7. Use the Query view to access more data set functionality.

From the Data set menu, click Queries to open the Query Explorer.

In this view, you can copy and paste queries from existing reports, manage advanced filters and
prompts, or rename the queries.

Here is an example of a data set in the Queries view:

Note: The query names are used as table names when the data set is used to create data modules.
Use logical names that clearly describe the data when renaming the queries.

8. Click the More icon  to access additional functionality:
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Click Validate report to validate the data set, or click Show generated SQL/MDX to view the data set
SQL.

9. Click the save icon , and choose one of the following options to save the data set:

• To save the data set for the first time or to save changes to the data set, click Save. This option
saves the metadata, but doesn’t load the data. Depending on the data set, loading data might take
some time.

• To save an updated data set as a new data set, click Save as. This option saves the metadata, but
doesn’t load the data. Depending on the data set, loading data might take some time.

• To save the data set and load the data, click Save and load data. In addition to saving the new
or changed metadata, this option loads data. The data is immediately available when you create a
dashboard or story.

Results
The data set object  is created in a location that you saved it to.

What to do next
To edit the data set, open it from Team content or My content.

You can replace data items in the data set with data items from a different query. In the Page design or
Page preview mode, click the Reset button. The previously selected data items are removed, and you can
start adding new ones to the list.

You can also replace the data module or package that was used as a source for the data set. Right-click
the source name in the Insertable objects pane, and select the Replace data module or Replace
package option, as shown in the following screen capture:
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Reusing report queries in data sets
You can reuse existing queries from Cognos Analytics reports by copying either individual queries or entire
report specifications into data sets.

The data set and the report from which you copy the queries must be based on the same type of data
source, either a data module or a package.

When you copy an individual report query, you add the query to the data set, and can continue working
with the data set.

When you copy the report specification, the data set is overwritten and you can use the query (or queries)
from the report in the data set. The report layout is not copied. The data set is renamed to the default
New data set. You can then save it as a new data set.

Procedure
1. Create or open an existing data set.
2. From Team content or My content, open the Cognos Analytics report in the edit mode.
3. Use the following steps to copy an individual query into your data set:

a) In the report, from the Report menu, click Queries to open the report Queries view.
b) Right-click the query that you want to copy, and click Copy.
c) Go back to the data set, and from the Data set menu, click Queries.
d) Right-click anywhere in the empty space in the Queries view, and click Paste. The new query is

added to the view.
e) Save the data set.

4. Use the following steps to copy the report specification:

a) From any page in the report, click the More icon , and select Copy report to clipboard.

b) Go back to the data set, click the More icon , and select Open report from clipboard.
c) Paste the report specification into the empty box that is displayed, and click OK.

You are back in the data set list view. The data source and the query in the data set were replaced.
The data set name is shown as New data set, even if you started with a data set named differently.

d) Open the Queries view. All queries from the report are copied into the data set.
e) Save the data set using the Save as option.

5. From the Data set menu, click Pages > Page1. You are back in the data set list view.
6. Click the Reset button to break the list association with the previous query.

The data items are removed from the list. You can now add data items from a different query, including
the copied report queries, to the list.

7. In the Insertable objects pane, click the Data items tab .

The report queries and their data items are shown in the tab.
8. Drag items from one query to the data set list.
9. Save the data set.

Results
Here is an example of the Queries view after a query labeled Report query was copied into the data
set. The report query was joined with a preexisting query labeled Initial query.

Chapter 3. Managing data access  67



Later, the data items from the Joined query were used to populate the list in the data set.

Uploaded files
If you want to do some quick analysis and visualizations with data files, you can upload the files to IBM
Cognos Analytics by yourself. Your data files must meet size and structure requirements.

The data in the files must be in a simple columnar format. Pivot tables or crosstabs aren’t supported.

The size limits for uploaded files are configured by administrators in Manage > Configuration > System
> Data. The settings that need to be modified are Size limit per upload of data (MB) and Size limit of
stored data per user (MB).

The following file size limitations apply to individual users:

• Maximum size of each individual file. The default is 100 MB.
• Maximum size of all uploaded files. The default is 500 MB.

The file types that you can upload into Cognos Analytics are specified below.

Microsoft Excel workbook files
The supported Microsoft Excel file formats include .xls and .xlsx workbook files.

The file formats .xlsb and .xlsm aren't supported.

68  IBM Cognos Analytics Version 11.1: Managing User Guide



All worksheets in a multi-tab workbook are uploaded simultaneously. Each worksheet appears as a
separate table in Cognos Analytics.

The following conditions apply to uploading Microsoft Excel files:

• .xlsx files that are saved in OpenOffice aren’t supported.
• Password-protected Excel files aren’t supported.
• Filters in Excel files are ignored. You can use the filtering options in data modules to reapply the filters.
• Comments before the first header row are interpreted as column headers.

Text before the first row that describes the worksheet is incorrectly read as a column header. If
you need a description of the worksheet, leave an empty row at the end of your data, and add the
description under the empty row.

• Totals and subtotals are treated as part of the data.

Totals can be mistaken as unsummarized data, and give misleading results. Consider removing totals
and subtotals from your data before uploading the file.

• Each file can contain a maximum of 2000 columns.

However, for better query performance, avoid uploading files with hundreds of columns. Try to remove
redundant columns and rows from the files before uploading the files.

For more information, see “Best practices for improving query performance on uploaded files” on page
72.

Delimiter-separated values files
The supported delimiter symbols include commas, tabs, semi-colons, and pipes ( | ). The file extension
can be .csv, .tsv, .tab, or .txt.

The following conditions apply to uploading delimiter-separated values files:

• Quotation mark characters escape literal values. Single quotation marks (') and double quotation marks
(") are supported.

• Record separators separate rows. Newline (\n), carriage return (\r), and carriage return followed by
newline (\r\n) are supported.

• If your file is encoded as Unicode, it must contain a byte order mark (BOM) as the first character.
• Each string value in a file can contain a maximum of 5000 characters. Any extra characters are

truncated.
• The date and time values in the files must be in a supported format. Otherwise, the data might not be

rendered properly in visualizations. Cognos Analytics supports the ISO 8601 standard formats for times.

The following date formats are supported:

– M/d/yy
– MMM d, y
– MMMM d, y
– dd-MM-yy
– dd-MMM-yy
– yyyy-MM-dd

The following time formats are supported:

– h:mm a
– h:mm:ss a
– h:mm:ss a z
– HH:mm
– HH:mm z
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– HH:mm:ss
– HH:mm:ss.SS
– HH:mm:ss z
– HH:mm:ss.SS z

Jupyter Notebook files (.ipynb)
You can upload Jupyter Notebook (.ipynb) files that were created in a Jupyter environment outside of
Cognos Analytics.

For more information, see "Uploading external notebooks" in the IBM Cognos Analytics Getting Started
guide.

Compressed files (.zip and .gz)
The compressed file types that you can upload to Cognos Analytics are .zip and .gz files.

The .zip file can contain files with different (supported) extensions, such as .csv, .xls, .xlsx,
or .txt. The .gz format can be used only with .csv files, which means that only the .csv.gz extension
is supported.

When a .zip file is uploaded, all files inside the ZIP archive are treated as if they were from one Excel
workbook, and a table is created for each file. If a file inside the ZIP archive contains multiple worksheets,
a table is created for each worksheet. Each of those tables is named using the FileName - SheetName
naming convention. For example, a .zip file contains the Product.csv and Geography.xlsx files,
where Geography.xlsx contains two sheets, Country and Region. After the .zip file is uploaded to
Cognos Analytics, the file is shown with the following 3 tables: Product, Geography - Country, and
Geography - Region. Cognos Analytics tries to detect joins between all of these tables.

The files inside a ZIP archive are saved together in Team content or My content. You cannot replace a
subset of files that were uploaded as a single .zip file. The whole .zip file must be replaced.

Uploading files
You can upload supported file types that are stored in any location to which your computer has local or
LAN access.

You can upload each data file individually or upload multiple files concurrently. Multiple files can also be
compressed for a one-step upload.

Procedure
1. Use the following methods to upload files:

• In the vertical application toolbar, tap  New, and then tap Upload files. Locate the files on your
local drive or on the LAN, and select one or multiple files to upload them.

• In the welcome page, drag one or multiple files from your local drive onto the welcome page
to activate the Quick launch functionality. When Quick launch appears, drop the files into
the appropriate box to immediately start building a data module, exploration, dashboard, or a
notebook.

• In the welcome page, tap the Browse link at the bottom of the page. Locate the files on your local
drive, and select one or multiple files to upload them.

• From a folder in Team content or My content, click the New  icon, and select Upload files.
Locate the files on your local drive or on the LAN, and select one or multiple files to upload them.
The files are saved to the folder from which you initiated the upload.

Tip: At different upload stages, progress and error messages are shown for single-file uploads and
consolidated, progress messages for multi-file uploads.
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2. Optional: If the Replace data message is displayed, it means that a file was uploaded before, and you
can either replace or append data to the file. For more information, see “Updating data in uploaded
files” on page 71.

Results
By default, the uploaded files are saved in My content. When the upload was initiated from a specific
folder in Team content or My content, the files can be saved to that folder.

If you specified a different default, shared location in Team content for uploaded files at the role, tenant,
or global level, users can save uploaded files to this location. For more information, see Edit the default
user profile.

What to do next
Use uploaded files to create dashboards, stories, explorations, data modules, or data sets.

To join two uploaded files, create a data module using them as sources.

Reporting can't use uploaded files directly. However, they can be incorporated into a data module, which
can then be used as a source in Reporting.

Updating data in uploaded files
You can replace or append data in an uploaded file with data from an external file.

About this task
During the Replace file operation, you put data from an external file in the place of data in an uploaded.

During the Append file operation, you add rows of data from an external file at the end of data in an
uploaded file.

To perform both these operations with success, the following conditions must be fulfilled:

• External file contains data, not only column names.
• The names of columns are the same in both files.
• Data types of columns in the external and uploaded files are compatible. For more information, see Data

type compatibility while replacing or appending files.

When you replace a file, the order of columns in the external and uploaded files can be different. Also, the
external file can contain additional columns with arbitrary names.

Procedure
1. In Team content or My content, locate the uploaded file that you want to update.
2. Click the Action menu icon , and choose one of the following options from the context menu:

• Replace file
• Append file

Tip: While the file is being updated, progress and error messages are displayed.

Results
You replaced or appended data in the uploaded file with data from an external file. The name of the
updated file does not change.
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Data type compatibility while replacing or appending files
Column data types in the original and incoming file must be compatible to replace or append data in
uploaded files.

Otherwise, IBM Cognos Analytics might return the MSR-UPL-2128 error. This error is thrown when the
column data type in the original file is incompatible with the detected data type for the same column in
the incoming file. The error is returned to prevent data type changes that might cause problems in existing
dashboards, reports, or other content.

To avoid this error, ensure that the data types of columns in the original file and in the file that is used to
replace or append data are compatible. The following table shows compatible data types for the Replace
file functionality:

Data type in the original file Compatible data types in the incoming file

VARCHAR VARCHAR, BIGINT, DOUBLE, DATE, TIME,
TIMESTAMP

BIGINT BIGINT, DOUBLE

DOUBLE BIGINT, DOUBLE

DATE DATE

DATETIME TIME

TIMESTAMP TIMESTAMP

Note: When replacing a file, the compatible data type replaces the data type in the original file. As a
result, you might now see the MSR-UPL-2128 error for the original file. For example, a file containing
DOUBLE values was replaced with a file containing BIGINT values. Now, you can no longer append the
original file containing the DOUBLE values.

The following table shows compatible data types for the Append file functionality:

Data type in the original file Compatible data types in the incoming file

VARCHAR VARCHAR, BIGINT, DOUBLE, DATE, TIME,
TIMESTAMP

BIGINT BIGINT

DOUBLE BIGINT, DOUBLE

DATE DATE

TIME TIME

TIMESTAMP TIMESTAMP

Note: When appending a file with a compatible data type, the data type in the original file is preserved. In
this case, you can see this type of error message: MSR-UPL-2128 Original column "Price" type “BIGINT"
doesn't match column "Price" type "DOUBLE" at the same position.

Best practices for improving query performance on uploaded files
IBM Cognos Analytics can process large uploaded files. However, to improve query performance and save
memory, consider some best practices.

Apply the following best practices before uploading files to IBM Cognos Analytics:

• Save frequently calculated expressions as columns.
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This practice reduces the amount of expression evaluation at run time. Projecting, comparing, and
sorting simple column references and simple values (literals) is more efficient than evaluating
expressions.

• Avoid storing large numbers of columns that are never used by queries.

While data is both compressed and encoded to reduce the amount of storage, it’s still recommend to
avoid storing redundant or unnecessary columns.

• Sort the input on the column that is most frequently used in filters.

For large uploaded files, sorting the input can enhance the evaluation of predicates. Sorting the data on
the common column that is used in a filter, for example Country or Store, groups rows with the same
value. If a query includes predicates on that column, the query can determine more efficiently which
blocks of data it can ignore as it navigates the data.

Data types used to store data in uploaded files and data sets
IBM Cognos Analytics applies its own data types to data in uploaded files and data sets.

The data in uploaded files and data sets is stored in the following data types:

• All integer types (smallint, integer, and bigint) are stored as bigint.
• All approximate numeric types (real, float, and double) are stored as double.
• All precise numeric values are stored as decimal to the maximum precision of 38.
• All character types (char, nchar, varchar, nvarchar, clob, nlclob) are stored as national varchar with no

maximum precision.
• All temporal types (date, timestamp, time, timestamp/time with time zone) are stored as timestamp.
• Interval types are stored in a format understood to be an interval. Report server renders interval values.

In previous releases, the value was stored as a string.

If a source value is a decimal data type with a precision > 38, the query service attempts to store the
value as a decimal type with a precision of 38. If a value is too large, the query service returns an error
indicating the source column, value, and logical row number in the input data. The scale of a precise value
can be reduced by specifying a CAST expression with a scale smaller than 38.

Trailing spaces are removed from any character values.

Timestamps and times with time zones are normalized to a value based on the coordinated universal time
(UTC).
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Chapter 4. Configuring system settings

You can configure system settings that affect all users and components in your Cognos Analytics
environment.

Configuring appearance
Administrators can enable certain elements to appear in the Cognos Analytics user interface.

Procedure
1. Go to Manage > Configuration > System, and select Appearance.
2. Specify values, as required, for the following settings:

Property Setting Result

Load content by pages in
Accounts

Enabled(default) In Manage > People >
Accounts, the list of user,
group, and role entries is split
into separate pages. When
you manage accounts, you can
navigate more quickly between
pages to find entries.

Disabled The list of entries appears as
one scrollable list.

Items per page in Accounts number

Default=200

If Load content by pages
in Accounts is enabled, the
number of namespace entries
per page.

Launch Cognos legacy UI 1 Legacy BI components are
enabled. Users can access
Analysis Studio, Drill-through
definitions, Event Studio, Query
Studio, and Cognos Workspace
by clicking New  and then
clicking Other.

0 The Other menu does not
appear.



Property Setting Result

Enable My portal pages Enabled The My portal pages folder
appears under the Team

content folder .

Users who had portal pages
in their Cognos BI 10.x
environment can migrate their
content to Cognos Analytics.
Their portal pages will look and
operate as they did in Cognos BI
10.x.

Disabled(default) The My portal pages folder
does not appear.

3. Click OK.

Results
The configuration changes are saved and propagated to all dispatchers. You do not need to restart the
service for the changes to take effect.

Configuring security
Administrators can configure security settings in Cognos Analytics.

Procedure
1. Go to Manage > Configuration > System, and select Security.
2. Specify values, as required, for the following settings:

Property Setting Result

HTTP Strict Transport
expiration period (days)

number The HTTP Strict Transport
Security Max Age setting in
days.

Login redirect URL URL The url of a page that the user is
redirected to when they sign in
to Cognos Analytics.

Tip: You can use this parameter
when integrating with your
specific SSO environment.

Logout redirect URL URL The url of a page that the user is
redirected to when they sign out
from Cognos Analytics.

Tip: You can use this parameter
when integrating with your
specific SSO environment.
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Property Setting Result

Login parameters allowed in
URL

comma-separated list of
parameter names

Use this parameter to enable
passing CAM namespace login
parameters.

Example

Your company wants to deploy
the following user login syntax:

http://
server:port/bi/v1/disp?
CAM_action=logonAs&CAMNa
mespace=NamespaceName&CA
MUsername=UserID&CAMPass
word=Password

As Administrator, you would
enter the following in the Login
parameters allowed in URL
field:

CAMNamespace,CAMUsername
,CAMPassword

 Whitelist email domains list of domains Use this parameter to set a
whitelist of email domains.
When the parameter is set,
emails can be sent only to the
specified email domains.

The value is a comma-
separated list of domains, for
example: ibm.com, domain.com,
mail.com. If no value is
specified, any email domain can
be sent a message.

Token Login Signing Secret alphanumeric string Specify the signing secret for
tokens generated for login.

3. Click OK.

Results
The configuration changes are saved and propagated to all dispatchers. You must restart the service to
ensure that all changes take effect.

Managing data file uploads
You can control how data files are uploaded to IBM Cognos Analytics. Follow these steps to specify the
encryption and size limits of data for uploaded data files.

Tips:

• These settings apply to uploaded data files only; they do not apply to other types of data, such as data
sets.

• To change the location of the directory for uploaded data files, start Cognos Configuration, click
Environment and then edit the value of the Data files location property. The default value is ../data.
For more information, see the IBM Cognos Analytics Installation and Configuration Guide.
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Procedure
1. Go to Manage > Configuration > System, and select the Data tab.
2. Specify values, as required, for the following settings:

Property Setting Result

Encrypt new data files? Enabled (default) New uploaded data files are
encrypted.

Disabled New uploaded data files are not
encrypted.

Size limit per upload of data
(MB)

number Default=100 The maximum size, in MB, of an
uploaded data file.

Size limit of stored data per
user (MB)

number Default=500 The maximum size of data
storage per user, in MB.

Tip: Updates to size limits might take a moment to refresh.
3. Click OK.

Results
The configuration changes are saved and propagated to all dispatchers. You do not need to restart the
service for the changes to take effect.

Logging
Log messages provide information about the status of components and important events. Administrators
and users can use these messages to troubleshoot problems.

IBM Cognos Analytics supports different types of logging, including the following main types of logging:
audit logging, diagnostic logging, user session logging, and report performance logging.

By default, the IBM Cognos service for each installation sends information to the local
install_location/logs directory. The audit messages are saved to the cogaudit.log file, and the
diagnostic messages are saved to the cognosserver.log and dataset-service.log files. For audit
logs, the administrator can specify the location, size and number of log files in IBM Cognos Configuration.
For diagnostic logging, the size and number of log files is set in the Manage part of Cognos Analytics.
Diagnostic logs are always written to the install_location/logs directory. Audit logging can be
configured to also write to a database, remote log server, or system log. For more information, see
“Diagnostic logging” on page 80.

Session logging can be turned on by individual users for a single Cognos Analytics session after
administrators enable this type of logging for the system. The messages are logged in the following
log files in the install_location/logs directory: cognosserver-session-session_id.log and
dataset-service-session-session_id.log. For more information, see “Setting up logging” on
page 79.

Report performance logging
This type of logging is supported in IBM Cognos Analytics - Reporting for individual reports. A report
author enables the option to log performance details by selecting the report run option Include
performance details. The following details can be viewed in the report output: Total execution time,
Query execution time, and Rendering time. Customers can use this information to self-diagnose
performance or tuning issues before logging a service request.

For more information, see the sections about running reports and viewing performance details in the IBM
Cognos Analytics - Reporting Guide.
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Setting up logging
Administrators can configure both session logging and diagnostic logging.
Session logging

Session logging is used to log detailed user activity in every IBM Cognos Analytics component and service
that is associated with the user's request.

The user does not need to know the components, services, or logging configuration details. There is no
performance impact on other users.

Session logging is typically used when a user can reproduce a problem. It can be stopped at any time by
the user.

Unique log files are generated for each user who enables session logging. The file names include a unique
Log identifier that is generated when session logging is turned on by the user.

The administrator must enable session logging for the system, and then individual users can turn it on or
off for themselves.

Note: Interactive queries in dashboarding do not record the original dashboard name with each
interactive change. The reason for this is that there is no guarantee that the saved object will not be
saved as another name, thereby attributing the dashboard usage stats to the wrong dashboard.

Diagnostic logging

Diagnostic logging creates server log files that allow administrators and support personnel to
troubleshoot intermittent or service-specific problems. The same diagnostic logging configuration is
automatically set on all servers.

For more information, see “Diagnostic logging” on page 80.

Procedure
1. Go to Manage > Configuration > System, and select Logging.
2. Specify values, as required, for the following settings:

Property Setting Result

Size limit for server log file
(MB)

number

Default=200

The maximum size, in MB, of the
server log file. After a server log
file reaches its size limit, a new
"rolling" log file is created.

Tip: Server log files are used
for “Diagnostic logging” on page
80.

Maximum number of backup
server log files

number

Default=10

The maximum number of server
rolling log files that are stored as
backups.

Tip: Server log files are used
for “Diagnostic logging” on page
80.
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Property Setting Result

Enable user session logging Enabled(default) User session logging occurs.

Tip: When this setting is turned
on, the option Log my session
is available for all users in their
personal settings.

Disabled User session logging does not
occur.

Size limit for user session log
file (MB)

number

Default=25

The maximum size, in MB, of
the user session log file for
each user session. After a user
session log file reaches its size
limit, a new "rolling" log file is
created.

Maximum number of backup
log files (per user session

number

Default=10

The maximum number of user
session rolling log files that are
stored as backups.

Delete session log files after
48 hours

Enabled(default) All user session files log files are
deleted after 48 hours.

Disabled User session files log files are
not deleted.

3. Click OK to apply the changes.

You do not need to restart the IBM Cognos Analytics service.

Results
The configuration changes are saved and propagated to all dispatchers. You do not need to restart the
service for the changes to take effect.

What to do next
Users can now enable session logging in their personal settings, by selecting the Log my session
option, and turning on the setting Session logging. The users should record the Log identifier that
is generated for the session before they turn off logging or close the browser. The administrator will
need this identifier to find the session log files, cognosserver-session-log_identifier.log and
dataset-service-session-session_id.log, in the install_location/logs directory.

Diagnostic logging
Diagnostic logging can be configured by administrators to use for intermittent or service-specific
problems. The same logging configuration is automatically set on all servers.

The diagnostic logging messages are logged in the cognosserver.log and dataset-service.log
files in the install_location/logs directory. The administrators can specify the maximum size for
log files and maximum number of log files to keep to avoid negative impact on performance.

This type of logging is a replacement for JAVA IPF logging (ipfclientconfig.xml) from previous versions
of Cognos Analytics. Cognos Analytics processes the log messages from the product services using
internally defined loggers. These loggers are abstracted into logging topics that can be enabled in the
Manage user interface.

Diagnostic logging has no impact on session logging or audit logging.
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Tip: You can still use ipfclientconfig.xml for native code components, such as Report Servers, or
Framework Manager. ipfclientconfig.xml can impact audit logging so use it with caution.

Configuring diagnostic logging
Administrators can specify restrictions on the size and number of log files that are used for diagnostic
logging.

Procedure
1. Start the procedure in the topic “Setting up logging” on page 79.
2. Specify the required values for the settings Size limit for server log file and Maximum number of

backup server log files .
3. Click OK.

You do not need to restart the IBM Cognos service to change diagnostic logging.

Enabling diagnostic logging for different topics
You can enable diagnostic logging on a specific product component, service, or function by changing the
logging topic.

IBM Cognos Analytics processes the log messages from the product services using internally defined
loggers. These loggers are abstracted into logging topics. The DEFAULT LOGGING topic that is set for
diagnostic logging uses a set of logger names that are set at specific error levels. This is done so that the
default logging is not too verbose and records only the most important messages.

You can enable diagnostic logging on a built-in topic or on a custom topic. To create a custom topic, you
can download a JSON spec for a built-in topic and use it as a basis for creating your custom topic. Custom
topics can be modified, but built-in topics cannot be modified.

Procedure
1. Go to Manage > Configuration.
2. Select the Diagnostic logging tab.
3. Select one of the built-in or custom topics for which you want to enable logging.

The following built-in topics are available:

• AAA - Access Manager Authentication logging
• CM - Content Manager logging
• DEFAULT LOGGING - logging using default settings
• DISP - Dispatcher logging
• MOSER - Modeling service logging
• POGO_MSGS - Dispatcher SOAP message logging

To see all built-in topics, select the Show all checkbox.

For example, to generate logs for Cognos Analytics Mobile Reports, select the MOB topic.
4. Click Apply.
5. To restore DEFAULT LOGGING, click Reset.
6. To create a custom topic, do the following:

a) Click the Built-in topics tab.

b) Click the More icon  next to a built-in topic that is similar to the one you want to create and then
select Download topic.

c) Edit the file and save it on your computer as filename.json.
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d) Click the Custom topic tab.

e) Click the Upload topic icon 

Your new topic appears as an entry on the Custom topics tab.

Results
The logs are now written to the cognosserver.log and dataset-service.log files in the
install_location/logs directory.

Using diagnostic logging to troubleshoot Cognos service startup problems
IBM Cognos service startup problems is an example of a situation when diagnostic logging can help you
discover the root cause of the problem.

If the Cognos service fails to start before the dispatcher is ready, you need to enable more detailed
diagnostic logging in your installation directory before trying to start the service again. By default, minimal
logging level is enabled.

Procedure
1. From the IBM Cognos Analytics installation_location/wlp/usr/servers/cognosserver

directory, open the bootstrap.properties file.
2. In this file, add the system property com.ibm.bi.logging.glug.hint.isready=false to enable

detailed logging.
3. Restart the Cognos service (from Cognos Configuration or from a command line).

At startup, the system property com.ibm.bi.logging.glug.hint.isready=false is examined
by the logging service before any other services are available.

The restart fails again, but this time with detailed logs in the installation_location/logs/
cognosserver.log file. Use these logs to troubleshoot the problem.

4. After the problem is resolved, remove the system property
com.ibm.bi.logging.glug.hint.isready=false from the bootstrap.properties file to
disable detailed logging, and restart the Cognos service. After the restart, the default, minimal logging
is restored.

Tip: If you are not concerned about the length of time that it takes to start the Cognos service, and if
you have a sufficient amount of space available, you can leave this property set to false. This will leave
detailed logging enabled until the message that the dispatcher is ready appears.

Enabling RSVP recordings for the whole system
RSVP recordings can be enabled for all users and all report executions.

About this task
Use the install_location\configuration\rsvpproperties.xml file to enable RSVP recordings
for the whole system. The impact on the system performance will be significant.

Disable RSVP recordings as soon as your issue is resolved.

Procedure
1. From the Cognos Analytics install_location\configuration directory, open the
rsvpproperties.xml.sample file.

2. Make a copy of this file, rename the copy to rsvpproperties.xml, and save it in the same location.
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Note: If the rsvpproperties.xml file already exists in the install_location\configuration
directory, you can use this file.

3. Open the rsvpproperties.xml file, and modify the following properties:
RecordingsEnabled

Uncomment this property, and set its value to 1:

<property>RecordingsEnabled</property>
<value type="long">1</value>

The default value is 0.
RecordAsynch

Uncomment this property, and set its value to 1:

<property>RecordAsynch</property>
                <value type="long">1</value>

The default value is 0.
4. Save the rsvpproperties.xml file.
5. Restart the Cognos Analytics service.

Results
The RSVP recordings are written to the Cognos Analytics install_location\temp\rsvp directory.

Enabling IBM Cognos Analytics for Jupyter Notebook
Administrators can configure IBM Cognos Analytics to connect to a computer that is running IBM Cognos
Analytics for Jupyter Notebook.

Before you begin
IBM Cognos Analytics for Jupyter Notebook must be installed on another computer. For more information,
see "Installing IBM Cognos Analytics for Jupyter Notebook" in Installing and configuring Cognos Analytics.

About this task
For a demonstration of how to enable IBM Cognos Analytics for Jupyter Notebook, watch this video.

Procedure
1. Note the computer name where IBM Cognos Analytics for Jupyter Notebook is installed.
2. Go to Manage > Configuration > System, and select Environment.
3. In the Jupyter service location field, enter the following URL:

http://Jupyter_Notebook_server_name:port_number

Tip: Use https:// if you have configured SSL on the Jupyter Notebook server. Note that if the Cognos
Analytics server is secured with SSL, then the Jupyter Notebook server must also be secured with SSL.

4. Click Apply.

Results
The configuration change is saved and propagated to all dispatchers. You do not need to restart the
service for users to connect to Jupyter Notebook.

What to do next
Ensure that you have assigned either the Notebook capability or roles that include the Notebook
capability to your intended Jupyter Notebook users. For more information, see "Notebook capability"

Chapter 4. Configuring system settings  83

https://youtu.be/llBuQf7ITWg


in the IBM Cognos Analytics Managing Guide. After you complete this task, users can start working with
Jupyter Notebook in IBM Cognos Analytics.

Advanced settings
You can configure advanced system settings, including a permissions filter and customized key/value
pairs.

Important: Contact IBM support for details on how to configure advanced settings.

For information about configuring advanced system settings using the Administration console, see
"Advanced settings configuration" in the IBM Cognos Analytics Administration and Security Guide.

Customizing messages in the alerts banner
 If you are assigned the System Administrator role, you can update a message that appears in the

alerts banner.

Note: The System Administrator role is not available to IBM Cognos Analytics on Cloud - Hosted
customers. To request a customized alert message in IBM Cognos Analytics on Cloud - Hosted, contact
IBM Support.

The alerts banner
The alerts banner can display two types of alerts: 1) What's New alerts and 2) Maintenance alerts.

• What's New alerts

By default, users can click the arrow icon  in the alerts banner to see two What's New messages
appear:

• Maintenance alerts

The administrator can add a Maintenance alert to help users stay informed of company-specific details.

Add or remove a maintenance message
Add a message to the alerts banner to help users stay informed of upcoming maintenance.

1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type Glass.maintenanceMessage in the Key field.

Tip: You must match the case as shown.
3. Enter your maintenance message in the Value field.

For example, type Our servers will be down for maintenance this Saturday between
1:00 a.m. and 6:00 a.m. in the Value field.

As another example, a message in the alert banner is written in English, but the users speak mainly
Spanish. As the System Administrator, you replace the message with a translated version.

4. If you want to remove a maintenance message, follow these steps:

a. Type Glass.maintenanceMessage in the Key field.
b. Click in the Value field.

Tip: Even if a value is already set, it does not appear until you click in the field.
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The current maintenance message appears.
c. Delete the message in the Value field.

5. Click Apply.
6. Refresh your browser window.

Depending on which setting you chose, your message appears in, or is removed from, the alerts banner.

Add a link to a maintenance message
Add a link to a maintenance message that points users to a web site.

1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type Glass.maintenanceMessage in the Key field.

Tip: You must match the case as shown.
3. Enter your maintenance message, including a reference to the link you are adding, in the Value field.

For example, type For more information about our product, click More info in the
Value field.

4. Type Glass.maintenanceLink in the Key field.

Tip: You must match the case as shown.
5. Enter the URL of the web site that you want to link to in the Value field.
6. Click Apply.
7. Refresh your browser window.

Your maintenance message appears in the alerts banner. When you click More info to the right of the
alerts banner, the web site that you linked to opens in a new tab.

8. Inform users that they can click More info to view the web site that you linked to.

Disable or enable the What's New alerts
Specify whether the What's New messages appear in the alerts banner.

Note: If you create a maintenance message but disable the What's New messages, the maintenance
message still appears.

1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type Glass.disableWhatsNewAlerts in the Key field.

Tip: You must match the case as shown.
3. Type true in the Value field.
4. If you want to reinstate the What's New messages in the alerts banner, follow these steps:

a. Type Glass.disableWhatsNewAlerts in the Key field.
b. Type false in the Value field.

5. Click Apply.
6. Refresh your browser window.

Depending on which setting you chose, only the What's New messages disappear from, or are reinstated
in, the alerts banner.

Disable or enable all messages
You can remove the alerts banner. This prevents both the What's New messages and your maintenance
message from appearing to users.

1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type Glass.disableAlertEntry in the Key field.
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Tip: You must match the case as shown.
3. Type true in the Value field.
4. If you want to reinstate the What's New messages and, if you have one, a maintenance message in the

alerts banner, follow these steps:

a. Type Glass.disableAlertEntry in the Key field.
b. Type false in the Value field.

5. Click Apply.
6. Refresh your browser window.

Depending on which setting you chose, the alerts banner either appears or does not appear to users.

Hiding the Show welcome switch
You can prevent the Show welcome switch from appearing to users.

The Show welcome switch allows you to choose whether you see the welcome page after you click 
Home. The welcome page provides quick access to walk through tours, videos, and embedded samples.

By default, the Show welcome switch appears. To hide the switch, follow these steps:

Procedure
1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type Glass.welcomeScreenDisabled in the Key field.
3. Click in the Value field.

The default value, false, appears.
4. Delete false and then type true in the Value field.
5. Click Apply.
6. Refresh your browser window.

Results
The welcome page is replaced with tiles of Cognos Analytics assets that you worked on recently.

Defining authentication parameters for login URLs
Use the Glass.urlLoginParameters advanced setting to allow namespace logging parameters contained in
a URL to be passed to the authentication provider.

For example, the administrator defines the parameters CAMNamespace, CAMPassword, and
CAMUsername. A user then logs on by entering a Cognos Analytics URL that is appended with their
credentials. The parameters are then passed to CAM for authentication. The login URL would appear as
follows:

http://yourserver:yourport/bi?
CAMNamespace=myNamespace&CAMUsername=myUser&CAMPassword=myPassword.

Procedure
1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type Glass.urlLoginParameters in the Key field.
3. Enter a parameter name in the Value field.

Tip: You can enter multiple parameter names separated by commas.
4. Click Apply.
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Setting the SameSite attribute on cookies
Configure the Configuration.cookieSameSite cookie attribute to prevent cross-domain errors in
your Cognos environment.

To prevent cross-site request forgery (CSRF) attacks, some browsers may return error messages if HTML
files containing iFrames are hosted in a different domain than the report server. To avoid these errors, you
can configure the Configuration.cookieSameSite advanced setting.

Before you begin
The following configuration must be in place:

• SSL is enabled
• XSRF protection must be enabled. For more information, see XSRF (Cross-Site Request Forgery).

Procedure
1. Click Manage > Configuration > System, and select Advanced Settings.
2. In the Key field, type the following:

Configuration.cookieSameSite

3. Type None in the Value field.
4. Click Apply.
5. Refresh your browser window.

Results
Applications in your Cognos environment with a different domain no longer produce error messages.

Adjusting the chunk size of files uploaded to the cloud
You can change the default size of data chunks that are delivered as files are uploaded to a cloud storage
location.

You may need to adjust the chunk size if a user receives an Error uploading report_name message
when they try to save a file to the cloud.

Procedure
1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type multipart-chunk-size-mb in the Key field.
3. Click in the Value field.

The default value, 15, appears.
4. Delete 15 and then enter a value that is larger than the number of MB of any files that you plan to save

to the cloud.
For example, type 50 in the Value field.

5. Click Apply.

Setting response headers for HTTP requests
If your environment does not include a web server, response headers for HTTP requests do not include
a value for X-FRAME-OPTIONS. The following steps describe how to include X-FRAME-OPTIONS in the
response headers.

Note: We recommend that you install a web server in your Cognos Analytics environment.
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Procedure
1. Click Manage > Configuration > System, and then select Advanced Settings.
2. Type BIHeaderFilter.responseHeaders in the Key field.
3. Type [{"name":"X-FRAME-OPTIONS","value":"SAMEORIGIN"}] in the Value field.
4. Click Apply.
5. Type BIResponseWrapper.staticExpiresDays in the Key field.
6. Type 7 in the Value field.

Tip: This sets the value for the HTTP response headers "Expires" and "max-age" when responding to
GET requests for static content.

7. Click Apply.
8. Refresh the page.

Limiting the number of emails sent when a report is delivered
You can control the number of emails that are sent when a report is delivered by email.

Procedure
1. Click Manage > Configuration > System, and select Advanced Settings.
2. Type limit.per.email.sender in the Key field.
3. Click in the Value field.

The default value, 500, appears. This means that a single sender can send up to 500 emails every two
minutes. After the counter reaches the limit, no additional emails are sent.

4. If you want to change the number of emails sent, delete 500 and type another number in the Value
field.

5. Click Apply.

Dispatcher routing
Depending on how your system is set up, you may want to control how reports are distributed among
servers.

For example, you have different departments that maintain their own servers, or you have specific servers
set up for specific data access, such as Microsoft Windows servers for Microsoft SQL Server databases
and Linux® servers set up for IBM Db2 access. You can set up IBM Cognos software so that report
requests are processed by specific servers by applying routing rules.

Affinity settings take precedence over advanced routing settings. For more information, see Maximum
Number of Processes and Connections.

When you define the routing rules, you must select a server group. Server group names are a property of
a dispatcher or the configuration folders into which the dispatchers are organized. For more information to
set server group names, see “Creating server groups for advanced dispatcher routing” on page 89.

To determine which server groups process certain reports, you must associate the server groups with
routing tags for data objects, such as packages, data modules, or uploaded files, and for user groups
or roles. Then, you need to specify how the routing tags are distributed among the dispatchers in your
environment. The distribution is controlled by routing rules that you create for the routing tags. The report
request will be processed by a specific server depending on the routing tags associated with the data
object from which the report was created and/or the user or group running the report.

Tip: A routing tag can by any word or phrase, but as a best practice, specify a tag that is meaningful for
your environment. You could have tags such as Sales reports, Db2 data, Europe.

When you create the routing rules, you create conditions that determine the server groups by which the
reports are to be processed. For example, you can set up routing rules so that reports from a Finance
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package that were created by a user in the Finance group are processed by Finance servers. Alternatively,
you can set up routing rules so that reports that were created by any Sales users, regardless of which data
object was used to create the report, are processed by the Sales servers. In the first example, you would
specify routing tags for both the group or role and the package, but in the second example you would only
specify a routing tag for the group or role and leave the package routing tag blank. You do not have to
specify a routing tag for both the data object and the group or role in your routing rules.

You must have the required permissions to access IBM Cognos Administration functionality. For more
information, see Secured Functions and Features.

Creating server groups for advanced dispatcher routing
If you intend to define routing rules for reports, you must create server groups for the dispatchers or
configuration folders to which you want reports to be routed.

For information about defining routing rules, see “Dispatcher routing” on page 88.

Tip: If you are setting up advanced dispatcher routing and are using PowerPlay, you must ensure that the
server group includes at least one PowerPlay server to handle PowerPlay requests.

About this task
You can

Procedure
1. From Manage > Administration console, open IBM Cognos Administration.
2. On the Status tab, click System.
3. In the Scorecard pane, from the change view menu of the current view, click All dispatchers.

Tip: The current view is one of All servers, All server groups, All dispatchers, or Services.
4. From the Actions menu of the dispatcher, click Set properties.
5. Click the Settings tab.
6. Select Tuning from the Category list.
7. Type a name in the Value column for the Server Group property.

Important: The name can contain a maximum of 40 characters.
8. Click OK.

You use this server group when you define routing rules, as documented in the topic “Setting routing
rules for dispatchers” on page 89.

Setting routing rules for dispatchers
You can set routing rules for server groups that allow you to send specific types of reports to different
servers.

Procedure
1. Select Manage > Configuration > Routing rules.
2. Click New routing rule.

Tip: You can select the pencil icon  beside the tag name.
3. Assign a data tag.

a) Click the down chevron icon  in the Data tag field.

Any existing tags are listed.
b) If you want to create a new tag:

i) Click New data tag.
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ii) Enter a tag name.

iii) Click the Add icon .
iv) In Team content or My content, click one or more packages, data modules, or uploaded files.
v) Click Select.

vi) Click Create.
c) Click the data tag that you want to associate with the routing rule.

Tip: To modify the data objects associated with a tag or to change its name, select the pencil icon 
beside the tag name.

4. Assign a group tag.

a) Click the down chevron icon  in the Group tag field.

Any existing tags are listed.
b) If you want to create a new tag:

i) Click New group tag.
ii) Enter a tag name.

iii) Click the Add icon .
iv) In the Open File panel, click a namespace, for example Cognos.
v) Click the groups that you want to associate with the routing rule.

vi) Click Open.
vii) Click Create.

The tag is created.
c) Click the group tag that you want to associate with the routing rule.

Tip: To modify the groups associated with a tag or to change its name, select the pencil icon 
beside the tag name.

5. Assign a role tag.

a) Click the down chevron icon  in the Role tag field.

Any existing tags are listed.
b) If you want to create a new tag:

i) Click New role tag.
ii) Enter a tag name.

iii) Click the Add icon .
iv) In the Open File panel, click a namespace, for example Cognos.
v) Click one or more roles that you want to associate with the routing rule.

vi) Click Open.
vii) Click Create.

The tag is created.
c) Click the role tag that you want to associate with the routing rule.

Tip: To modify the roles associated with an existing tag or to change its name, select the pencil icon
 beside the tag name.

6. Assign a server group.

a) Click the down chevron icon  in the Server group field.
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Any existing server groups are listed.
b) Click View server group details.

c) If server groups exist, the URL of each server group is listed. Go to step “6.e” on page 91.
d) If the message No server group found appears, click the Advanced Administration Console link

and then create a server group.
e) Click the server group that you want to associate with the routing rule.

7. You can further modify your routing rules, as follows:

• To create additional routing rules, click New routing rule, as described in the previous steps.
• To see which data objects, groups, roles and server group URLs are associated with each routing

rule, click the More button  next to the routing rule and then select Detail view.

Tip: To return to the list of routing rules, click the back icon  beside the panel title, Details for
Rule number.

• To create a rule with similar associations as an existing rule, click the More button  next to the
routing rule and then select Duplicate. You can then modify the tags, as necessary.

• To remove a routing rule, click the More button  next to the routing rule and then select Delete.
8. Click Apply changes.

Your changes to all routing rules are saved.

Results
Reports will now be processed by a specific server, depending on the routing tags associated with the
data object from which the report was created and/or the group or role running the report.
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Chapter 5. Schedules and activities
You can view a list of users' scheduled activities that are current, past, or upcoming on a specific day.

You can filter the list so that only the entries that you want appear. A bar chart shows you an overview of
daily activities, by hour. You can use the chart to help choose the optimum date for rescheduling activities.
You can set run priority for entries. You can also view the run history for entries, specify how long to keep
run histories, and rerun failed entries.

You can see who ran each entry and perform actions on entries as required. For example, you may want to
cancel or suspend a user's large job if it is holding up important entries in the queue. You can also override
the priority of an entry instance or you can change it permanently for an entry itself.

If you switch views, you must refresh to see current data. For example, if you switch from Past Activities
to Upcoming Activities, you must refresh to see current data in the panes.

Administrators can use the Manage > Activities administration function, or IBM Cognos Administration
to manage activities for all user entries.

Scheduling a report
 You schedule a report to run it at a later time or at a recurring date and time.

If you no longer need a schedule, you can delete it. You can also disable it without losing any of the
scheduling details. You can then enable the schedule at a later time.

If you want, you can change the current schedule owner by changing the credentials for a scheduled
entry. For more information, see "Taking ownership of a schedule" in the Managing User Guide.

Before you begin
To use this functionality, you must have the required permissions for the Scheduling capability. You can
see which capabilities are available with your assigned license role in the topic "Default permissions
based on licenses" in the Managing User Guide.

To schedule a report, you also require the following access permissions for any data sources used by the
report:

• dataSource - Execute and Traverse
• dataSourceConnection - Execute and Traverse

With only Execute access, you are prompted to log on to the database.
• dataSourceSignon - Execute

To schedule reports to run in the restricted CVS, PDF, XLS, or XML output formats, you require the
generate output capability for the specific format. For more information, see Report formats in the
Administration and Security Guide.

To set priority for an entry, you must have the required permissions for the Scheduling priority secured
feature. For more information, see Capabilities.

Procedure

1. Click the report's More icon , and then click Properties.
2. In the Properties pane, click the Schedule tab, and then:

• Click Create schedule.



Tip: Available options change with each selection. Wait until the pane is updated before you choose
additional settings.

3. In the Frequency section, specify when and how frequently the report runs:

• Select the Type of time unit to measure the interval between meetings.

Tip: Try selecting different Type values and then watch how the other fields change. For example,
selecting Daily, Weekly, or Monthly allows you to select a Repeat every integer. You can therefore
choose an interval which is a multiple of the time unit that you chose, for example, "every 3 weeks".

• If you are selecting a Type value of Monthly,
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–

Select Day of the Month in the Schedule by field so that you can choose, for example, "Repeat
every 3 months on the 15th of the month" (see figure above).

–

Select Day of the week in the Schedule by field so that you can choose, for example, "Repeat
every 3 months on the 3rd Monday of the month" (see figure above).

• If you are selecting a Type value of By trigger,
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Tip: If a report is scheduled by a trigger, it can run only if you have already set up a
trigger occurrence. For more information, see "Set Up a Trigger Occurrence on a Server" in the
Administration and Security Guide.

In the field pictured above, enter the name of the trigger occurrence, for example, trigger.bat.
4. If you want to select a daily frequency for your scheduled entries:

• Select the Daily time interval check box.

Tip: Specify the frequency and the period during the day in which the report runs. For example,
"every 2 hours between 10:00 AM and 10 PM" (see figure above).

We recommend that you select an hourly frequency that divides evenly into the 24-hour clock. This
ensures that your report runs at the same times each day. If you select an hourly frequency that
does not divide evenly into the 24-hour clock, your report runs at different times on subsequent
days.

5. If you want to set the time period within which the first and last runs of the report will take place:

• Scroll to the Period section.
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Tip: In the example shown above, the first report run will occur on September 1 at 10:00 AM and
the last report run will end on September 30 at 10:00 PM.

Set the date and time for both the start and the end of the period.

If you don't enter anything in the Period section, by default the period begins as soon as you save
the schedule and there is no end date.

6. If you want to change the credentials or priority of the schedule:

• Click the Advanced section.

Tip:
About the Credentials field

Credentials show the current schedule owner. If you are not already the schedule owner, you
can click Use My Credentials and make temporary changes to the schedule.
For more information, see " Taking ownership of a schedule" in the Managing User Guide.

About the Priority field
If you are assigned the Scheduling Priority capability, you can select a priority from 1 to 5 for
the scheduled entry to run. Priority 1 runs first.
For more information, see " Changing the entry run priority" in the Managing User Guide.

7. To see the default format, delivery method, and language of your report:

• Click the Options tab.

Chapter 5. Schedules and activities  97



Tip:

The default options are displayed:

– Format: HTML only, accessibility support disabled
– Delivery: Save report only
– Languages: English only

• Did you notice the Summary pane?

Tip:

As you build your schedule, the Summary pane on the right of your window uses natural language
to describe all of your selections in real time.

At any time, you can click Reset default options to clear the options that you set on every tab.
8. If you want, change the Format options:

• If you select HTML format, you can click Edit options.
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Tip:

If you want to drill up and down in a report or drill through to other reports, you must select the
Enable selection-based interactivity check box. However, if your report is very large, you may
want to deselect the check box to shorten the time that it takes the report to run.

• If you select PDF format, you can click Edit options.

Figure 2. PDF options - part 1

Tip: You can create a password to add extra security to your report. This is in addition to the
permissions that users are granted by their capabilities.
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Figure 3. PDF options - part 2

Tip: You can limit the types of changes that other users can make to the report.
• If you select the Enable accessibility support check box.

Figure 4. PDF options - part 1

Tip: You can make your report output accessible. Accessible reports contain features, such
as alternate text, that allow users with disabilities to access report content using assistive
technologies, such as screen readers.

In IBM® Cognos® applications, you can create accessible output for reports, jobs, steps within jobs,
and scheduled entries in PDF and HTML.

Accessible reports require more report processing and have a greater file size than non-accessible
reports. Consequently, making reports accessible can have a negative impact on performance.

9. You can change the Delivery options:

• If you want to save the report in Cognos Analytics, you have two options.
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Figure 5. PDF options - part 1

Tip:

– Save report. This option is selected by default.
– Save as a report view. Unlike saving the report, you can change the name or destination folder

of the report view. A report view uses the same report specification as the source report, but has
different properties such as prompt values, schedules, delivery methods, run options, languages,
and output formats.

Creating a report view does not change the original report. You can determine the source report
for a report view by viewing its properties. The report view properties also provide a link to the
properties of the source report.

• If you select Send report by email and then click Edit details.

Tip:

An email window appears, in which you can enter recipients' names, if you have permission.
Otherwise, you can choose your email recipients from your local LDAP directory. If your directory is
very large, you can use search, filter and sort functions to quickly find your recipients.

After you enter your message, and you have the correct permissions, you can attach the report
output to the email. Or you can add a link that your recipient can click to see the report.

• If you select Send report to mobile device.
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Tip:

This option is available only to users of Cognos Analytics on Demand or Cognos Analytics on Cloud
Hosted.

Similar to the email option, you can find your recipient in the Directory. When the report is run, it
will be sent to the mobile device of the recipient via Cognos Analytics for Mobile.

• If you select Print.

Tip: It may be convenient for you to have a printed copy of a report.

You may need to review a report when your computer is not available, or you may need to take a
copy of a report to a meeting.

To print reports, you must have the Generate PDF Output capability.

Select a printer from the list or enter a valid printer name, location, or address and then click Add.
• If you want your output in languages other than English (the default).
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Tip: Start typing the name of the language in the Languages field. A dynamic list of languages
appears, from which you can select the one you want.

10. If your report has prompts:

• Click the Prompts tab and then click Set values.

Tip: In the example Prompt window shown above, the p_Date parameter prompts for a date value.
11. Click Save.

Results
A schedule is created and the report runs at the next scheduled time.
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Prompts not displayed when a scheduled report runs (11.1.7.0-11.1.7.3)
After a report with prompts is run according to a schedule, the prompt values that were used may not
appear on the View run history details page.

Note: This issue occurs only in Cognos Analytics versions 11.1.7.0 - 11.1.7.3.

Solution
To fix this issue, follow these steps:

1. Download the ScheduleParamFix_11_1_7.zip extension to your computer.

a. Click this link: Download ScheduleParamFix_11_1_7 extension.
b. Save the file ScheduleParamFix_11_1_7.zip on your computer.

2. Upload the extension ScheduleParamFix_11_1_7.zip to Cognos Analytics.

a. Select Manage > Customization, and then click the Extensions tab.

b. Click Upload extension , browse to the extension that you just downloaded.
c. Click Open.

The extension is uploaded and ScheduleParamFix_11_1_7 appears in the list of uploaded
extensions.

3. Reload the page or sign out of Cognos Analytics and then sign back in.

The Schedule update button appears in the navigation bar.

Note: You must be signed in as a System Administrator to view the Schedule update page.
4. Click Schedule update.
5. Click Analyze to search for broken schedules.
6. Select the schedules you want to fix and then click Apply.

The next time the fixed reports run on a schedule, the prompt values that were used appear on the View
run history details page.

Taking ownership of a schedule
When you edit a schedule owned by someone else, you can take ownership of the schedule during your
current Cognos Analytics session.

For example, a schedule owner is on vacation, but you don't have access permissions to change the
schedule. You can take temporary ownership of the schedule and change some scheduling options while
they are away. However, the schedule's credentials change back to the original owner as soon as you exit
the session.

Procedure

1. Click the report's More icon , and then click Properties.
2. Click the Schedule tab, and then click Edit.
3. On the Schedule tab, scroll down and click the Advanced section.
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If the schedule is owned by someone else, a Use My Credentials link appears.
4. Click Use My Credentials.

Your name appears in the Credentials field.
5. Make changes to the schedule.
6. Click Save to save the schedule.

Results
The schedule is updated with the changes you made. The schedule's credentials change back to the
original owner as soon as you exit the session.

Changing the entry run priority
You can assign a priority of 1 to 5 to scheduled entries.

For example, an entry with priority 1 runs before an entry with priority 5. If there is more than one entry
with the same priority, the one that arrived in the queue first runs first. The default priority is 3.

Before you begin
You must have the Scheduling Priority capability to change the entry run priority.

About this task
Interactive entries always run immediately and priority cannot be changed once they are running.

You set the priority for an entry when you schedule it . When an entry is in the current, upcoming, or
scheduled queue, you can change the priority.

You may want to set a low priority for entries that take a long time to run so that other entries in the queue
are not delayed.

When you schedule a job, you set the priority for the whole job, not for individual entries within the job.
You may want to set a low priority for a job with many entries so that other entries in the queue are not
delayed.

You schedule priority for the parent job. When the job runs, all the child entries inherit the priority of
the parent. When the job is in the queue and is not yet running, you can update the priority. You cannot
do this for the individual entries in the job. Changing the priority of the job changes the priority of all its
child entries. You can view the run history of a job while it is executing and see which of its entries have
completed, are executing, or are pending.

The priority of entries in the queue does not affect an entry that is already running. That entry completes
and then the queue priority is checked for the next entry to run.
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Procedure

1. Click the report's More icon , and then click Properties.
2. Click the Schedule tab, and then click Edit.
3. On the Schedule tab, scroll down and click the Advanced section.

4. Click the down chevron in the Priority field and then select a number from 1 to 5.
5. Click Save to save the schedule.

Managing upcoming activities for a specific day
You can choose to view a list of all upcoming activities that are scheduled for a specific day.

Each entry is listed by name and shows the request time and the priority. A bar chart show the total
number of scheduled and canceled entries for each hour of the day. The chart legend shows the total
number of scheduled and canceled entries for the day.

You can sort the Request time, Status, and Priority columns. You can choose to view a list of background
activities or interactive activities.

Each entry shows the user who scheduled it. You can sort by user.

You can filter the entries to display only those you want. You can choose the date and time for which you
want to view upcoming activities. You can filter by status, priority, type, and scope.

You can also filter by the user that scheduled the entry, and the entry owner.

You can change the priority of an entry in the queue .

Procedure
1. From the Manage menu, click Activities.

2. Click the type icon , and then click Upcoming.
3. In the Filter section, click the filtering options that you want to use.

Tip: If you want to use advanced filtering options, click Advanced options. To reset all selections to
the default settings, click Reset to default.

4. Click Apply.

• The list shows the entries that you selected.
• The filter status line shows the criteria used to generate the list.
• The bar chart shows the scheduled and canceled entries by hour for the specified day.

The list of entries, filter status line, and chart are updated whenever you redefine the filter and click
Apply. The list of entries and filter status line do not change when you browse the chart to a different
date.
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Managing past activities from the Manage tool
Past activities are entries that have finished processing in IBM Cognos software.

Each entry is listed by name and shows the request time and the status. You can sort the Request time
and Status columns. The bar chart shows the total number of entries, broken down by status. If an entry
has failed, a button appears showing the severity of the error. The user who ran the entry is also listed.

You can filter the entries to display only those you want. You can choose to view a list of activities that
occurred over a specified length of time, such as the last four hours or the last day, or you can specify a
date or time range. You can filter by status, type, and scope. You can also filter by the user who ran the
entry, the user who owns the entry, and the dispatcher where the activity ran.

You can view the run history .

Procedure
1. From the Manage menu, click Activities.

2. Click the type icon , and then click Past.

A chart appears, showing when past activities were run and whether they succeeded, failed, or were
canceled. Below the chart, details about the activities are listed.

3. To filter the activities that appear in the chart and the list, click the Filter icon .

Tip: You can filter by the following attributes:

• The user who performed the activity.
• The activity owner.
• The activity status.
• The activity type.

The following diagram shows an example of how past activities are displayed from the Manage tool. In
this example, note the following:

• The list is filtered to show only reports run by Harry Miller.
• The job named Metrics contains two reports that are run as job steps. These two report runs appear

in the list below the job that contained them.
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4. If an activity failed, you can pause over the error button next to the status to see the severity of the
error.

5. To perform an action on an individual activity, click the More icon  for the entry and choose an
action:

• Click  Run once to perform the activity again.

• Click  View versions to see details about previous runs of the report.

• Click  Run details to see information about the most recent run of the report.

Managing current activities
Current activities are entries that are currently being processed in IBM Cognos software.

Each entry is listed by name and shows the request time, the status, and the priority for background
activities. The bar chart shows the total number of entries, broken down by the number of pending,
executing, waiting, and suspended entries. When the activity is processing, the process number is
displayed.

You can sort the Request time, Status, and Priority columns. You can choose to view a list of background
activities or interactive activities.

You can filter the entries to display only those you want. You can choose to display only those entries with
a specific status or priority, or entries of a specific type or scope.
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For interactive current entries, you can filter by status and the dispatcher where the activity is running. For
background current entries, you can filter by status, priority, type, scope, user who ran the entry, and user
who owns the entry.

When an entry is currently running, the dispatcher, process ID, and start time is displayed. Note that
process ID and dispatcher of current background entries might be unavailable when the activity first
appears. Refresh the page to see the updated process ID and dispatcher.

If you cancel an entry that contains other entries, such as a job or an agent, steps or tasks that have
not yet been completed are canceled. However, steps or tasks that have already completed remain
completed.

You can change the priority of entries and view the run history .

Procedure
1. From the Manage menu, click Activities.

2. Click the type icon , and then click Current.
3. In the Filter section, specify the filtering options that you want to use.

Tip: If you want to use advanced filtering options, click Advanced options.
4. Click Apply.

The list shows the entries that you selected.
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Chapter 6. Tenant administration
Tenant administration tasks are performed by system administrators and delegated tenant
administrators.

System administrators must be members of the System Administrators role in the Cognos namespace.
System administrators can view and modify all objects in the content store. They can also delegate tenant
administration tasks to other administrators who are members of the Tenant Administrators role in the
Cognos namespace.

Members of the System Administrators role can perform the following tasks in a multitenant IBM Cognos
Analytics environment:

• Create, change, and delete tenant objects.
• Change tenancy properties on any object in the content store.
• Move tenants.
• Terminate sessions for tenants.

The Multitenancy tab in Manage is the central area for tenant administration. On this tab, the
administrator can add new tenants, and manage all tenants that are registered in the current Cognos
Analytics environment. Only members of the System Administrators role can access the Multitenancy
tab.

Tip: The Multitenancy tab in IBM Cognos Administration can also be used for tenant administration.

Containment rules for multitenancy
Multiple tenants can co-exist in a single content store. The tenant containment rules ensure security and
isolation between tenants. These rules dictate how the content is created and where it can be located.

Every object in the content store has a tenant ID value that indicates which tenant the object belongs to.
For information about creating tenant IDs, see “Creating tenants” on page 111.

The tenant ID of an object must be the same as the tenant ID of its parent, unless the parent tenant ID is
public. If the parent tenant ID is public, the tenant ID for the child can be changed to any value. For more
information, see “Setting a tenant ID for a public object” on page 113.

If the current logged-in user creates an object, the object tenant ID is the same as the user's tenant ID.

Model and modelView objects inherit their tenant ID from the package. For example, models published to
a public package are always public.

Creating tenants
System administrators must create and enable the tenant object before the tenant users can access IBM
Cognos Analytics.

Before you begin
Multitenancy must already be enabled in IBM Cognos Configuration.

About this task
The system administrator creates the tenant object in the Cognos Analytics Manage component, on the
Multitenancy tab, and assigns a unique tenant ID to the object.

The tenant IDs are defined in the authentication provider, such as LDAP, Active Directory, or a custom
authentication provider. For more information, see Configuring multitenancy.



Procedure
1. In Manage, select the Multitenancy tab.

2. Select the Add a tenant  icon.
3. Specify the Name and Tenant ID parameters.

Ensure that you specify a valid tenant ID that was preconfigured in the authentication provider.

Other parameters on this page are optional.
4. Select Add.

Results

The tenant name is displayed on the Multitenancy tab. By default, the tenant is disabled . You can
enable the tenant after it is fully configured.

Assigning tenant IDs to existing content
After multitenancy is enabled, the system administrator assigns tenant IDs to the existing content store
objects. All objects that belong to a tenant have the same tenant ID.

When a user from a specific tenant logs on to IBM Cognos Analytics, the system looks at the tenant ID and
filters the content.

Tenants can be created and tenant IDs can be assigned using the software development kit (SDK).

About this task
In a multitenant environment, all objects in the content store are either public or belong to a single
tenant. As a system administrator, you must ensure that the existing objects have a proper tenant ID or
are meant to remain public. For example, you can assign tenant IDs to content within a folder, but leave
the folder itself public.

You can also assign tenant IDs for individual objects, such as reports, dashboards, data server
connections, user groups and roles, and so on.

Procedure
1. Log on to IBM Cognos Analytics as a system administrator.
2. In Team Content, locate the container entries, such as folders or packages, whose descendents

should be assigned the same tenant ID.

When assigning tenant IDs for objects such as data server connections or groups or roles, locate the
objects in the appropriate area in the administration interface.

3. Open the Properties panel for the object for which you want to assign the tenant ID.
4. On the General tab, Advanced section, click the link next to Tenant.
5. Choose a tenant ID from the list of available IDs, and click Apply.

Results
The tenant ID is applied to the entry. If the entry is a container, such as a folder or package, the tenant ID
is applied to the entry and its descendents.

The tenant name is displayed on the General tab, Advanced section, in the object properties page.
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Setting a tenant ID for a public object
You can assign a tenant ID for objects whose parent is public.

Procedure
1. Open the Properties panel for the object, such as a data server connection, for which you want to

specify the tenant ID.
2. On the General tab, Advanced section, select the link next to Tenant.
3. Choose a tenant ID from the list of available IDs.
4. Click Apply.

Delegated tenant administration
System administrators can delegate tenant administration tasks to members of the Tenant
Administrators role.

If the Tenant Bounding Set Mapping property is configured, Tenant Administrators can access only
tenants that are defined in their bounding set. They are further restricted by the Cognos Analytics security
policies assigned to the content by system administrators. In this situation, Tenant Administrators are
considered bounded tenant administrators.

If the Tenant Bounding Set Mapping property is not configured, Tenant Administrators bypass tenancy
checking and are restricted only by the Cognos Analytics security policies assigned to the content
by system administrators. In this situation, Tenant Administrators are considered unbounded tenant
administrators.

For more information about the Tenant Bounding Set Mapping property, see information about advanced
multitenancy features in the IBM Cognos Analytics Administration and Security Guide.

Tenant Administrators can perform the tenant administration tasks that the system administrator
assigns to them.

Tenant Administrators cannot perform the following tasks:

• Access the Multitenancy tab in Manage and in IBM Cognos Administration.
• Create, delete, deploy, and disable tenants.
• Terminate user sessions and customize tenants.
• Change tenancy on objects in the content store.

Tip: The Tenant Administrators role is one of the built-in entries in the Cognos namespace.

For information about the role of System Administrators in a multitenant environment, see Chapter 6,
“Tenant administration,” on page 111.

Setting up the Tenant Administrators role
In the initial content store, the Tenant Administrators role has no members and only System
Administrators have access permissions for this role. System administrators must add members and
modify the initial access permissions for this role to use it for delegated tenant administration.

About this task
When you add members to the Tenant Administrators role, choose the users, groups, or roles from the
appropriate tenants.

Procedure
Use the following procedure to add or remove members of the Tenant Administrators role.
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1. Log on to IBM Cognos Analytics as a system administrator who is a member of the System
Administrators role.

2. In Manage > Accounts > Namespaces, select the Cognos namespace.

3. In the list of entries, locate the Tenant Administrators role, and from its context menu , click View
members.

4. On the Members tab, select the add member  icon, and browse through the hierarchy of your
security namespace to select the users, groups or roles that you want to be members of this role.

Results
After you add the appropriate users, groups, or roles to the Tenant Administrators role, you can use this
role to set up security policies and capabilities for objects in the content store.

Setting up virtual tenants to enable content sharing among tenants
When you set up virtual tenants, objects in the content store can be accessed by users who belong to
different tenants.

Virtual tenants include real tenants that are already configured in Cognos Analytics.

Before you begin
Multitenancy is enabled for IBM Cognos Analytics and the tenants are created in Manage > Multitenancy.
For more information, see “Creating tenants” on page 111.

About this task
When viewed on the Multitenancy tab, the entries for virtual tenants and real tenants look identical.
To make it easier to identify virtual tenants, use meaningful names when creating them and specify
descriptions.

For example, you want to configure content sharing for tenants named North America, Central America,
and South America. You create a virtual tenant named Americas and add the three tenants to this tenant.
Users who belong to any of the three tenants can access content of their own tenant, content of the other
two tenants, and public content.

If you delete a virtual tenant, all content that is associated with that tenant is also deleted.

For more information, see Advanced multitenancy features (www.ibm.com/support/knowledgecenter/
SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cra.doc/c_config_mt_advanced.html).

Procedure
Perform the following steps to create a virtual tenant and a folder for the virtual tenant content.

1. Log on to IBM Cognos Analytics as a member of the System Administrators role.
2. In Manage, select the Multitenancy tab.

3. Select the Add a tenant  icon.
4. Specify the Name and Tenant ID parameters.

The virtual tenant ID does not need to be preconfigured. It can be any value.

For a description, type a string, such as Virtual tenant, that will help you to identify the tenant
among other tenants in Cognos Analytics.

5. Select Add.
The virtual tenant name is displayed in the list of tenants, and the tenant is disabled by default. You
can enable the tenant after you finish configuring it.
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6. For the virtual tenant that you created, from its context menu , select View members.

7. On the Members tab, select the add member  icon.
8. Select the tenants that you want to add to the virtual tenant, and click Add.

Tip: You can add disabled tenants. However, users cannot access content of the disabled tenants
until the tenants are enabled.

9. Create a new folder. The folder name should be similar to the virtual tenant name for easier
identification.

10. In the folder properties page, on the General tab, Advanced section, change the Tenant ID value to
the tenant ID of the virtual tenant by selecting the ID from the list of available IDs. For example, if
your virtual tenant ID is Americas, select this ID from the list and assign it to the folder.

Customizing tenants
You can apply themes to individual tenants. You can also specify that a customized home page, or a
particular report or dashboard, be displayed when a user with a particular tenant ID opens IBM Cognos
Analytics. You can also remove default user interface features for tenants.

Before setting customized themes and home pages (other than a dashboard or report) you must have
created and uploaded custom themes or home pages. For more information, see Chapter 9, “Customizing
Cognos Analytics across all roles,” on page 195.

In Manage > Multitenancy, click a tenant. The slide-out panel for that tenant has a Customization tab.
For more information, see “Applying themes, extensions, and views” on page 223.

Setting a default home page

Click the next  icon next to the default home page. You can now browse for a dashboard or report to be
the default home page, or you can select a view in the list of views to be the default home page for all
users of this tenant.

Removing features

You can choose user interface features to remove for the tenant. Click the next  icon next to Features.
A list of views is displayed. This list includes both the built-in views and any custom views that have been
uploaded. Click a view to see a high-level grouping of features for the view. Click  next to a grouping to
drill-down to a lower level of features. You can deselect any features in this list, or drill-down to another
set of features to deselect. Click Apply to save your changes. You can revert your changes by clicking
Reset to defaults.

Setting a default theme

Click  next to the default theme. You can select a theme in the list of themes to be the default theme for
this tenant.

Creating a custom folder

Click  next to Custom folder to set a custom content folder for this tenant. When a user with this tenant
ID logs in, the custom folder is displayed on the navigation bar below Team content.

Setting the default location for uploaded files
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Click  next to Default upload location to specify a folder in Team content as the default location for
uploaded files for this tenant.

Parameters
Add content here and for roles.

Defining regional settings for tenants
A system administrator can specify regional settings for a tenant.

The regional settings apply to all IBM Cognos Analytics components, such as reporting, dashboarding,
modeling, administration, and so on. These settings also apply to the companion applications such as IBM
Cognos Analysis Studio, IBM Cognos Event Studio, and so on.

The following settings can be specified:

Time zone
The time zone of the tenant users.

Product language
The language of the IBM Cognos Analytics user interface.

Content language
The language used to view and produce content in IBM Cognos Analytics, such as data in reports,
dashboards, and stories.

Bidirectional language support
This setting applies to languages such as Arabic, Hebrew, Urdu, or Farsi. Using this setting, you can
control the direction of text in entry names, descriptions, labels and tooltips, input boxes, comments,
and in structured text, such as email addresses, file paths, breadcrumbs, URLs, and date and time
formats.

Select one of the following options from the Base direction for text: Right-to-left, Left-to-right,
Contextual. When the Contextual option is selected, the text direction depends on the first letter in
the text. If the letter belongs to a right-to-left script, the text direction is right-to-left. Otherwise, the
text direction is left-to-right. Numbers and special characters do not influence the text direction. For
example, if the text starts with a number followed by an Arabic letter, the direction is right-to-left. If
the text starts with a number followed by a Latin letter, the direction is left-to-right

Procedure
1. In Manage, select the Multitenancy tab.
2. From the tenant context menu, click Properties.
3. Click the Regional tab, and specify the settings.

Results
By default, all tenant users inherit these settings. Depending on their access permissions, the users can
personalize these settings later.

Setting up notifications for tenants
A system administrator can configure an email account, called tenant sender, from which the tenant users
receive emails.

The tenant sender account overwrites the default sender account that is specified when configuring the
mail server for IBM Cognos Analytics.

Tip: The default sender is configured in IBM Cognos Configuration, under Data Access > Notification.
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Procedure
1. In Manage, select the Multitenancy tab.
2. From the tenant context menu, click Properties.
3. On the Notifications tab, select Tenant Sender and specify the corresponding email address. Click

Apply.

Results
The tenant sender email account is now associated with distributing IBM Cognos Analytics content.

Terminating active user sessions for tenants
You must terminate the tenant active user sessions before deleting a tenant or before performing some
tenant maintenance operations.

Before you begin
Before terminating its active user sessions, disable the tenant so that new user sessions cannot be
started. For more information, see “Disabling and enabling tenants” on page 117.

About this task
Use this action to terminate all active user sessions for the specified tenants. Access for other tenants is
not affected.

Procedure
1. In Manage > Multitenancy, locate the appropriate tenant.

2. From the tenant context menu , click Terminate sessions.

Results
A message that specifies the number of terminated user sessions is displayed.

Disabling and enabling tenants
You can disable a tenant when you want to prevent the tenant users from accessing IBM Cognos Analytics
and modifying the tenant content.

About this task
By default, a newly-created tenant is disabled, and you need to enable it after it is configured.

You should disable a tenant before deploying the tenant and its content. For more information, see Tenant
content deployment.

As a best practice, you should also disable a tenant before terminating its active user sessions. For more
information, see “Terminating active user sessions for tenants ” on page 117.

Procedure
1. In Manage > Multitenancy, locate the required tenant.

2. From the tenant context menu , click Disable.

An icon that indicates the disabled state is added to the tenant icon .

You can enable the tenant by selecting Enable.
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Deleting tenants
You can delete a tenant from IBM Cognos Analytics. This might be needed if the tenant was permanently
moved to a different instance of IBM Cognos Analytics.

Before you begin
Before deleting a tenant, you must terminate the tenant active user sessions. Otherwise, you will not be
able to delete the tenant. For more information, see “Terminating active user sessions for tenants ” on
page 117.

About this task
When you delete a tenant, you also delete all content associated with the tenant, such as reports or
dashboards.

Procedure
1. In Manage > Multitenancy, locate the tenant that you want to delete.

2. From the tenant context menu , click Delete.
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Chapter 7. Managing access
Administrators define the levels of access that each user, role, and group has to the features and
components in Cognos Analytics.

As administrator, you are responsible for securing the predefined roles in the Cognos Users namespace.
You define which capabilities are assigned to each user, group, and role. You also manage capabilities as
they relate to license role entitlements.

Access permissions for an entry
You use access permissions and credentials to secure your organization's data. You specify which users
and groups have access to a specific report, dashboard, or other content in IBM Cognos software. You also
specify the actions they can perform on the content.

When you set access permissions, you can reference both authentication provider users, groups, and
roles and Cognos groups and roles. However, if you plan to deploy your application in the future, we
recommend that you use only the Cognos groups and roles to set up access to entries in IBM Cognos
software to simplify the process.

Permissions and Permitted Actions
The following table describes the access permissions that you can grant or deny.

Table 3. Permissions and permitted actions

Permissions Icons Permitted Actions

Read View all the properties of an entry, including the report
specification, report output, and so on, which are properties
of a report.

Note: A dashboard requires read permission both on the
dashboard itself and on any data sources that it uses.

Write Modify properties of an entry.

Delete an entry.

Create entries in a container, such as a package or a folder.

Modify the report specification for reports created in Reporting
and Query Studio.

Create new outputs for a report.



Table 3. Permissions and permitted actions (continued)

Permissions Icons Permitted Actions

Execute Process an entry.

For entries such as reports, agents, and metrics, the user can
run the entry.

For data sources, connections, and signons, the entries can be
used to retrieve data from a data provider. The user cannot read
the database information directly. The report server can access
the database information on behalf of the user to process
a request. IBM Cognos software verifies whether users have
execute permissions for an entry before they can use the entry.

For credentials, users can permit someone else to use their
credentials.

Note: Users must have execute permissions for the account
they use with the run as the owner report option.

Set policy Read and modify the security settings for an entry.

Traverse View the contents of a container entry, such as a package or
a folder, and view general properties of the container itself
without full access to the content.

Note: Users can view the general properties of the entries for
which they have any type of access. The general properties
include name, description, creation date, and so on, which are
common to all entries.

Access Permissions for Users

Users must have at least traverse permissions for the parent entries of the entries they want to access.
The parent entries include container objects such as folders, packages, groups, roles, and namespaces.

Permissions for users are based on permissions set for individual user accounts and for the namespaces,
groups, and roles to which the users belong. Permissions are also affected by the membership and
ownership properties of the entry.

IBM Cognos software supports combined access permissions. When users who belong to more than
one group log on, they have the combined permissions of all the groups to which they belong. This is
important to remember, especially when you are denying access.

Tip: To ensure that a user or group can run reports from a package, but not open the package in an
IBM Cognos studio, grant the user or group execute and traverse permissions on the package. Users also
require read permissions on the package to launch studios.

Access Permissions Required for Actions
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To perform specific actions, each user, group, or role needs the correct combination of access permissions
granted for the entry, its parent entry, and its source and target entry. The following table lists permissions
required for specific actions.

Table 4. Access permissions required for actions

Action Permissions required

Add an entry Write permissions for a parent entry

Query the entry properties Read permissions for an entry

View the children of the
entry

Traverse permissions for an entry

Update an entry Write permissions for an entry

Delete an entry Write permissions for an entry, and write permissions for a parent entry

Copy an entry Read permissions for an entry and any child entries, traverse permissions
for all of the children, and write and traverse permissions for the target
parent entry

Move an entry Read and write permissions for an entry, write permissions for both the
source parent entry and the target parent entry, and traverse permissions
for the target parent entry

Permissions and permitted actions for Cognos Workspace reports
Cognos Workspace users can or cannot perform actions, depending on their permissions and
combinations of permissions for a report, report part, report folder, or workspace objects. The owner of
an object is automatically granted read, write, traverse, and execute permissions. If an object is disabled,
you must be granted write access in order to see and edit it.

For reports, users with the following access permissions and combinations of permissions can perform
the following actions:

Table 5. Report access permissions and permitted actions

Permissions Permitted actions

Read Users can view the report in the content pane.

Users cannot expand the report to show the report parts.

Users cannot drag the report.
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Table 5. Report access permissions and permitted actions (continued)

Permissions Permitted actions

Read and
Traverse

Users can view the report in the content pane.

Users cannot expand the report to show the report parts.

If saved output exists, users can drag the report onto the canvas and view the
saved output. If saved output does not exist, users cannot drag the report. If
they attempt this action, users see the error message in the widget:The content
cannot be displayed. It may have been deleted or you may not
have sufficient privileges.

Users can view saved output in the workspace.

Users cannot run a live report in a workspace. If they attempt this action, users
see the error message: RSV-CM-0006. The user does not have execute
permission on this report.

Execute Users can view the report in the content pane.

Users cannot expand the report to show the report parts.

Users can execute the report, but interactions are not available. Interactions are not
available if:

• a report is dragged to the canvas
• if a user with execute permissions saves a report, and other users open the report
• if a user with execute permissions opens a workspace created by other users

When saved output cannot be viewed in a workspace, users see the error message:
The content cannot be displayed. It may have been deleted or
you may not have sufficient privileges.

Read and
execute

Users can view the report in the content pane.

Users can expand the report to show the report parts.

Users can execute the report and interactions are available.

In the content pane, users cannot save report changes.

If users add the report to the workspace and save it, report changes can be saved.

If the report is added to the workspace by a person who is not the report owner, that
user cannot save changes. The user sees the error message: The content cannot
be saved. You do not have sufficient privileges.

Read, execute,
traverse

Users can view the report in the content pane.

Users can expand the report to show the report parts.

In the content pane, users can execute the report and interactions are available.

Users can add the report to the canvas as either live or saved output. The type
of report that is added depends on the default action specified in the report's
properties.
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Table 5. Report access permissions and permitted actions (continued)

Permissions Permitted actions

Read, write,
execute, traverse

Users can view the report in the content pane.

Users can expand the report to show the report parts.

Users can add the report to the workspace.

Users can execute the report and interactions are available.

Users can change and save the report.

Users can add the report to the canvas as either live or saved output. The type
of report that is added depends on the default action specified in the report's
properties.

Read, execute,
set policy

Users can view the report in the content pane.

Users can expand the report to show the report parts.

Users can execute the report and interactions are available.

In the content pane, users cannot save report changes.

If users drag the report to the workspace and save it, report changes can be saved.
This action creates a copy of the report. The copied workspace report inherits the
permissions from the original report when the user has the set policy permission.

For report parts, users with the following access permissions and combinations of permissions can
perform the following actions:

Table 6. Report part access permissions and permitted actions

Permissions Permitted actions

Read and
execute

Users can view the report.

Users can expand the report to show the report parts.

Users can drag the report part onto the canvas and can execute the report part.

For folders, users with the following access permissions and combinations of permissions can perform the
following actions:

Table 7. Folder access permissions and permitted actions

Permissions Permitted actions

Read Users can view the folder in the content pane and can read folder properties.

Users cannot drag the folder onto the canvas.

Users cannot expand the folder to show the contents.

Users cannot save workspace objects in this folder.

Traverse Users can drag the folder onto the canvas.

Users can expand the folder to show the contents.

Users cannot save workspace objects in this folder.
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Table 7. Folder access permissions and permitted actions (continued)

Permissions Permitted actions

Write and
traverse

Users can drag the folder onto the canvas.

Users can expand the folder to show the contents.

Users can save workspace objects in this folder.

For workspaces, users with the following access permissions and combinations of permissions can
perform the following actions:

Table 8. Workspace access permissions and permitted actions

Permissions Permitted actions

Read Users can view the workspace.

Users cannot open the workspace.

Read and
traverse

Users can open the workspace.

With the Traverse permission, users can view the workspace widgets.

Read, write, and
traverse

Users can view, open, and save the workspace.

Ownership of Entries

If the user is an owner of an entry, the user has full access permissions for the entry. This ensures that
users can always access and modify the entries they own. By default, the owner of the entry is the user
who creates the entry. However, any other user who has set policy permissions for the entry can take
ownership of the entry.

Granted and Denied Access

You can grant access or deny access to entries. An icon that represents the type of access appears next to
the entry name on the Permissions tab. For example, when a group has execute permissions for a report,

this icon  appears next to the group name on the Permissions tab for the report. When a group has

execute permissions denied for a report, this icon  appears next to the group name.

Denied access has precedence over granted access. When you deny specific users or groups access to an
entry, you replace other security policies that grant access to the entry.

If the grant and deny permissions are in conflict, access to the entry is always denied. For example, a user
belongs to two groups. One group has access granted to a report and the other group has access denied
to the same report. Access to this report is denied for the user.

Deny access only when it is really required. Typically, it is a better administrative practice to grant
permissions than to deny them.

Parent and Child Permissions

If access permissions are not defined, the entry usually acquires permissions from its parent entry. You
can replace parent permissions by defining permissions for the child entry.
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Note: If you create a Framework Manager package but do not define its security, its default access
permissions do not match those of its parent folder. To ensure that a new package's access permissions
match those of its parent, follow these steps:

1. Edit the file installation_directory\configuration\fm.ini
2. Change the line

<Preference Name="SetPolicyPackage">TRUE</Preference>

to

<Preference Name="SetPolicyPackage">FALSE</Preference>

For more information, see "Chapter 7: Publishing packages" in the IBM Cognos Analytics Framework
Manager User Guide.

Objects that exist only as children of other objects always acquire permissions from their parents.
Examples of such objects are report specifications and report outputs. They are visible through the
Software Development Kit. You cannot set permissions specifically for those objects.

Accessing Entries Associated with Data Sources Secured Against Multiple
Namespaces

Data sources in IBM Cognos software can be secured against multiple namespaces. In some
environments, the namespace used to secure the data source is not the primary namespace used for
access to IBM Cognos Analytics. When you try to access an entry, such as a report, a query, or an analysis,
that is associated with a data source secured against multiple namespaces, and you are not logged on to
all of the required namespaces, a prompt for authentication appears. You must log on to the namespace
before you can access the entry.

When single signon (SSO) is enabled, the prompt for authentication does not appear. You are
automatically logged on to the namespace.

This functionality applies to IBM Cognos Viewer only. If a similar situation occurs in an IBM Cognos studio,
you must quit your task and log on to all the namespaces that you want to use in the current session.

Security settings after installation
Your IBM Cognos software installation must already be configured to use an authentication provider,
which is documented in the Configuring IBM Cognos Analytics Guide.

When the predefined roles are created during the content store initialization, the group Everyone is a
member of the System Administrators role. This means that all users have full access to the content
store. To limit that access, you must add trusted users as members of this role, and then remove the
group Everyone from its membership.

You must also modify the membership of the predefined roles that include the group Everyone, such as
Consumers, Query Users, and Authors. Make similar modifications for them as you do for the System
Administrators role. These modifications should also take the license terms into consideration.

If you do not want to use the predefined roles, you can delete them.

To secure the Cognos Users namespace, modify its initial access permissions by granting access for the
required users.

When you set access permissions, you should not explicitly deny access to entries for the group Everyone.
Denying access overrides any other security policies for the entry. If you denied access to the entry for
Everyone, the entry would become unusable.

To maintain a secure installation, users should be granted only the permissions and capabilities required
to allow them to complete their assigned tasks. For example, Readers would normally be restricted to
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read and traverse permissions for Public Folders and not be allowed to create reports using any studio.
Consumers would normally be restricted to read, traverse and execute permissions.

Certain capabilities, such as HTML Item In Report and User Defined SQL should be tightly managed.
These capabilities are checked during the authoring process as well as when running reports. If a
consumer needs to run a report that requires these capabilities, you may be able to use the Run as
Owner feature to limit the number of system users that require these capabilities. The Run as Owner
feature uses the report owner's credentials to perform some capability checks and to access data.

Securing System Administrators and standard roles
As one of the first steps when setting up security for the IBM Cognos environment, modify the initial
membership of the System Administrators role and other standard roles.

If the group Everyone is a member of a standard role, remove the group from the role membership.

Note: For a list of the default capabilities that are assigned to each role, see “Initial access permissions
for capabilities” on page 136.

Procedure
1. From Manage > People, click Accounts.
2. Click the Cognos namespace.

3. For the role that you want to modify, click the More icon  and then click Properties.
4. On the Members tab, modify the role membership:

• Ensure that one or more users defined in your authentication provider are members.
• Remove the group Everyone if this group is a member of the role.

5. On the Permissions tab, set access permissions for this role to prevent unauthorized users from
creating, updating, or deleting the content, and then click Apply.

6. For each role that you want to modify, repeat steps 3 to 5.

Securing the Cognos namespace
You can setup the Cognos namespace as follows.

Procedure
1. From Manage > People, click Accounts.

2. Next to the Cognos namespace, click the more icon  and then click Properties.
3. On the Permissions tab, set access permissions for the Cognos namespace to prevent unauthorized

users from creating, updating, or deleting the content.

We recommend that you remove the group Everyone. However, you may leave it, depending on your
requirements.

4. If you want, select the Apply to all children check box.
5. Click Apply.

User capabilities
The capabilities within the functions, which are also referred to as secured functions and secured
features, control access to different administration tasks and different functional areas of the user
interface in IBM Cognos software.

Examples of the secured functions are Administration and Reporting. Examples of the secured features
are User Defined SQL and Bursting.
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Content Manager reads the users' permissions at logon time. Depending on the permissions for the
secured functions and features, users can access specific components and perform specific tasks in IBM
Cognos software.

When a content store is initialized, the initial permissions for the secured functions and features are
created. The permissions define which of the predefined and built-in Cognos groups and roles have
access to which secured functions and features, and the type of access. The initial permissions grant
unrestricted access to IBM Cognos software because the built-in role System Administrators includes the
group Everyone in its membership. You must remove the group Everyone from the membership of System
Administrators before you start setting access to capabilities.

When running a report using the Run as the owner option, the capabilities of the owner are used for
bursting and report layout properties in the HTML format. All other capabilities are based on the user who
runs the report.

Users can see a list of the secured functions and features available to them in My Preferences on the
Personal tab.

For more information, see “Initial access permissions for capabilities” on page 136.

Note: You must select Manage > People > Capabilities to see the complete list of capabilities. Although
many of the capabilities also appear in the Administration console, we recommend that you use the
Manage component to assign capabilities. If a capability's administration can be performed only via the
Manage component, it is noted in its description in the following list.

Adaptive Analytics
This secured function controls access to the reports packaged using Adaptive Analytics.

Administration
This secured function contains the secured features that control access to the administration pages that
you use to administer IBM Cognos software. System administrators can use this capability to delegate
administration tasks to different administrators.

The following secured features are associated with this function:

• Adaptive Analytics Administration

Users can access Adaptive Analytics to perform administrative tasks.
• Administration tasks

Users can access Content Administration on the Configuration tab in IBM Cognos Administration to
administer exports, imports, consistency checks, and report updates.

• Collaboration Administration

Users can access the ability to create and control collaboration platforms.
• Configure and manage the system

Users can access System on the Status tab and Dispatchers and Services on the Configuration tab in
IBM Cognos Administration to configure dispatchers and services, and to manage the system.

• Controller Administration

Users can use the administrative functions of IBM Cognos Controller.
• Data Source Connections

Users can access Data Source Connections on the Configuration tab in Administration console or
in Data server connections under Manage to define data sources, connections, and signons. In IBM
Cognos Analytics on Cloud, they can also access the Secure Gateway page from the Manage menu.

• Distribution Lists and Contacts

Users can access Distribution Lists and Contacts on the Configuration tab in IBM Cognos
Administration to manage distribution lists and contacts.
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• Manage Visualizations

This secured function specifies that the user can control access rights to custom visualizations for
individual users, groups, and roles.

CAUTION: Be judicious when you assign Develop Visualizations access and ensure that you
review files that are being uploaded. People who are permitted to upload files may be able to
deliver malicious code.

• Mobile Administration

Users can administer IBM Cognos Analytics Mobile Reports services and applications.
• Planning Administration

Users can access IBM Cognos Planning Contributor Administration Console and IBM Cognos Planning
Analyst to perform administration tasks.

• PowerPlay Servers

User is given limited access to the IBM Cognos Administration pages. This includes access to the
PowerPlay® page and the ability to set PowerPlay properties.

• Printers

Users can access Printers on the Configuration tab in IBM Cognos Administration to manage printers.
• Query Service Administration

Users can access the Status > Data Stores page in IBM Cognos Administration to manage dynamic
cubes. Users can perform operations on cubes, such as starting and stopping cubes, refreshing the data
cache, and creating and scheduling query service tasks.

• Run activities and schedules

Users can access Current Activities, Past Activities, Upcoming Activities and Schedules on the
Status tab in IBM Cognos Administration to monitor the server activities and manage schedules. To
grant access to the scheduling functionality independently from the monitoring functionality, use the
Scheduling capability.

• Set capabilities and manage UI profiles

Users can access Capabilities and User Interface Profiles on the Security tab in IBM Cognos
Administration to manage the secured functions and features and the Reporting user interface profiles.

• Styles and portlets

Users can access Styles and Portlets on the Configuration tab in IBM Cognos Administration to
manage styles and portlets.

• Users, Groups and Roles

Users can access Users, Groups and Roles on the Security tab in IBM Cognos Administration to
manage namespaces, users, groups, and roles.

AI
This capability allows designated users to access AI functionality. The roles granted with Execute
permissions by default are listed in the AI capability section.

Note: To administer this capability and its secured functions, you must select Manage > People >
Capabilities. You cannot administer this capability from the Administration console.

The following secured functions are associated with this function:

•  Learning

This secured function allows the system to learn from an assignee’s product usage.
•  Use Assistant

This secured function allows designated users to use the Assistant.
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Analysis Studio
This secured function controls access to IBM Cognos Analysis Studio. Users with access to this studio
explore, analyze, and compare dimensional data, find meaningful information in large data sources, and
answer business questions.

Attach Outputs
 This capability allows a user to attach outputs in an email when setting a schedule, running a report

in the background, or setting job steps.

Note: To administer this capability, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Cognos Analytics for Mobile
 This capability allows users access to Cognos Analytics via the Cognos Analytics for Mobile app.

The roles granted with Execute permissions by default are listed in the "Cognos Analytics for Mobile
capability" section of Initial access permissions for capabilities.

Note: To administer this capability, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Cognos Insight
This secured function controls access to IBM Cognos Insight. Users with access to this tool work with
complicated data sources to discover, visualize, and plan in easy to use workspaces.

Cognos Viewer
This secured function controls access to IBM Cognos Viewer, which you use to view reports.

The secured features associated with this function are

• Context Menu

Users can use the context menu in IBM Cognos Viewer.

Note: To see the context menu, users must have access to both the Selection and Context Menu
secured features.

• Run With Options

Users can change the default run options. When users have no execute permissions for this feature,

they cannot see the Run with options  icon for reports.
• Selection

Users can select text in lists and crosstabs.
• Toolbar

Users can see the IBM Cognos Viewer toolbar.

Collaborate
This secured function controls access to IBM Connections from within IBM Cognos.

The secured features associated with this function are:

• Launch Collaboration Tools

The secured feature allows users to launch IBM Connections from any Launch menu within the IBM
Cognos Analytics environment, including the Cognos Workspace Getting Started Page, and the Actions
Menu. The links will go to the user's IBM Connections home page, if it is configured, or to Activities.

• Allow Collaboration Features
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This secured feature controls access to the Collaborate icon and to IBM Connections Search Results
within Cognos Workspace. Users must have access to create or view activities from within Cognos
Workspace.

Controller Studio
This secured function controls access to IBM Cognos Controller.

Dashboard
This secured function controls access to view Dashboards and Stories. Users require Execute permissions
for the Dashboard capability to view both dashboards and stories. The roles granted with Execute
permissions by default are listed in the “Dashboard capability” on page 148 section.

The following secured feature is associated with this function:

Create/Edit

This secured function controls access to the New > Dashboard and New > Story functions. Users require
Execute permissions for the Dashboard and Create/Edit capability to both create or edit dashboards and
stories.

Note: To administer this seecured function, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Data Manager
This secured function controls access to Data Manager.

Data sets
This secured function controls access to the Create data set menu that is available from the package and
data module context menus.

Desktop Tools
This secured function controls tracking for Cognos Desktop Tools products. Users with this capability
are members of the Analytics Explorers role. This allows an admin to track the users in the license
counter. Products that will count as a desktop tool include Planning Analytics For Microsoft Excel,
Cognos Framework Manager, Cognos Cube Designer and Dynamic Query Analyzer, Transformer, and TM1
Writeback to bundled FLBI TM1 server.

Detailed Errors
This secured function controls access to viewing detailed error messages in the Web browser.

Develop Visualizations
This secured function specifies that the user can develop custom visualizations.

CAUTION: Be judicious when you assign Develop Visualizations access and ensure that you
review files that are being uploaded. People who are permitted to upload files may be able to
deliver malicious code.

Drill Through Assistant
This secured function controls access to the drill-through debugging functionality in the drill-through Go
To page and the drill-through definitions. Users who have this capability see additional information in the
Go To page for each drill-through target. This information can help to debug a drill-through definition, or
can be forwarded to the Cognos Software Services representative.
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Event Studio
This secured function controls access to Event Studio.

Email
 This capability allows a user to send an email when scheduling or sharing content. The roles

granted with Execute permissions by default are listed in the "Email capability" section of Initial access
permissions for capabilities.

Note: To administer this capability and its secured functions, you must select Manage > People >
Capabilities. You cannot administer this capability from the Administration console.

The following secured features are associated with this capability:

Email Delivery Option

This secured function allows a user to choose email delivery when setting a schedule, running a report in
the background, or setting job steps.

Include link in email

This secured function allows a user to link to content from an email when sharing content, setting a
schedule, or running a report in the background.

Share using email

This secured function allows a user to share annotated screen captures via email from Share > Send.

Type in external email

This secured function allows a user to enter external recipients in an email. If the secured function is not
granted, the user can only select recipients from their authenticated namespaces.

Execute Indexed Search
This secured function controls access to the search of indexed content. This secured function does not
appear until the Index Update Service has been started.

By default, Execute Indexed Search allows enhanced indexed search. When Execute Indexed Search is
disabled, basic indexed search is provided.

Executive Dashboard
This secured function controls access to IBM Cognos Workspace. Users who have access to this function
are granted basic permissions for the workspaces in Cognos Workspace. With this type of permissions,
users can view the workspaces, drill up and down on the workspace data, add comments, print the
workspaces, use slider filters, and select value filters if these filters are included in the workspace.

The following secured features, which are associated with the Executive Dashboard function, grant more
extensive permissions for the workspace:

• Use Advanced Dashboard Features

Use this feature to grant the users maximum permissions for the workspace.
• Use Interactive Dashboard Features

Use this feature to grant the users permissions to access the workspace functions that allow interaction
with the widget data. This includes access to the on-demand toolbar in the widget that provides options
for interacting with the report data, such as sorting, deleting, resetting, swapping rows and columns,
and changing the report display type.
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Exploration
This secured function controls access to the New > Exploration function. Users require Execute
permissions for the Exploration capability both to create or view explorations. The role is granted with
Execute permissions by default, as listed in the Exploration capability section.

External Content
This capability allows the assignee to use content from sources that are external to IBM Cognos Analytics.

Note: To administer this capability and its secured functions, you must select Manage > People >
Capabilities. You cannot administer this capability from the Administration console.

The secured function associated with the External Content capability is Watson Studio. It allows the
assignee to create assets in the Cognos Analytics content store that reference external Watson Studio
Notebooks.

External Repositories
This secured function controls access to external repositories. External repositories provide long-term
storage for report content. When a connection to an external repository is specified for a package or
folder, report output versions are copied to the repository automatically.

The secured features associated with this function are

• Manage repository connections

Users can set a repository connection on a package or folder if a data source connection already exists.
• View external documents

Users can view the report output stored in an external repository.

Generate CSV Output
With permissions for this secured function, users can generate report output in the delimited text (CSV)
format. Without this capability, users do not see an option in the user interface to run reports in the CVS
format.

Generate PDF Output
With permissions for this secured function, users can generate report output in the PDF format. Without
this capability, users do not see an option in the user interface to run reports in the PDF format.

Generate XLS Output
With permissions for this secured function, users can generate report output in the Microsoft Excel
spreadsheet (XLS) formats. Without this capability, users do not see an option in the user interface to run
reports in the XLS formats.

Generate XML Output
With permissions for this secured function, users can generate report output in XML format. Without this
capability, users do not see an option in the user interface to run reports in the XML format.

Glossary
This secured function controls access to the IBM InfoSphere® Business Glossary.

132  IBM Cognos Analytics Version 11.1: Managing User Guide



Hide Entries
This secured function specifies that a user can hide entries and view hidden entries in IBM Cognos
software.

The Hide this entry check box appears on the General tab of the entries' properties pages. The Show
hidden entries check box appears on the Preferences tab in user profiles, and on the General tab in My

Area Options , My Preferences.

Import Relational Metadata
Specifies that a group can import relational metadata into a Framework Manager or Dynamic Cube
Designer project using dynamic query mode.

By default, the System Administrator, Directory Administrator, and Report Administrators groups belong
to this secured function.

If other groups require the ability to import relational metadata to a dynamic query mode project they
must be added to the capability. For example, if you create a Framework Manager Users group and add
your Framework Manager users to that group, you also need to add the group to the Import relational
metadata secured function.

Job
This secured function controls the ability for a user to be able to create jobs.

Note: To administer this capability, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Lineage
This secured function controls access to the Lineage action. Use this to view information about data or
metadata items from IBM Cognos Viewer, or from the source tree in Reporting, Query Studio, and Analysis
Studio.

Manage content
This secured functions controls access to the Content tab in Manage.

Manage Own Data Source Signons
This secured function controls the ability to manage data source credentials on the Personal tab in My
Preferences.

Mobile
This secured function controls access to IBM Cognos Analytics Mobile Reports.

Notebook
This secured function controls access to the New > Notebook option. Users require Execute permissions
for the Notebook capability to create Notebooks.

Note: To administer this capability, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Planning Contributor
This secured function controls access to IBM Cognos Planning Contributor and IBM Cognos Planning
Analyst.
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PowerPlay Studio
This secured function controls access to PowerPlay Studio.

Query Studio
This secured function controls access to the Query Studio, which you use to create simple, ad hoc reports.

The secured feature associated with this function is

• Create

Create new reports and use the Save as option for new reports and custom views.
• Advanced

Use advanced authoring features, such as creating complex filters, formatting style, and multilingual
support.

Report Studio
This secured function controls access to the Reporting user interface and to the underlying report
execution functionality. Users need execute permissions on this secured function to access the Reporting
user interface. Traverse or read permissions on this secured function might be needed to use the
associated secured features, for example, to run reports created with custom SQL or embedded HTML.

The secured features associated with this function are:

• Allow External Data

Users can use external data in reports.
• Bursting

Users can author and run burst reports.
• Create/Delete

Users can create new reports, use the Save as option for new reports and report views, and change
models.

• HTML Items in Report

Users can use the HTMLItem button and hyperlink elements of the report specification when authoring
reports.

• User Defined SQL

Users can edit the SQL statements directly in the query specification and run the query specifications
that contain the edited SQL statements.

Tip: Restrictions on who can use this feature are not enforced in Framework Manager. For example, a
Framework Manager user who does not have User Defined SQL rights in IBM Cognos Administration
can still create a query subject and use manually created SQL queries to search a database.

Save to Cloud
 This capability allows designated users to save their report output to the cloud. Users require

Execute permissions for the Save to Cloud capability to view the Save to cloud check box as a delivery
option for saved report outputs. The roles granted with Execute permissions by default are listed in the
Save to Cloud capability section.

Note: To administer this capability and its secured feature, you must select Manage > People >
Capabilities. You cannot administer this capability from the Administration console.

The following secured feature is associated with this function:

• Manage Connections
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This secured feature allows Directory Administrators to access the Manage > Storage page to create
and manage connections to external Cloud Object Storage services. Designated users can then access
the Save to cloud feature.

Scheduling
The Scheduling capability allows a user to schedule items that can be run, such as reports. Users must
have the Scheduling capability to see the My schedules and subscriptions option in the Personal menu

. For more information, see "My schedules and subscriptions" in the IBM Cognos Analytics Getting
Started Guide.

The secured features associated with this capability are

• Schedule by day

Users can schedule entries daily.
• Schedule by hour

Users can schedule entries by the hour.
• Schedule by minute

Users can schedule entries by the minute.

If a user is denied access to the Schedule by minute capability, 'by minute' scheduling is also denied
for other capabilities that allow 'by minute' scheduling, for example, the Schedule by month capability.

• Schedule by month

Users can schedule entries monthly.
• Schedule by trigger

Users can schedule entries based on a trigger.
• Schedule by week

Users can schedule entries weekly.
• Schedule by year

Users can schedule entries yearly.
• Scheduling Priority

Users can set up and change the processing priority of scheduled entries.

Note: A user who schedules an item (that is, a report, event, job and so on) without the Scheduling
Priority capability cannot schedule an item with a priority other than 3. A different priority may be set,
and displayed, in the schedule by a user with the appropriate access. However, the report will still run
with a priority of 3 unless its ownership is also changed to a user with the appropriate access to the
Scheduling Priority capability.

Self Service Package Wizard
This secured function controls the ability to select which data sources can be used to create a package.

Set Entry-Specific Capabilities
This secured function specifies that a user can set up capabilities at an entry level.

The Capabilities tab appears in the Set properties pages for packages and folders for users who have
this capability and who have set policy permissions for the entry or who own the entry.
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Share Pin Board
 Users who are assigned this capability can share a pin board that they created using Cognos

Analytics for Mobile.

Note: To administer this capability, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Specification Execution
This secured function allows a user or Software Development Kit application to use an inline specification.
The Specification Execution secured function is counted as an Analytics Administrators licence role.

IBM Cognos Analytics studios and some services use inline specifications internally to perform tasks. The
service running the specification tests a number of capabilities to ensure that the user is entitled to use
the inline specification. For more information, see the runSpecification method in the Developer Guide.

Upload files
This secured function controls access to the Upload files function. Users who have this capability can
upload data files.

Visualization Alerts
 Users who are assigned this capability can create an alert for a pin board in Cognos Analytics for

Mobile.

Note: To administer this capability, you must select Manage > People > Capabilities. You cannot
administer this capability from the Administration console.

Watch Rules
This secured function controls access to the Rules tab in My Watch Items. Use this secured function to
create and run watch rules.

Web-based modeling
This secured function controls access to the web-based modeling function. Users who have this capability
can create data modules from the New > Data module menu.

Initial access permissions for capabilities
In IBM Cognos Analytics, when Content Manager initializes a content store, it creates basic structures and
security information. These structures include initial access permissions for the capabilities.

The capabilities are also referred to as secured functions and secured features.

Note: If you want to make changes to the initial access permissions, see “Setting access to capabilities”
on page 171.

Permission levels
There are five types of access permissions that can be assigned to a group or role: Read, Write, Execute,
Set policy, and Traverse. For a description of the permitted actions that are available for each permission
type, see “Access permissions for an entry” on page 119.

In addition, combinations of access permissions are granted for each capability. These combinations are
defined as permission levels, as shown in the following table:
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Permission level Access permissions granted

Access Execute and Traverse

Assign Traverse and Set Policy

Manage Execute, Traverse, and Set Policy

Custom Any other combination not listed above.

Capability names
This section lists all the Cognos Analytics capabilities. For each capability, you can see which groups or
roles can initially access the capability, as well as the access permissions that they were granted.

Adaptive Analytics capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 9. Adaptive Analytics capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Administration capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 10. Administration capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Manage

Library
Administrators

Access

Mobile
Administrators

Access

Modelers Access

Portal
Administrators

Access
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Table 10. Administration capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

PowerPlay
Administrators

Access

Report
Administrators

Access

Server
Administrators

Access

The secured features in the following table are children of the Administration capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 11. Secured features of the Administration capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Adaptive
Analytics
Administration

Adaptive
Analytics
Administrators

Directory
Administrators

Assign

Administration
tasks

Server
Administrators

Access

Report
Administrators

Access

Directory
Administrators

Assign

PowerPlay
Administrators

Access

Collaboration
Administration

Directory
Administrators

Manage
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Table 11. Secured features of the Administration capability and permissions for related groups and roles
(continued)

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Configure and
manage the
system

Server
Administrators

Access

Directory
Administrators

Assign

Controller
Administration

Directory
Administrators

Assign

Data Sources
Connections

Directory
Administrators

Manage

Modelers Access

Distribution
Lists and
Contacts

Directory
Administrators

Manage

Manage
Visualizations

Directory
Administrators

Assign

Library
Administrators

Access

Metric Studio
Administration

Directory
Administrators

Assign

Mobile
Administration

Directory
Administrators

Assign

Mobile
Administrators

Access

Planning
Administration

Directory
Administrators

Assign

PowerPlay
Servers

Directory
Administrators

Assign

PowerPlay
Administrators

Access

Printers Directory
Administrators

Manage

Chapter 7. Managing access  139



Table 11. Secured features of the Administration capability and permissions for related groups and roles
(continued)

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Query Service
Administration

Directory
Administrators

Assign

Server
Administrators

Access

Run activities
and schedules

Report
Administrators

Access

Directory
Administrators

Assign

PowerPlay
Administrators

Access

Set capabilities
and manage UI
profiles

Directory
Administrators

Manage

Styles and
portlets

Portal
Administrators

Access

Directory
Administrators

Manage

Library
Administrators

Access

Users, Groups,
and Roles

Directory
Administrators

Manage

AI capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 12. AI capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access
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Table 12. AI capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Users Access

Directory
Administrators

Assign

The secured features in the following table are children of the AI capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 13. Secured features of the AI capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Learning Analytics
Explorers

Access

Analytics Users Access

Directory
Administrators

Assign

Use Assistant Analytics
Explorers

Access

Analytics Users Access

Directory
Administrators

Assign

Analysis Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 14. Analysis Studio capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users Access

Chapter 7. Managing access  141



Table 14. Analysis Studio capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Authors Access

Directory
Administrators

Assign

Modelers Access

Report
Administrators

Access

Attach outputs capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 15. Attach Outputs capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Directory
Administrators

Assign

Cognos Analytics for Mobile capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 16. Cognos Analytics for Mobile capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access
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Table 16. Cognos Analytics for Mobile capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Viewers Access

Directory
Administrators

Assign

Report
Administrators

Access

Cognos Insight capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 17. Cognos Insight capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Cognos Viewer capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 18. Cognos Viewer capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users Access

Authors Access

Consumers Access

Directory
Administrators

Assign

Analytics Viewers Access

Modelers Access
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Table 18. Cognos Viewer capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

PowerPlay
Administrators

Access

PowerPlay Users Access

Query Users Access

Readers Access

Report
Administrators

Access

The secured features in the following table are children of the Cognos Viewer capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 19. Secured features of the Cognos Viewer capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Context Menu

Selection

Toolbar

Report
Administrators

Access

Authors Access

Consumers Access

Query Users Access

Analysis Users Access

Readers Access

Directory
Administrators

Assign

Analytics
Viewers

Access

Modelers Access

PowerPlay
Administrators

Access

PowerPlay
Users

Access
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Table 19. Secured features of the Cognos Viewer capability and permissions for related groups and roles
(continued)

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Run With
Options

Report
Administrators

Access

Authors Access

Consumers Access

Query Users Access

Analysis Users Access

Directory
Administrators

Assign

Modelers Access

PowerPlay
Administrators

Access

PowerPlay
Users

Access

Collaborate capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 20. Collaborate capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users Access

Authors Access

Consumers Access

Directory
Administrators

Assign

Modelers Access
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Table 20. Collaborate capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

PowerPlay
Administrators

Access

PowerPlay Users Access

Query Users Access

Report
Administrators

Access

The secured features in the following table are children of the Collaborate capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 21. Secured features of the Collaborate capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Allow
collaboration
features

Launch
collaboration
tools

Analysis Users Access

Authors Access

Consumers Access

Directory
Administrators

Assign

Modelers Access

PowerPlay
Administrators

Access

PowerPlay
Users

Access

Query Users Access

Report
Administrators

Access
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Controller Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 22. Controller Studio capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Dashboard capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 23. Dashboard capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Analytics Viewers Access

Directory
Administrators

Assign

The secured features in the following table are children of the Dashboard capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 24. Secured features of the Dashboard capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Create/Edit Analytics
Explorers

Access

Analytics Users Access

Directory
Administrators

Assign

Data Manager capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 25. Data Manager capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Data sets capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 26. Data sets capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access

Desktop Tools capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 27. Desktop Tools capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Directory
Administrators

Assign

Detailed Errors capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 28. Detailed Errors capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Develop Visualizations capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 29. Develop Visualizations capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Directory
Administrators

Assign

Drill Through Assistant capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 30. Drill Through Assistant capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Email capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 31. Email capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Analytics Viewer Access

Directory
Administrators

Assign

The secured features in the following table are children of the Email capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 32. Secured features of the Email capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Email Delivery
Option

Analytics
Explorers

Access

Analytics Users Access

Directory
Administrators

Assign

Include link in
email

Analytics
Explorers

Access

Chapter 7. Managing access  151



Table 32. Secured features of the Email capability and permissions for related groups and roles
(continued)

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Analytics Users Access

Analytics
Viewer

Access

Directory
Administrators

Assign

Share using
email

Analytics
Explorers

Access

Analytics Users Access

Analytics
Viewer

Access

Directory
Administrators

Assign

Type in
external email

Analytics
Explorers

Access

Analytics Users Access

Analytics
Viewer

Access

Directory
Administrators

Assign

Event Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 33. Event Studio capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Authors Access

Directory
Administrators

Assign
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Table 33. Event Studio capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Modelers Access

Report
Administrators

Access

Execute Indexed Search capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 34. Execute Indexed Search capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users

Authors

Consumers

Analytics Viewers

Modelers

PowerPlay
Administrators

PowerPlay Users

Query Users

Readers

Report
Administrators

Access

Directory
Administrators

Assign

Executive Dashboard capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 35. Executive Dashboard capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users Access

Authors Access

Consumers Access

Directory
Administrators

Assign

Analytics Viewers Custom Permissio
n Denied

Permissio
n Denied

Modelers Access

PowerPlay
Administrators

Access

PowerPlay Users Access

Query Users Access

Readers Access

Report
Administrators

Access

The secured features in the following table are children of the Executive Dashboard capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 36. Secured features of the Executive Dashboard capability and permissions for related groups and
roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Use Advanced
Dashboard
Features

Use Interactive
Dashboard
Features

Authors Access

Directory
Administrators

Assign

Analytics
Viewers

Custom

Modelers Access

Query Users Access

Report
Administrators

Access

Exploration capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 37. Exploration capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Directory
Administrators

Assign

Analytics Viewers Custom Permissio
n denied

Permissio
n denied

External Repositories capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 38. External Repositories capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access

The secured features in the following table are children of the External Repositories capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 39. Secured features of the External Repositories capability and permissions for related groups and
roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Manage
repository
connections

Directory
Administrators

Assign

View external
documents

Directory
Administrators

Assign

Everyone Access

Generate CSV Output

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 40. Generate CSV Output capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access
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Generate PDF Output capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 41. Generate PDF Output capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access

Generate XLS Output capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 42. Generate XLS Output capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access

Generate XML Output capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 43. Generate XML Output capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access
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Glossary capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 44. Glossary capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Everyone Access

Directory
Administrators

Assign

Hide Entries capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 45. Hide Entries capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Everyone Access

Directory
Administrators

Assign

Import relational metadata capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 46. Import relational metadata capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Report
Administrators

Access

158  IBM Cognos Analytics Version 11.1: Managing User Guide



Job capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 47. Job capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Directory
Administrators

Assign

 Report
Administrators

Access

Lineage capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 48. Lineage capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Everyone Access

Directory
Administrators

Assign

Manage content capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 49. Manage content capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Library
Administrators

Mobile
Administrators

Portal
Administrators

PowerPlay
Administrators

Report
Administrators

Server
Administrators

Access

Directory
Administrators

Manage

Manage own data source signons capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 50. Manage own data source signons capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Metric Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 51. Metric Studio capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access
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Table 51. Metric Studio capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

The secured features in the following table are children of the Metric Studio capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 52. Secured features of the Metric Studio capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Edit View Analytics
Explorers

Access

Directory
Administrators

Assign

Mobile capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 53. Cognos Analytics Mobile Reports capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Analytics Viewers Access

Mobile
Administrators

Access

Mobile Users Access
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Notebook capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 54. Notebook capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Planning Contributor capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 55. Planning Contributor capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

PowerPlay Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 56. PowerPlay Studio capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Authors Access

Directory
Administrators

Assign

Modelers Access

PowerPlay
Administrators

Access

PowerPlay Users Access
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Query Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 57. Query Studio capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Authors Access

Directory
Administrators

Assign

Modelers Access

Query Users Access

Report
Administrators

Access

The secured features in the following table are children of the Query Studio capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 58. Secured features of the Query Studio capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Create

Advanced

Authors Access

Modelers Access

Query Users Access

Report
Administrators

Access

Directory
Administrators

Assign

Report Studio capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 59. Reporting capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Authors Access

Directory
Administrators

Assign

Library
Administrators

Access

Modelers Access

Report
Administrators

Access

The secured features in the following table are children of the Reporting capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 60. Secured features of the Reporting capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Bursting

HTML Items in
Report

User Defined
SQL

Create/Delete

Authors Access

Library
Administrators

Access

Modelers Access

Report
Administrators

Access

Directory
Administrators

Assign

Allow External
Data

Directory
Administrators

Assign

Library
Administrators

Access

Save to Cloud capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 61. Save to Cloud capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Directory
Administrators

Assign

Report
Administrators

Access

The secured feature in the following table is a child of the Save to Cloud capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 62. Secured features of the Save to Cloud capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Manage
Connections

Directory
Administrators

Assign

Report
Administrators

Access

Scheduling capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 63. Scheduling capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users Access

Authors Access

Consumers Custom
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Table 63. Scheduling capability and permissions for related groups and roles (continued)

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Modelers Access

PowerPlay
Administrators

Access

PowerPlay Users Access

Query Users Access

Report
Administrators

Access

The secured features in the following table are children of the Scheduling capability.

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 64. Secured features of the Scheduling capability and permissions for related groups and roles

Secured
feature

Group or role Permission
level

Permission type

Read Write Execute Set
policy

Traverse

Schedule by
day

Schedule by
hour

Schedule by
minute

Schedule by
month

Schedule by
trigger

Schedule by
week

Schedule by
year

Analysis Users Access

Authors Access

Consumers Custom

(Except for
Schedule by
day, where
permission
level = Access)

Directory
Administrators

Assign

Modelers Access

Query Users Access

Report
Administrators

Access

PowerPlay
Administrators

Access

PowerPlay
Users

Access

Scheduling
Priority

Report
Administrators

Access

Directory
Administrators

Assign

PowerPlay
Administrators

Access

Self Service Package Wizard capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 65. Self Service Package Wizard capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Manage

Set Entry-Specific Capabilities capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 66. Set Entry-Specific Capabilities capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Share Pin Board

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 67. Share Pin Board capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Directory
Administrators

Assign

Report
Administrators

Access

Snapshots capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.
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Table 68. Snapshots capability and initial permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Everyone Access

Modelers Access

Specification Execution capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 69. Specification Execution capability and initial permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Upload files capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 70. Upload files capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Everyone Access

Directory
Administrators

Assign

Analytics Viewers Custom Permissio
n denied

Permissio
n denied

Modelers Access
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Visualization Alerts capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 71. Visualization Alerts capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analytics Explorers Access

Analytics Users Access

Directory
Administrators

Assign

Report
Administrators

Access

Watch Rules capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 72. Watch Rules capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Analysis Users Access

Authors Access

Consumers Access

Directory
Administrators

Assign

Modelers Access

PowerPlay
Administrators

Access

PowerPlay Users Access

Query Users Access

Report
Administrators

Access
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Web-based modeling capability

In the following table, a checkmark ( ) indicates that a permission is granted to a group or role for an
object.

Table 73. Web-based modeling capability and permissions for related groups and roles

Group or role Permission level Permission type

Read Write Execute Set policy Traverse

Directory
Administrators

Assign

Analytics Viewers Custom Permissio
n denied

Permissio
n denied

Everyone Access

Modelers Access

Setting access to capabilities
You set access to the capabilities, also known as secured functions and features, by granting Execute and
Traverse permissions for them to specified namespaces, users, groups, or roles.

Note: A user must have Execute and Traverse permissions on a capability for it, or any of its sub-
capabilities, to appear in the Personal menu  under My preferences > Personal > Advanced > My
Capabilities > View details.

Before you begin
You must have set policy permissions to administer secured functions and features. Typically, this is done
by directory administrators.

Before you start setting permissions on capabilities, ensure that the initial security settings are already
changed.

Procedure
1. From Manage > People, click Capabilities.

A list of available secured functions appears.

2. For the secured function that you want to modify, click the More icon  and then click Properties.
3. Click the Access tab.
4. When the entry is a child, you can choose to use the permissions of the parent entry or specify

different permissions:

• To use the permissions of the parent entry, ensure that Override parent access is turned off. If
Override parent access is turned on, set it off, and click Apply.

• To specify access permissions explicitly for the entry, set Override parent access to on, and then
perform the remaining steps.

5. If you want to remove an entry from the list, click the Remove member icon .

6. If you want to add new entries to the list, click the Add member icon  and choose how to select
entries:
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• To choose from listed entries, click the appropriate namespace, and then click the users, groups, or
roles that you want. Click Add when you are done.

• To select multiple entries at once press Ctrl-click.

• To search for entries, type text in the  Find field.

Note: You can click the Search Method icon  to find entries that either contain, start with, or are
an exact match with the text that you type.

• Click the filter  icon to narrow the view of entries.
• To type the name of entries you want to add, click Type and type the names of groups, roles, or users

using the following format, where a semicolon (;) separates each entry:

namespace/group_name;namespace/role_name;namespace/user_name;

Here is an example:

Cognos/Authors;LDAP/scarter;
7. Select the box in the Permissions column next to the entry for which you want to set access to the

function or feature.
8. Select the Access permission.

This permission includes the Execute and Traverse granular permissions. Alternatively, you can select
the Custom permission, and choose the required combination of granular permissions.

Important:

The Execute permission is always necessary when setting access to capabilities. The Traverse
permission is not always required. Any other permissions depend on the user role.

9. To apply your changes, click outside the window with the permissions.

Object Capabilities
Object capabilities specify the secured functions and features that users, groups, or roles can use with
different packages. For example, the capabilities define the studio to open a package and the studio
features available while working with this package.

The secured functions and their features, also referred to as global capabilities, control access to the
different components and functionality in IBM Cognos software. For object capabilities to work, you must
combine them with applicable global capabilities. For example, when setting up object capabilities for a
package that contains Reporting and Query Studio reports, ensure that the user also has access to the
Reporting and Query Studio secured functions and their applicable secured features.

Republishing an existing package from a client tool, such as Framework Manager, does not overwrite or
modify object capabilities previously specified.

Control object capabilities with the Set Entry-Specific Capabilities secured function. For more
information, see “User capabilities” on page 126.

The following sections describe the capabilities that are available for individual packages and folders that
contain packages.

Adaptive Analytics
This secured function controls access to the reports packaged using Adaptive Analytics.

Administration
This secured function controls access to the administrative pages in IBM Cognos software. You can
specify object capabilities for the following secured features within Administration.

• Adaptive Analytics Administration
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Users can access Adaptive Analytics to perform administrative tasks.
• Planning Administration

Users can access IBM Cognos Planning Contributor Administration Console and IBM Cognos Planning
Analyst to perform administration tasks.

Event Studio
This secured function controls access to Event Studio.

Glossary
This secured function controls access to the IBM InfoSphere Business Glossary.

Lineage
This secured function controls access to the Lineage action. Use this to view information about data or
metadata items from IBM Cognos Viewer, or from the source tree in Reporting, Query Studio, and Analysis
Studio.

Planning Contributor
This secured function controls access to IBM Cognos Planning Contributor and IBM Cognos Planning
Analyst.

PowerPlay Studio
This secured function controls access to PowerPlay Studio.

Query Studio
This secured function controls access to the Query Studio, which you use to create simple, ad hoc reports.

The secured feature associated with this function is

• Create

Create new reports and use the Save as option for new reports and custom views.
• Advanced

Use advanced authoring features, such as creating complex filters, formatting style, and multilingual
support.

Report Studio
This secured function controls access to the Reporting user interface and to the underlying report
execution functionality. Users need execute permissions on this secured function to access the Reporting
user interface. Traverse or read permissions on this secured function might be needed to use the
associated secured features, for example, to run reports created with custom SQL or embedded HTML.

The secured features associated with this function are:

• Allow External Data

Users can use external data in reports.
• Bursting

Users can author and run burst reports.
• Create/Delete

Users can create new reports, use the Save as option for new reports and report views, and change
models.
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• HTML Items in Report

Users can use the HTMLItem button and hyperlink elements of the report specification when authoring
reports.

• User Defined SQL

Users can edit the SQL statements directly in the query specification and run the query specifications
that contain the edited SQL statements.

Tip: Restrictions on who can use this feature are not enforced in Framework Manager. For example, a
Framework Manager user who does not have User Defined SQL rights in IBM Cognos Administration
can still create a query subject and use manually created SQL queries to search a database.

Specification Execution
This secured function allows a user or Software Development Kit application to use an inline specification.
The Specification Execution secured function is counted as an Analytics Administrators licence role.

IBM Cognos Analytics studios and some services use inline specifications internally to perform tasks. The
service running the specification tests a number of capabilities to ensure that the user is entitled to use
the inline specification. For more information, see the runSpecification method in the Developer Guide.

Watch Rules
This secured function controls access to the Rules tab in My Watch Items. Use this secured function to
create and run watch rules.

Setting access to object capabilities
Use this functionality to specify the secured functions and features that users, groups, or roles can use
with specific packages.

You can specify object capabilities at the package level or, if the package is stored in a folder, at the folder
level. Capabilities specified at the folder level apply only to packages in that folder and in its sub-folders,
and not to any other entries, including reports. For example, if a folder contains packages, reports and a
subfolder that contains other packages and reports, only the packages in the folder and in the subfolder
are affected by the capabilities settings.

The following capabilities are applied globally; they cannot be set on a folder by folder basis:

• Generate CSV Output
• Generate PDF Output
• Generate XLS Output
• Generate XML Output

Before you begin
To set object capabilities, users must have access for the secured function Set Entry-Specific
Capabilities. For more information, see “User capabilities” on page 126. The users must also have set
policy permissions for the package, or own the package. For more information, see “Access permissions
for an entry” on page 119.

When setting object capabilities for the first time after installing Cognos Analytics, start with the Team
content capabilities, which should mirror the global capabilities. This provides an accurate baseline on
which object capabilities can be further refined.

Procedure
1. In Team content (or any other folder in the Content page), open the package or folder properties page.
2. Click the Capabilities tab, and then click Set capabilities.
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3. For the user, group, or role for which you want to specify object capabilities, select the checkbox
Override parent capabilities.

If the user, group, or role is not in the list, click Add. If you want to remove the user, group, or role from
the list, select its check box, and click Remove.

4. In the Grant and Deny column, select or clear the applicable checkboxes to grant or deny the required
object capabilities for users, groups, or roles.

An icon that represents a granted or denied capability appears next to the name of the user, group,
or role. When you deny access to a secured function, you automatically deny access to all its secured
features.

5. If applicable, select the Override child capabilities checkbox.

Use this option to specify object capabilities for a hierarchy of entries, for example, for all packages in
a folder.

6. Click Save.

Managing licenses
System administrators need to track IBM Cognos Analytics license usage.

The license information in IBM Cognos Analytics shows the licenses that were used by individual users
with their last login. Users' changed capabilities are not reflected in their licence usage until the users
log in again. Also, for existing customers the license usage information is incomplete until all users log in
again.

A license usage report is generated when the licenses page in Manage > Licenses is opened for the first
time, when the Refresh button is clicked, or after a product restart.

The basic report contains information about license usage by user. Some customers might want to do
additional reporting, for example, on license usage by tenant.

IBM Cognos Analytics has a few types of licensed roles, each of them associated with different
capabilities. Refer to this article (https://www.ibm.com/support/docview.wss?uid=ibm10735275) to view
the capabilities and permissions matrix that the IBM Cognos Analytics license model is based on.

Procedure
1. To access the licenses page in IBM Cognos Analytics, click Manage > Licenses.
2. To enter the number of owned licenses, click the Owned field for the licensed role, type the number,

and click Apply to save the value.

This value is used for information purposes only and is not included in the license usage report.
3. To generate the license usage report, click Refresh.

You can generate the report as often as you want.

4. To view the license information for a specific role, click the details icon .

This information is a subset of information from the full report.
5. To view the full report, click Export to save the information to a CSV file, and open the file.

Tip: In the exported file, the values in Level column correspond to specific license roles, as follows:

Level License role

3 Analytics Administrator

2 Analytics Explorer

1 Analytics User

0 Analytics Viewer
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Level License role

-1 The license role is unknown because the user has
not logged in yet.

What to do next
For more information, see the following topics:

• Predefined license roles
• Assigning capabilities based on license roles
• Upgrade scenario: If your customized roles have the same names as the new license roles

License roles
To help you map capabilities to licensing requirements, Cognos Analytics also provides predefined roles
that are based on license entitlements.

Note: Another type of role is a standard role. Standard roles have specific capabilities that allow users to
perform different tasks. For more information, see “Standard roles” on page 4.

The following table lists the predefined license roles.

Table 74. Predefined Cognos license roles

License role Description

Analytics Administrator Members have the same access permissions as Analytics
Explorers. They can also access IBM Software Development Kit;
and components in the Manage menu, including IBM Cognos
Administration.

Analytics Explorer Members have the same access permissions as Analytics Users.
They can also access Exploration, Planning Analytics for Microsoft
Excel, Cognos Framework Manager, Cognos Cube Designer and
Dynamic Query Analyzer, Jupyter Notebook, and Transformer.

Analytics User Members can create new reports, dashboards, explorations, stories,
new jobs, data server/source connections, or data modules. They can
execute reports, respond to prompts, and upload files. They can also
access Cognos for Microsoft Office, Cognos Workspace, Cognos Event
Studio, Cognos Query Studio, and Cognos Analysis Studio.

Analytics Viewer Members can read public content. For example, they can subscribe
to reports and view dashboards and stories. However, members
cannot execute public content. Therefore, they cannot schedule
reports.

Default permissions based on licenses
In IBM Cognos Analytics, the licence counter in Manage > Licences is driven by the capabilities that are
granted to a user, group or role.

Note: If you make changes to the default permissions, a user can move up to a different licence than the
one that they were granted by default.

For information about how to restrict users based on their licence entitlements, see “Assigning
capabilities based on license roles” on page 184.
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The following table maps the capabilities that are granted for each license. Capabilities are divided into
secured features. A checkmark ( ) indicates that a permission is granted for a specific secured feature.
Capabilities marked as "Not Applicable" count as an Analytics Viewer Licence.

Table 75. Cognos Analytics 11.1 capabilities by license roles

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

Adaptive
Analytics

Not
Applicable

Administrati
on

Adaptive
Analytics
Administrati
on

Not
Applicable

Administrati
on tasks

Collaboratio
n
Administrati
on

Configure
and manage
the system

Controller
Administrati
on

You need a
separate IBM

Controller
Licence

Data Source
Connections

Distribution
Lists and
Contacts

Manage
Visualization
s

Metric Studio
Administrati
on

You need a
separate
Metrics
Licence

Mobile
Administrati
on
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Table 75. Cognos Analytics 11.1 capabilities by license roles (continued)

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

Planning
Administrati
on

You need a
separate IBM

Planning
Contributor

Licence

PowerPlay
Servers

You need a
separate

PowerPlay
license

Printers

Query
Service
Administrati
on

Run
Activities
and
Schedules

Set
Capabilities
and Manage
UI Profiles

Styles and
Portlets

Users,
Groups, and
Roles

AI

Learning

Use
Assistant

Analysis
Studio

 Attach
Outputs

Cognos
Analytics for
Mobile
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Table 75. Cognos Analytics 11.1 capabilities by license roles (continued)

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

Cognos
Insight

Not
Applicable

Cognos
Viewer

Context
Menu

Run with
Options

Selection

Toolbar

Collaborate You need
separate

entitlement
of IBM

Connections

Allow
collaboration
features

You need
separate

entitlement
of IBM

Connections

Launch
collaboration
tools

You need
separate

entitlement
of IBM

Connections

Controller
Studio

You need a
separate IBM
Controller
Licence

Dashboard

Create/Edit

Data
Manager

Not
Applicable

Data sets

Desktop
Tools
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Table 75. Cognos Analytics 11.1 capabilities by license roles (continued)

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

Detailed
Errors

Develop
Visualization
s

Drill Through
Assistant

 Email

Email
Delivery
Option

Include link
in email

Share using
email

Type in
external
email

Event Studio

Execute
Indexed
Search

Executive
Dashboard

Use
Advanced
Dashboard
Features

Use
Interactive
Dashboard
Features

Exploration

External
Repositories

Manage
Repository
Connections
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Table 75. Cognos Analytics 11.1 capabilities by license roles (continued)

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

View
External
Documents

Generate
CSV Output

Generate
PDF Output

Generate
XLS Output

Generate
XML Output

Glossary Integration
with IBM

InfoSphere
Business

glossary. Can
use directly
from Viewer

Hide Entries

Import
relational
metadata

Job

Lineage

Manage
content

Manage own
data source
signons

Metric Studio You need a
separate
Metrics
Licence

Edit View You need a
separate
Metrics
Licence

Mobile
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Table 75. Cognos Analytics 11.1 capabilities by license roles (continued)

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

Notebook IBM Cognos
Analytics for

Jupyter
Notebook

Server must
be installed

for Notebook
features to

be available

Planning
Contributor

You need
separate

entitlement
of IBM

Planning
Contributor

PowerPlay
Studio

You need a
separate

PowerPlay
license

Query Studio

Advanced

Create

Report
Studio

Allow
External
Data

Bursting

Create/
Delete

HTML Items
in Report

User Defined
SQL

Save to
Cloud

Manage
Connections
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Table 75. Cognos Analytics 11.1 capabilities by license roles (continued)

Capability Secured
feature

Analytics
Viewer

Analytics
User

Analytics
Explorer

Analytics
Administrat

or

Comments

Scheduling

Schedule by
Day

Schedule by
Hour

Schedule by
minute

Schedule by
month

Schedule by
trigger

Schedule by
week

Schedule by
year

Schedule by
Priority

Self Service
Package
Wizard

Set Entry-
Specific
Capabilities

Share Pin
Board

Snapshots

Specification
Execution

Upload files

Visualization
Alerts

Watch Rules

Web-based
modeling
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Assigning capabilities based on license roles
You can assign capabilities based on license role entitlements. This allows you to restrict users to perform
only the functions to which they are entitled.

You must perform the tasks in this order:

1.  Assign yourself to the System Administrators role

2.  Restrict access to members of the Cognos namespace

3.  Remove the Everyone group from the System Administrators role

4.  Assign users to their predefined roles

5.  Remove Analytics Viewer capabilities to match license requirements

6.  Grant Dashboard capabilities to specific roles and users (11.1.4 only)

For information about usage restrictions, see the
License Information Documents (http://www-03.ibm.com/software/sla/sladb.nsf/searchlis/?
searchview&searchorder=4&searchmax=0&query=(IBM+Cognos+Analytics+11.1) for your program.

1. Assign yourself to the System Administrators role:

As administrator, you must first ensure that your personal userid and any applicable administrative groups
are members of the System Administrators role.

Only after you have completed this task can you remove the Everyone group from the System
Administrators role.

Procedure

1. Log on to Cognos Analytics using the administrator userid and password.
2. Click Manage > People > Accounts.
3. Select the Cognos namespace.

4. Click the More icon  next to the System Administrators role and then click  View members.
5. Click Select.
6. Add your personal userid, and any applicable administrative groups, to the System Administrators

role.

2. Restrict access to members of the Cognos namespace:

You or the installer can configure access to Cognos Analytics so that only users who are members of any
group or role in the Cognos namespace can access the application.

Procedure

1. On each Content Manager computer, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click Authentication.
3. In the Properties window, change the value of Restrict access to members of the built-in

namespace to True.
4. From the File menu, click Save.

3. Remove the Everyone group from the System Administrators role:

Important: Ensure that you have assigned your userid to the System Administrators role before you
remove the Everyone group from the System Administrators role. Otherwise, that role will be locked out
and no one will be able to make any further administrative changes.

The Everyone group is a Cognos group that comprises every userid in the Cognos namespace. By
default, after installation the Everyone group is assigned to the System Administrators role. This initial

184  IBM Cognos Analytics Version 11.1: Managing User Guide

http://www-03.ibm.com/software/sla/sladb.nsf/searchlis/?searchview&searchorder=4&searchmax=0&query=(IBM+Cognos+Analytics+11.1)


configuration gives every user, even those who are not targeted as administrators, full access to all
capabilities.

Purpose

This task removes, from all users, all the capabilities that they were initially assigned from a default
installation. After completing this task, your next step will be to assign users and groups to their
predefined roles. Users will then have access only to the capabilities that they require for their own
role.

Procedure

1. Log on with your personal userid, which you previously assigned to the System Administrators role.
2. Click Manage > People > Accounts.
3. Select the Cognos namespace.

4. Click the More icon  next to the System Administrators role and then click  View members.

5. Click the Remove member icon  next to Everyone group and then click OK.

4. Assign users to their predefined roles:

You can now assign users and groups to their predefined roles. These roles are as follows:

• Analytics Explorers
• Analytics Users
• Analytics Viewers

About this task

By assigning each user to their predefined role, you are effectively granting them the capabilities that are
associated with their role. To see a matrix of the default capabilities that are available to each predefined
role, see “Default permissions based on licenses” on page 176.

Procedure

1. Log on as the System Administrator.
2. Click Manage > People > Accounts.
3. Select the Cognos namespace.

4. Click the More icon  next to the Analytics Explorers role and then click  View members.
5. Click Select.
6. Add the applicable users and groups as members of the Analytics Explorers role.
7. Repeat steps 4-6 for these roles:

• Analytics Users
• Analytics Viewer

5. Remove Analytics Viewer capabilities to match license requirements:

About this task

Certain capabilities count toward an Analytics User license that are not intended for Analytics Viewer
licensees. By default, however, these capabilities are granted to the Everyone group. In this task, you
narrow the list of users granted these capabilities to only those who are appropriately licensed. The
net effect is that the capabilities are removed from Analytics Viewer licensees, moving in line with their
license entitlements.

This task has two parts:

1. Add specific roles to each of these capabilities:

• Generate CSV Output
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• Generate PDF Output
• Generate XLS Output
• Generate XML Output
• Data sets

2. Remove the Everyone group from the capabilities listed above. As a result, only the roles that were
added in part 1 retain the capabilities.

Procedure

1. Log on as a System Administrator.
2. Click Manage > People > Capabilities.

3. Click the More icon  next to the Generate CSV Output capability and then click Customize access.

4. Click the Add member icon .
5. Click the Cognos namespace.
6. Press Ctrl-click to multi-select Analytics Users, Analytics Explorers, Authors, Modelers, and Report

Administrators.
7. Click Add and then click Close.
8. In the Permissions column, for each role you added, select Access.

9. Click the Remove member icon  next to the Everyone group and then click OK.
10. Repeat steps 3-9 for the remaining capabilities:

• Generate PDF Output
• Generate XLS Output
• Generate XML Output
• Data sets

11. Scroll to the External Repositories capability.

a. Click the More icon .
b. Click Customize access.

c. Click the Remove member icon  next to the Everyone group.
d. Click OK.

12. Scroll to the Snapshots capability.

a. Click the More icon .
b. Click Customize access.

c. Click the Remove member icon  next to the Everyone group.
d. Click OK.

6. Grant Dashboard capabilities to specific roles and users (11.1.4 only):

 In Cognos Analytics 11.1.4 only, you must customize the Dashboard capability and the Dashboard
> Create/Edit secured feature.

Procedure

1. Log on as a System Administrator.
2. Click Manage > People > Capabilities.
3. Scroll to the Dashboard capability.

a. Click the More icon .
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b. Click Customize access.

c. Click the Add member icon .
d. Click the Cognos namespace.
e. Select Analytics Viewer.
f. Click Add and then click Close.

g. In the Permissions column for Analytics Viewer, select Access.

4. Expand the Dashboard capability and then click the More icon  next to Create/Edit.

a. Click Customize access.

b. Click the Remove member icon  next to the Analytics Viewer role.

c. Click the Add member icon .
d. Navigate to your namespace, select the appropriate groups or users, and then click Add.

e. Click the Add member icon .
f. Navigate to the Cognos namespace.

g. Press Ctrl-click to multi-select Analytics Users, Analytics Explorers, Authors, Modelers, and
Report Administrators.

h. Click Add and then click Close.
i. In the Permissions column, for each user, group, and role that you added, select Access.

Upgrade scenario: If your customized roles have the same names as the
newer Cognos license roles

If you previously created roles with the same names as the newer Cognos license roles and you are
planning an upgrade, consider which capabilities you want to apply to the roles after you upgrade.

For more information, see “License roles” on page 176

• If you want to continue using capabilities that you previously assigned to those roles, you can perform
the upgrade without losing those capabilities.

• However, if you want to adopt the capabilities of the new license roles, you must first delete or rename
your existing roles before you upgrade.
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Chapter 8. Configuring collaboration platforms

You can configure Cognos Analytics so that users can send their content in  Slack or by  Email.

Tip: You can also customize this feature to restrict how people in selected roles are able to send content.
For more information, see “Example: Selectively disabling content sharing by email” on page 192.

For information, see "Sharing content" in the IBM Cognos Analytics Getting Started Guide.

Integrating with a collaboration platform
If your company uses the Slack* collaboration tool, you can integrate one or more Slack workspaces with
Cognos Analytics. Cognos Analytics users can then connect to the Slack workspaces to share messages
and Cognos Analytics content with other Slack users.

For information about the initial access permissions that are granted for administering collaboration,
see "Collaboration Administration" in the "Initial access permissions for capabilities" section of the IBM
Cognos Analytics Administration and Security Guide.

For information about how users can share their content, see the IBM Cognos Analytics Getting Started
Guide.

Note: Collaboration platforms in IBM Cognos Analytics are not created by, affiliated with, or supported by
Slack Technologies Incorporated.

Creating a Slack application
In Slack, create an application so that you can connect to Slack from within Cognos Analytics.

Before you begin
Your company must have a registered Slack account.

Procedure
1. Go to https://api.slack.com/apps
2. Sign into the slack account for your company.
3. Click Create New App.
4. In the Create a Slack App dialog, enter a name for your application, for example, type Cognos
Analytics, and select Development Slack Workspace.

5. Select the workspace that you signed in to.
6. Click Create App.

The Slack application is created
7. On the Slack API page, click the Basic information tab and scroll down to the App Credentials

section.
8. Make a note of both the Client ID and the Client Secret values. You will need them when configuring

Slack in Cognos Analytics.

Tip: Click the Show button in each field to see the values.
9. In the Features section, click OAuth & Permissions.

10. In the Redirect URLs section, add the following Redirect URL:

http://ca_servername:port/bi/v1/collaboration/auth/slack

where ca_servername:port is the fully qualified name and port number of your Cognos Analytics
server.

https://api.slack.com/apps


Tip: You can configure multiple redirect URLs. This allows you to use the same Slack application in
multiple Cognos Analytics environments, for example, "Dev", "Test", and "Prod".

11. Click Add.
12. Click Save URLs.
13. If you don't have administration access to your Slack workspace, follow these steps:

a) Go to the Scopes section and, in the Select Permission Scopes field, select Access your
workspace’s profile information users:read.

b) Click Save changes.
c) Scroll up to the OAuth Tokens & Redirect URLs section and click on Request approval.

After your request is approved by the Slack admin, you receive a message from slackbot indicating
that your request was approved. The Install app to workspace button appears in the OAuth &
Permissions section of your app.

d) Click Install app to workspace.
14. Confirm that your Slack workspace is working.

a) If not done already, install Slack on your computer.
b) Sign into your Slack app using the email account and password that you used to create the Slack

app.
c) Test your Slack workspace.

Tip: For information about setting up and using Slack, see the documentation available at
www.slack.com.

What to do next
You are now ready to “Adding a collaboration platform in Cognos Analytics” on page 190.

Adding a collaboration platform in Cognos Analytics
You can connect Cognos Analytics to a third party collaboration platform, such as Slack. This allows
Cognos Analytics users to share Cognos Analytics content with each other.

Before you begin
Before you configure collaboration in Cognos Analytics, you must create an application in Slack.

Procedure
1. Ensure that you have been assigned the Collaboration Administration capability.
2. Log on to Cognos Analytics.

3. In the Manage > Collaboration slide-out panel, click the Add collaboration platform icon .
4. Enter a name for the collaboration platform, for example, Cognos Analytics collaboration.
5. In the Settings tab, enter the following collaboration platform details :

• Client ID

Enter the Client ID that you noted when you created the Slack application.
• Client secret

Enter the Client Secret that you noted when you created the Slack application.
• Workspace URL

Enter the workspace URL that you registered with Slack, except for the .slack.com at the end.

6. Click the Add workspace icon .

7. Click  Test.
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8. If you are not authenticated already by the Slack workspace, a message may appear asking you to
sign in. Use your Slack credentials to sign in.

A message appears asking you to authorize access to the Slack application that you created.
9. Click Authorize.

10. Click Save.

Results
The collaboration platform is created. The platform name appears in the Manage > Collaboration slide-
out panel. To see its associated workspaces or to add additional ones, click the platform name and scroll
down in the slideout panel.

What to do next
If you want to disable your Collaboration platform for Cognos Analytics users, click the General tab and
then select the Disable this entry check box. Users will still see the Collaboration icon in the toolbar.
However, the platform name will be inactive and grayed out.

If you want to hide your Collaboration platform from Cognos Analytics users, click the General tab and
then select the Hide this entry check box.

Note: If users selected the Show hidden entries check box under My preferences > General tab, they
will see the collaboration platform name in grayed out text. If they did not select Show hidden entries,
they will not see the name.

If you click the name of the collaboration platform and then click the Permissions tab, you can control
the access that different users, roles, and groups have to the collaboration platform. You can assign one of
three values:

• Full - allows administrative access to the collaboration platform
• Read - allows users to send Slack messages via the collaboration platform
• Deny - hides the collaboration platform from the selected user, group, or role, preventing them from

using it to send messages
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Enabling content sharing by email
Configure a mail server to allow users to share Cognos Analytics content in an email.

Procedure
1. In the location where Content Manager is installed, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, click Notification.
3. In the Properties window, for the SMTP mail server property, type the host name and port of your

SMTP (outgoing) email server.

To be able to open content that is sent by email, you must change the host name portion of the
Gateway URI from localhost to either the IP address of the computer or the computer name.
Otherwise the URL in the email will contain localhost, and remote users will not be able to open
the content.

To be able to open content that is sent as links, ensure that the Gateway URI on report servers and
notification servers specifies an accessible web server hosting IBM Cognos content. If you have mobile
users accessing links remotely, consider using an external URI.

4. Click the Value box next to the Account and password property, and click the edit button when it
appears.

5. Type the values in the Value - Account and password dialog box, and click OK.

If logon credentials are not required for the SMTP server, remove the default information for the
Account and password property. When you are prompted for confirmation to leave this property
blank, click OK. Ensure that the default user name is removed. Otherwise, the default account is used
and notifications do not work properly.

6. In the Properties window, type the appropriate value for the default sender account.
7. In the Explorer window, right-click Notification, and click Test.

IBM Cognos Analytics tests the email server connection.

Results
Users can now select Email as a collaboration platform when they share their Cognos Analytics content.

Example: Selectively disabling content sharing by email
You can control precisely which scenarios allow Cognos Analytics content to be sent by email by
customizing 1. specific roles or 2. all roles.

In this example, you have enabled content sharing by email for all users. However, you now want to
prevent only people in the Analytics Users role from sending Cognos Analytics report or dashboard
content.

Tip: If you wanted to disable the sharing of content by email for everyone, you could customize the
feature for all roles.

Procedure
1. Log on as an administrator.
2. Go to Manage > People > Accounts, and click the Cognos namespace.

3. Click the More button  next to the Analytics Users role.
4. Click  Properties.
5. Click the Customization tab.
6. Disable email content sharing for both dashboard content and report content.

a) Click the chevron button  after Features.
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b) Click the chevron button  before Reporting to expand the list.

c) Click the chevron button  before Application bar to expand the list.

d) Click the chevron button  before  Share to expand the list.

e) Click the chevron button  before Send to expand the list.

f) Deselect the Email check box.

Tip: This action also deselects the Email check box for Dashboards, because email sharing is a
feature common to both dashboards and reports.

g) Click Apply.
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Chapter 9. Customizing Cognos Analytics across all
roles

The IBM Cognos Analytics user interface is built on an extensible model. In this model, the user interface
screens are defined as views (such as home, authoring, dashboard, and modeler). You can customize
these views for all users and roles by adding and removing user interface elements, such as buttons and
menus. You can define new views to extend the Cognos Analytics user interface. You can also replace the
default home page and sign-in page or substitute your own branding (colors, logos, and brand text) for the
default branding on all views.

Customizations are packaged as compressed files that contain a spec.json file that defines the
customization. The compressed file can also contain other files, depending on the type of the
customization. Customizations can also be included in deployments.

You manage customizations for all users and roles with the Manage > Customizations slide-out panel.
You use this panel to upload your customizations to the Cognos Analytics server, and to select which
customizations to use.

Note:

When you use the Manage > Customizations slide-out panel, your customizations are applied to all users
and roles.

For example, if you upload the sample extension called

SampleExtensionExcludeNotifications.zip, it will remove the Notifications icon  from the
Application Bar in the Home perspective for all users and roles. It will also remove the Notifications
check box from the feature list when an administrator selects the properties of any role, clicks on the
Customization tab, and navigates to Features > Home > Application bar.

Therefore, if your goal is to add or remove a feature for everyone in your Cognos environment, then you
should use an extension. If your goal is to provide users and roles with different features, you should use
individual role customization, rather than an extension.

If you use role customizations to set specific features for user roles and then apply an extension that is
based on those features, the extension will override all of your role customizations.

To assign home pages, features, themes, custom folders, and parameters to particular roles, use the
Manage > Accounts > Namespaces slide-out panel. For more information, see “Customizing roles” on
page 7.

To assign custom themes and home pages to particular tenants, use the Manage > Multitenacy slide-out
panel, and from the tenant properties panel, select the Customization tab. For more information, see
“Customizing tenants” on page 115.

Some types of customizations require the use of the JavaScript programming language. These
customizations are described in the following topics.

• “Creating a custom action controller” on page 207
• “Creating a view (other than a sign-in view)” on page 216
• “Creating a sign-in view” on page 218

The other types of customizations do not require any programming knowledge.

The JSON schemas that are used to define customizations are provisional and can change in future
releases of Cognos Analytics in a way that is not compatible with earlier versions.



Customization samples
Customization samples are available that demonstrate how to create themes, extensions, and views. You
can modify these samples to create your own customizations.

These sample files are installed with the product in an Easy Installation, and are an option in a Custom
Installation. After product installation, you can find them in the installation_location/samples/
folder.

The customization samples are described in the following topics.

• “Sample themes” on page 198
• “Sample extensions” on page 199
• “Sample views” on page 221

Using the samples
The customization samples illustrate how to implement commonly used customizations. You can view
the sample code and modify it to create customizations for your users. To examine the contents of a
customization sample, extract the .zip file. Each sample contains a spec.json file that contains the logic
for the customization. There can also be other files or folders that contain image files, JavaScript files, and
HTML files, depending on the customization.

To upload and use a sample theme or extension, follow the instructions in “Applying themes, extensions,
and views” on page 223.

Creating themes
You can override the standard IBM Cognos Analytics theme for the Cognos Analytics user interface to
reflect your corporate branding.

The sample customization, SampleTheme.zip, shows how to create a theme. The .zip archive contains a
file, spec.json, that defines the theme and a folder, images, that contains the graphic images that are
associated with this theme. Image file names cannot contain spaces.

Attention:

When you are using a sample theme, you cannot reset your password after it expires.

Your specific theme may consist of a folder such as "myTheme" that contains a .json file and
images folder (containing your graphics). When creating the zip file, do not include the folder
(e.g., "myTheme") in the zip file; Cognos Analytics will not be able to process it. Instead, select
the .json file and images folder, then use an archiving program to create the .zip file. Do not use
the Windows Explorer "send to compressed folder" feature to create the .zip file; the result would
be an incompatible file.

The spec.json file is shown here.

{
  "name": "Sample_Theme",
  "schemaVersion": "2.0",
  "brandText": "the Sample Outdoors Company",
  "brandTextSmall": "Sample Outdoors Company",
  "images": {
    "brandIcon": "images/logo_large.png",
    "brandIconSmall": "images/logo_small.png",
    "favicon": "images/logo_fav.png"
  },
  "colors": {
    "appbarBackground": "#eeeeee",
    "appbarForeground": "black",
    "appbarSelectLine": "#033f38",
    "appbarPushButtonBackground": "#c8d2d1",
    "navbarBackground": "#1c96d4",
    "navbarForeground": "white",
    "navbarSelectLine": "#033f38",
    "navbarPushButtonBackground": "#007670"
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  }
}

The current samples do not include the brandTextSmall and favicon elements. They are included
here for documentation purposes.

The objects in this file map to the Cognos Analytics user interface elements as shown here. If any theme
items are omitted from the theme, then the Cognos Analytics default theme item is used.

This table relates the user interface elements to the JSON objects.

Table 76. Theme objects

User interface
reference

JSON description Definition

1 brandText Brand text. Enter an empty string to
leave this entry blank.

2 brandTextSmall Small brand text. if omitted, brandText
is used. Enter an empty string to leave
this entry blank.

3 brandIcon Brand icon

4 brandIconSmall Small brand icon

5 appbarBackground Application bar background color

5 appbarForeground Application bar foreground color

5 appbarSelectLine Application bar selection line color
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Table 76. Theme objects (continued)

User interface
reference

JSON description Definition

5 appbarPushButtonBackground Application bar push-button background
color

6 navbarBackground Navigation bar background color

6 navbarForeground Navigation bar foreground color

6 navbarSelectLine Navigation bar selection line color

6 navbarPushButtonBackground Navigation bar push-button background
color

favicon Icon to display in web browser tab.

Sample themes
The following examples are available that illustrate the use of themes.

These samples are installed in the <installation_location>/samples/themes folder.

SampleTheme.zip
A theme that modifies the branding and color scheme for the Cognos Analytics user interface.

SampleThemeBlueGreen.zip
A theme that modifies the color scheme for the Cognos Analytics user interface.

SampleThemeDarkBlue.zip
A theme that modifies the color scheme for the Cognos Analytics user interface.

SampleThemeLight.zip
A theme that modifies the color scheme for the Cognos Analytics user interface.

Creating extensions
You can create extensions that add functions to the IBM Cognos Analytics user interface. For example,
you can add buttons that, when clicked, open a particular report or dashboard. You can also remove
default buttons from the user interface.

To create and upload extensions, you must have Portal Administrator or System Administrator privileges.

CAUTION: Be judicious when you assign Develop Visualizations access and ensure that you
review files that are being uploaded. People who are permitted to upload files may be able to
deliver malicious code.

Extensions are defined in a spec.json file that is contained in the root of the extension .zip file.
Depending on the extension, there can also be folders that include images, HTML files, and JavaScript
files. The structure and contents of the spec.json file is described in “spec.json description” on page
224. The high-level structure of the file is show here.

{
    "name":"...",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "features": [{
            "id": "...",
            "toolItems": [<tool_item1>,<tool_item2>,...],
            "collectionItems": [<collection_item1>,<collection_item2>,...],
            "excludeFeatures": [<exclude_feature1>,<exclude_feature2>,...],
            "excludeItems": [<exclude_item1>,<exclude_item2>,...]
        }]
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    }
}

The value of the perspective element indicates which views will use this extension. A value of common
means that the extension is used for all views. The items contained in the features array are used
depending on the action of the extension. These are illustrated in the following topics.

By creating extensions, you can modify existing views and create new views. The actions that an
extension can perform are listed here and are described in the following topics. A single extension can
perform one or more actions.

• Add a button to the Application or Navigation bars that performs an action such as displaying a web site,
running a report, or opening a dashboard, a story, or a folder.

• Add a menu item to an existing menu that performs an action such as displaying a web site, running a
report, or opening a dashboard, a story, or a folder.

• Add a menu along with its menu items.
• Remove a default user interface feature or item.
• Add custom shapes for use in dashboards.
• Add custom widgets for use in dashboards.

Sample extensions
The following examples are available that illustrate the use of extensions.

These sample files are installed with the product in an Easy Installation, and are an option in a Custom
Installation. After product installation, you can find them in the installation_location/samples/
extensions folder.

Note: The samples covered in this topic are included with the Base Samples during a Cognos Analytics
installation. After product installation, you can find them in the installation_location/samples/
extensions folder.

IBM will provide support if the asset does not work as described for the product version(s) identified.
However, we are unable to provide custom support for you such as adding features or troubleshooting
environmental issues. These will be logged in our system as future Feature requests. These assets are
functional examples. They are code samples with narrow requirements and a specific use case, providing
a baseline. They do not include every possible feature/interactivity or environment/configuration. You
can use these samples as-is (supported by IBM), or you can modify/extend these samples to suit your
business needs (not supported).

SampleExtensionButtonDashboard.zip
An extension that adds a button to open a dashboard in all views.

SampleExtensionButtonFolder.zip
An extension that adds a button to open a folder in all views.

SampleExtensionButtonOpenPerspective.zip
An extension that creates a custom view and adds a button ( ) to the navigation bar in all views that
opens the custom view.

SampleExtensionButtonReport.zip
An extension that adds a button to open a report in all views.

SampleExtensionButtonWebsite.zip
An extension that adds a button to open a website in all views.

SampleExtensionContextMenuItem.zip

An extension that adds a menu item ( ) to the pop-up menu for all report objects. When selected,
the menu item opens an alert that displays information about the report.

SampleExtensionCustomMedia.zip
An extension that adds custom images that can be used in dashboards.
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SampleExtensionCustomMediaAll.zip
An extension that adds custom images that can be used in both dashboards and reports.

SampleExtensionCustomShape.zip
An extension that adds custom shapes that can be used in dashboards.

SampleExtensionExcludeDelete.zip
An extension that removes the Delete button from all objects in all views.

SampleExtensionExcludeNotifications.zip
An extension that removes the Notifications button from all views.

SampleExtensionMenuQuicklinks.zip
An extension that adds a menu to all views.

SampleExtensionMenuUrlLinks.zip
An extension that demonstrates how to add a menu to the AppBar that contains two menu items that
open external URLs.

SampleExtensionOpenFolderShowHideParent.zip
An extension that shows the use of the skipAncestors option when opening a folder.

SampleExtensionsAll.zip
An extension that combines the SampleExtensionButtonDashboard.zip,
SampleExtensionButtonFolder.zip, SampleExtensionButtonWebsite.zip,
SampleExtensionButtonReport.zip, SampleExtensionContextMenuItem.zip,
SampleExtensionExcludeDelete.zip, SampleExtensionMenuQuicklinks.zip, and
SampleExtensionExcludeNotifications.zip extensions.

SampleExtensionTabs.zip
An extension that adds a collection of tabs to the home view that provide quick access to certain
reports and dashboards.
SampleExtensionHelpMenu.zip

An extension that adds a customized URL to the Help icon menu in the top Application Bar in all
perspectives.

Note: As of release 11.1.6, SampleExtensionHelpMenu.zip is no longer supported.

Using the tabs collection extension
This task shows you how to install and use the tabs collection extension.

About this task
The tabs collection extension emulates the portal pages available in older versions of IBM Cognos
Business Intelligence. This extension adds three buttons to the navigation bar as shown here.

Each button corresponds to a tab in a portal page. Click the Overview button to display a subfolder that
contains two items, the Product line by year dashboard, and the Quantity sold report. The subfolder is
equivalent to a subtab in a portal page.
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Click the Revenue button to display a subfolder that contains three items, the By year dashboard, the By
quarter folder that contains four reports, and the QTD report.

Click the Retailer button to open a dashboard.

Procedure
Upload the Samples_for_Install deployment archive. (If not already done.)
1. Use Manage > Administration console to open IBM Cognos Administration.
2. On the Configuration tab, click Content Administration.
3. On the toolbar, click the New Import button.
4. Select Samples_for_Install in the first step of the New Import wizard and complete the remaining

steps of the wizard.
Upload the SampleExtensionTabs.zip sample extension.
5. In the Manage > Customizations slide-out panel, select the Extensions tab, click Upload

extension( ), browse to the <installation_location>/samples/extensions folder, and
select SampleExtensionTabs.zip.

Results
You can now use this extension.

Modifying icons to appear against a light background
You can change the color of icons in the sample extensions to ensure that they contrast sufficiently
against the background color of your theme.

About this task
Many of the Cognos Analytics sample extensions contain icons that are designed to work with the default
theme, IBM Carbon X, which has a dark background. However, if you apply a theme without a dark
background, these icons become indiscernible.

Example

The extension SampleExtensionOpenDashboard_11_2.zip includes the icon dashboard.svg.
It has a light color, hexadecimal color code #f4f4f4, as shown next to the Line dashboard option in
the following diagram:
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If you apply a theme in which the background is a light color, you can no longer see the icon:
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To fix this issue, follow these steps:

Procedure
1. Download the extension.
2. Unzip the contents of the extension.
3. Modify the color of the image(s) in the images folder and save the changes.

For example, after you unzip the extension SampleExtensionOpenDashboard_11_2.zip, change
the color of the icon from a light color (#F4F4F4) to a dark color (#161616):

a. In the images folder, open the file dashboard.svg in a text editor.
b. Replace this text:

<style type="text/css"> .st0{fill:#F4F4F4;} .st1{fill:none;} </style>

with this text:

<style type="text/css"> .st0{fill:#161616;} .st1{fill:none;} </style>

c. Save the file.
4. Create a .zip file that contains all the files and folders.
5. Upload the revised extension.
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Results
The black icon is visible against the light background.

For more information, see these topics:

• Creating extensions
• Creating themes

Adding a button or a menu item
You can add buttons and menu items to perform various actions, such as displaying a web site, running a
report, opening a dashboard, a story, or a folder. You can also create custom actions.

All buttons require an action controller. There are four built-in action controllers that perform common
actions. These actions are shown here.

bi/glass/api/IFrameOpener
Opens a web page.

bi/glass/api/ReportOpener
Runs a report.

bi/glass/api/DashboardOpener
Opens a dashboard.

bi/glass/api/FolderOpener
Opens a folder.

You can also write custom action controllers using JavaScript.

The content of the json.spec file are similar for buttons and menu items and they are described
together. The main difference is that the value of the type element is button for a button and menuItem
for a menu item. Other differences are noted in the following topics.

Using built-in action controllers
There are four built-in action controllers available. These action controllers can open a web page, run a
report, open a folder, and open a dashboard or story. The action controllers are described in the following
sections.

Opening a web page
Use the bi/glass/api/IFrameOpener action controller to open a web page. The available options are
shown here.

url
Specifies the web page URL to open.

title
Specifies the web page title to display.

The SampleExtensionButtonWebsite.zip sample extension opens a web page. The spec.json file
is shown here.

{
    "name":"Sample_Button_Website",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "comment": "There is a special meta perspective called COMMON. Adding 
                 contributions to this perspective will cause the extension to be 
                 applied to All perspectives.",
        "features": [{
            "id": "sample.common.button.openWebsite",
            "toolItems": [
            {
                "comment": "This code will display a custom Website button that opens
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                                        the specified URL in an iFrame.",
                "id": "sample.iframeOpener.website",
                "containerId": "com.ibm.bi.glass.navbarTrailingGroup",
                "label": "Website",
                "type": "Button",
                "icon": "images/web.png",
                "weight": 100,
                "actionController": "bi/glass/api/IFrameOpener",
                "options": {
                    "url": "http://www.ibm.com/analytics/us/en/technology/products/cognos-
analytics/",
                    "title": "Website"
                }
            }
            ]
        }]
    }]}

The button label is Website and the button icon is the web.png image this is in the images folder.
The action controller is bi/glass/api/IFrameOpener and it requires two options, the web page URL
(url) and the web page title to display when the page is opened (title). The other elements in the
spec.json file are described in “spec.json description” on page 224.

Running a report
Use the bi/glass/api/ReportOpener action controller to run a report. The available options are
shown here. Either the id or the path must be specified.

id
Specifies the storeID of the report to run.

path
Specifies the path of the report to run.

The SampleExtensionButtonReport.zip sample extension runs a report. The spec.json file is
shown here.

{
    "name":"Sample_Button_Report",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "comment": "There is a special meta perspective called COMMON. Adding contributions
                 to this perspective will cause the extension to be applied to All 
                 perspectives.",
        "features": [{
            "id": "sample.common.button.openReport",
            "toolItems": [
            {
                "comment": "This adds a button to the navbar to directly open a popular 
report.",
                "id": "sample.report.opener",
                "containerId": "com.ibm.bi.glass.navbarLeadingGroup",
                "label": "QTD revenue",
                "type": "Button",
                "icon": "common-report",
                "weight": 800,
                "comment": "The greater the weight, the higher the item appears in the 
container.",
                "actionController": "bi/glass/api/ReportOpener",
                "options": {"path": ".public_folders/Samples/Extensions/QTD revenue"}
            }
            ]
        }]
    }]}

The action controller is bi/glass/api/ReportOpener and it requires one option, the path to the report
(path). .public_folders is the root folder for Team content and .my_folders is the root folder for
My content. If the report name contains a slash(/), it must be encoded as %2F. The other elements in the
spec.json file are described in “spec.json description” on page 224.
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Opening a dashboard or a story
Use the bi/glass/api/DashboardOpener action controller to open a dashboard or s story. The
available options are shown here. Either the id or the path must be specified.

id
Specifies the storeID of the dashboard or story to open.

path
Specifies the path of the dashboard or story to open.

The SampleExtensionButtonDashboard.zip sample extension opens a dashboard. The spec.json
file is shown here.

{
    "name":"Sample_Button_Dashboard",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "comment": "There is a special meta perspective called COMMON. Adding contributions
                to this perspective will cause the extension to be applied to 
                All perspectives.",
        "features": [{
            "id": "sample.common.button.openDashboard",
            "toolItems": [
            {
                "comment": "This code adds a button to directly open a core dashboard.",
                "id": "sample.dashboard.opener",
                "containerId": "com.ibm.bi.glass.navbarLeadingGroup",
                "label": "Line dashboard",
                "type": "Button",
                "icon": "common-dashboard",
                "weight": 900,
                "comment": "The greater the weight, the higher the item appears in the 
container.",
                "actionController": "bi/glass/api/DashboardOpener",
                "options": {"path": ".public_folders/Samples/Extensions/Line dashboard"}
            }
            ]
        }]
    }]}

The action controller is bi/glass/api/DashboardOpener and the only option is the path to the
dashboard (path) which is determined in the same way as the path to a report. The other elements in the
spec.json file are described in “spec.json description” on page 224.

Opening a folder
Use the bi/glass/api/FolderOpener action controller to open a folder. The available options are
shown here. Either the id or the path must be specified.

id
Specifies the storeID of the folder to open.

path
Specifies the path of the folder to open.

skipAncestors
Specifies whether ancestor folders should be displayed (false) or hidden (true) when the folder is
opened. The default value is false.

The SampleExtensionButtonFolder.zip sample extension opens a folder. The spec.json file is
shown here.

{
    "name":"Sample_Button_Folder",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "comment": "There is a special meta perspective called COMMON. Adding contributions
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                              to this perspective will cause the extension to be applied 
                              to All perspectives.",
        "features": [{
            "id": "sample.common.button.openFolder",
            "toolItems": [
            {
                "comment": "This code adds a button to easily access an important folder.",
                "id": "sample.folder.opener",
                "containerId": "com.ibm.bi.glass.navbarLeadingGroup",
                "label": "2016 reports",
                "type": "Button",
                "icon": "common-folder",
                "weight": 700,
                "push": "true",
                "comment": "The greater the weight, the higher the item appears in the 
container.",
                "actionController": "bi/glass/api/FolderOpener",
                "options": {"path": ".public_folders/Samples/Extensions"}
            }
            ]
        }]
    }]}

This example has the element "push": "true". This element is required when opening a folder
because a button to open a folder has two states, open and close. (This element is not used for a menu
item.) If you press the button again after opening a folder, the folder is closed. The action controller is
bi/glass/api/FolderOpener and the only option is the path to the folder (path) which is determined
in the same way as the path to a report. The other elements in the spec.json file are described in
“spec.json description” on page 224.

Creating a custom action controller
You can create custom action controllers to perform actions that are not available with the built-in action
controllers. Custom action controllers are written in JavaScript using the Asynchronous module definition
(AMD) API.

The SampleExtensionContextMenuItem.zip sample extension implements a custom action
controller that adds a menu item to the context menu for all report objects. The spec.json file is shown
here.

{
    "name":"Sample_Context_Menu_Item",
    "comment": "This extension will add a new menu item to the context menu for
               all report objects.",
    "comment": "The menu item will open an alert box that provides information
                       about the selected report.",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "comment": "There is a special meta perspective called COMMON. Adding contributions
             to this perspective will cause the extension to be applied to All perspectives.",
        "features": [{
            "id": "sample.home.context.item",
            "toolItems": [
            {
                "id": "custom.context.menu.item1",
                "containerId" : "com.ibm.bi.contentApps.listViewMenu",
                "comment": "The containerId is the ID of the parent menu.",
                "type": "MenuItem",
                "actionController": 
                  "v1/ext/Sample_Context_Menu_Item/js/controllers/SampleContextMenuItem",
                "label": "Sample menu item",
                "icon": "common-properties",
                "weight":950
            }
            ]
        }]
    }]}
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The custom action controller is the SampleContextMenuItem.js file and is located in the js/
controllers folder in the extension. The file is shown here.

/**
 * Licensed Materials - Property of IBM
 *
 * IBM Cognos Products: BI Glass
 *
 * Copyright IBM Corp. 2015
 *
 * US Government Users Restricted Rights - Use, duplication or disclosure restricted by
 GSA ADP Schedule Contract with IBM Corp.
 */
define([], function() {
    'use strict';

    var SampleAction = function(){
        
        /**
         * Called by the AppController whenever this view is created
         *
         * @public
         * @returns {Promise} promise resolved to the root DOM element for this view.
         */
        this.isVisible = function(context, target) {
            return target.options[0].type === 'report';
        },
        
        /**
         * Called by the AppController whenever this view is destroyed
         *
         * @public
         */
        this.execute = function(context, target) {
            var info = 'This sample menu item extension opens an alert.
                \nThe alert contains information about the selected report.
                \n\nType: ' + target.options[0].type + '\nName: ' + target.options[0].name
                + '\nID: ' + target.options[0].id;
            alert(info);
        }
        
        

    };

    return SampleAction;

});

This JavaScript code uses the Action API in a JavaScript AMD module. These modules require the
JavaScript Q library. The Action API consists of two methods.

void execute(context, target)
context

This object contains utility methods.
target

This object contains information about the button or menu item that is created by the extension.

• For a button or menu item in an Application bar or navigation bar menu, this object contains the
options property for the item.

• For a menu item in a contextual menu of an object, this object contains an array of the type,
name, and Store ID of the object.

boolean isVisible(context, target)
This method is only applicable to menu items. The menu item is displayed if this method returns
true; otherwise the menu item is hidden.
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Adding a menu
You can add a menu and its associated menu items to the Application or Navigation bars.

The SampleExtensionMenuQuicklinks.zip sample extension adds a menu and six menu items. Part
of the spec.json file is shown here.

{
    "name":"Sample_Menu_Quicklinks",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "common",
        "comment": "There is a special meta perspective called COMMON. Adding contributions
         to this perspective will cause the extension to be applied to All perspectives.",
        "features": [{
            "id": "sample.common.menu.openMulipleItems",
            "toolItems": [
            {
                "comment": "This code adds a custom menu item to the App Bar in the trailing 
group.",
                "id":"custom.appbar.trailingGroup.menu",
                "containerId": "com.ibm.bi.glass.appbarTrailingGroup",
                "type": "Menu",
                "label": "Quick links",
                "icon": "images/debug.svg",
                "weight": 650
            },
            {
                "comment": "This code adds a submenu item to the custom menu created above.",
                "id": "custom.appbar.trailingGroup.menuItem1",
                "containerId" : "custom.appbar.trailingGroup.menu",
                "comment": "The containerId is the ID of the parent menu.",
                "type": "MenuItem",
                "actionController": "v1/ext/Sample_Menu_Quicklinks/js/controllers/
SampleMenuQuicklinks",
                "comment": "The actionController determines the actions for the menu item.",
                "label": "Home",
                "icon": "common-home",
                "weight":900
            },
            {
                "comment": "This code adds a submenu item to the custom menu created above.",
                "id": "custom.appbar.trailingGroup.menuItem2",
                "containerId" : "custom.appbar.trailingGroup.menu",
                "comment": "The containerId is the ID of the parent menu.",
                "label": "Line dashboard",
                "type": "MenuItem",
                "icon": "common-dashboard",
                "weight":800,
                "actionController": "bi/glass/api/DashboardOpener",
                "comment": "The actionController determines the actions for the menu item.",
                "options": {"path": ".public_folders/Samples/Extensions/Line dashboard"}
            },...            
            ]
        }]
    }]}

In this example, the menu is located in the Application bar trailing group.

Removing a user interface element
You can remove default user elements from all or specified views.

The SampleExtensionExcludeNotifications.zip sample extension removes the Notifications
button from the Navigation bar. The spec.json file is shown here.

{
    "name":"Sample_Exclude_Notifications",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "home",
        "comment": "This code will apply only to the HOME perspective.",
        "features": [{
            "id": "sample.home.exclude.notifications",
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            "excludeItems":["com.ibm.bi.share.notifications"],
            "comment": "Above, EXCLUDEITEMS will remove the Notifications button from the
                      Nav Bar of the HOME perspective.",
            "comment": "EXCLUDEITEMS must be applied at the individual perspective level.
                     It can not be used globally via the COMMON perspective."
        }]
    }]}

Adding dashboard shapes
You can create custom shapes for use in dashboards.

The SampleExtensionCustomShape.zip sample creates three new shapes for use in dashboards.
This sample is installed like any other extension. After it is installed, the following three new shapes
appear in the Shapes panel.

Note: Only .svg files can be used as dashboard shapes.

The contents of the spec.json file are shown here.

{
    "name":"Sample_Custom_Shape",
    "comment":"This sample will add 3 custom images to the bottom of the Shape panel in 
Dashboarding.",
    "schemaVersion": "2.0",
    "extensions": [
    {
        "perspective": "dashboard",
        "comment": "The custom shapes are for the dashboard perspective only.",
        "features": [
        {
            "id": "com.ibm.bi.dashboard",
            "collectionItems": [
            {
                "containerId": "com.ibm.bi.dashboard.shapes",
                "id": "sample_custom_shape_music",
                "name": "Music",
                "options":{
                    "templatePath": "v1/ext/Sample_Custom_Shape/images/music_32.svg"
                }
            },
            {
                "containerId": "com.ibm.bi.dashboard.shapes",
                "id": "sample_custom_shape_relationship",
                "name": "Relationship",
                "options":{
                    "templatePath": "v1/ext/Sample_Custom_Shape/images/relationship_32.svg"
                }
            },
            {
                "containerId": "com.ibm.bi.dashboard.shapes",
                "id": "sample_custom_shape_traffic",
                "name": "Traffic",
                "options":{
                    "templatePath": "v1/ext/Sample_Custom_Shape/images/traffic_32.svg"
                }
            }
        ]
        }
        ]
    }]
}

The custom shapes are contained in the images folder of the sample.
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Uploading custom images
You can add your own custom images to Cognos Analytics for use in dashboards, stories, and reports.

The SampleExtensionCustomMedia.zip (dashboards and stories only) and
SampleExtensionCustomMediaAll.zip (reports, dashboards, and stories) samples provide a way
to add new images for use in Cognos objects. These samples are installed like any other extension.

After you upload these extensions, you can select images as follows:

• Dashboard and Stories: After either of the above extensions are installed, dashboard and story authors
can select their custom images in the Widgets panel. For more information, see the Dashboards and
Stories guide.

• Reporting: After the SampleExtensionCustomMediaAll.zip extension is installed, report authors

can select the Toolbox icon , select Layout, drag the Image object  to the report, and then
double-click it. For more information, see the Reporting guide.

The images available in the image library have the following descriptions:

• Lightning strike above a city at night
• Lightning in a dark purple sky
• Heavy traffic in a city at night
• Hiker on a hill in the forest
• Several tents on a mountain
• Graph with increasing revenue highlighted
• Graph of increasing revenue
• Group of people in a Call Center

Sample_Custom_Media
The contents of the spec.json file for Sample_Custom_Media is shown here.

{
    "name": "Sample_Custom_Media",
    "comment":"This sample extension will add seven custom images to the the Widgets panel in 
Dashboarding and Stories.",
    "comment":"We currently only support the addition of JPG and PNG files.",
    "schemaVersion": "1.0",
    "extensions": [{
        "perspective": "dashboard",
        "comment": "The custom images are for the DASHBOARD perspective only.",
        "features": [{
            "id": "com.ibm.bi.common.media",
            "comment": "This is the ID for the MEDIA panel. It will be the container for the 
images below.",
            "collectionItems": [{
                "containerId": "com.ibm.bi.common.media",
                 "id": "customImage1",
                 "name": "Lightning above city",
           "comment": "The NAME is the text of the tooltip for the image.",
                 "options": {
                     "altText": "Lightning strike above a city at night.",
            "comment": "The ALTTEXT is shown as a Property for the selected image.",
                     "imageLink": "v1/ext/Sample_Custom_Media/images/SE_background.jpg"
                     }
                 }, {
                 "containerId": "com.ibm.bi.common.media",
                 "id": "customImage2",
                 "name": "Lightning in sky",
                 "options": {
                     "altText": "Lightning in a dark purple sky.",
                     "imageLink": "v1/ext/Sample_Custom_Media/images/weather_background3.jpg"
                     }
                 }, {
                 "containerId": "com.ibm.bi.common.media",
                 "id": "customImage3",
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                 "name": "Night city traffic",
                 "options": {
                      "altText": "Heavy traffic in a city at night.",
                      "imageLink": "v1/ext/Sample_Custom_Media/images/
story_scene1_background.jpg"
                       }
                  }, {
                  "containerId": "com.ibm.bi.common.media",
                  "id": "customImage4",
                  "name": "Hiker on hill",
                  "options": {
                       "altText": "Hiker on a hill in the forrest.",
                       "imageLink": "v1/ext/Sample_Custom_Media/images/login_background.jpg"
                       }
                  }, {
                  "containerId": "com.ibm.bi.common.media",
                  "id": "customImage5",
                  "name": "Tents on mountain",
                  "options": {
                       "altText": "Several tents on a mountain.",
                       "imageLink": "v1/ext/Sample_Custom_Media/images/welcome_background.jpg"
                       }
                   }, {
                   "containerId": "com.ibm.bi.common.media",
                   "id": "customImage6",
                   "name": "Increasing revenue highlighted",
                   "options": {
                        "altText": "Graph with increasing revenue highlighted.",
                        "imageLink": "v1/ext/Sample_Custom_Media/images/
story_scene5_background2.jpg"
                        }
                   }, {
                   "containerId": "com.ibm.bi.common.media",
                   "id": "customImage7",
                   "name": "Increasing revenue",
                   "options": {
                        "altText": "Graph of increasing revenue.",
                        "imageLink": "v1/ext/Sample_Custom_Media/images/
story_scene5_background.jpg"
                        }
                    }]
                }]
        }]
}

Sample_Custom_Media_All
The contents of the spec.json file for Sample_Custom_Media_All is shown here.

{
    "name": "Sample_Custom_Media_All",
    "comment":"This sample extension will add eight custom images to the Widgets panel in 
Dashboarding and Stories.",
    "comment":"It will also add the same eight custom images to the IMAGE PICKER dialog in 
Reporting.",
    "comment":"Only JPG and PNG files are supported at this time.",
    "comment":"These types of extensions are not additive. You must specify all of the custom 
images you require in one extension.",
    "comment":"Otherwise, the last uploaded extension (not UPDATED) will take precedence and 
become your final library of images.",
    "schemaVersion": "1.0",
    "extensions": [{
            "perspective": "common",
            "comment": "The custom images will apply to all perspectives - reporting, 
dashboarding, and stories.",
            "features": [{
                    "id": "com.ibm.bi.common.media",
                    "comment": "This is the ID for the Widgets panel. It will be the container 
for the images below.",
                    "collectionItems": [{
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage1",
                            "name": "Lightning above city",
                            "comment": "The NAME is the text of the tooltip for the image 
within the Image Library tab.",
                            "options": {
                                "altText": "Lightning strike above a city at night.",
                                "comment": "The ALTTEXT is shown in the Description Property 
for the selected image once it is placed on the dashboard.",
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                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
SE_background.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage2",
                            "name": "Lightning in sky",
                            "options": {
                                "altText": "Lightning in a dark purple sky.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
weather_background3.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage3",
                            "name": "Night city traffic",
                            "options": {
                                "altText": "Heavy traffic in a city at night.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
story_scene1_background.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage4",
                            "name": "Hiker on hill",
                            "options": {
                                "altText": "Backpacker on a hill in the forest.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
login_background.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage5",
                            "name": "Tents on mountain",
                            "options": {
                                "altText": "Several tents on a mountain.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
welcome_background.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage6",
                            "name": "Call center",
                            "options": {
                                "altText": "Group of people in a Call Center.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
call_center.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage7",
                            "name": "Increasing revenue highlighted",
                            "options": {
                                "altText": "Graph with increasing revenue highlighted.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
story_scene5_background2.jpg"
                            }
                        }, {
                            "containerId": "com.ibm.bi.common.media",
                            "id": "customImage8",
                            "name": "Increasing revenue",
                            "options": {
                                "altText": "Graph of increasing revenue.",
                                "imageLink": "v1/ext/Sample_Custom_Media_All/images/
story_scene5_background.jpg"
                            }
                        }
                    ]
                }
            ]
        }
    ]
}
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Adding a dashboard widget
You can create custom widgets for use in dashboards.

You can create custom widgets for use in dashboards. Custom widgets are installed in the same way as
other extensions. The widget action is determined by a JavaScript file that can execute any JavaScript
actions and displays the results in the widget.

A simple custom widget contains a spec.json file, a JavaScript file, and a folder that contains images
that are used by the widget. The spec.json file is shown here.

{
    "name":"SampleWidgetExt_old",
    "schemaVersion": "1.0",
    "extensions": [
    {
        "perspective": "dashboard",
        "comment": "Sample custom widgets for dashboard",
        "features": [{
            "id": "com.ibm.bi.dashboard.widgets",
            "collectionItems": [{
                "containerId": "com.ibm.bi.dashboard.widgets",
                "id": "Hello",
                "title": "Hello!",
                "iconUrl": "v1/ext/SampleWidgetExt/images/ibm.png",
                "widget": "v1/ext/SampleWidgetExt/helloParam.js",
                "scroll": "scrollNone",
                "disableTitle": true,
                "params" : {
                    "name": "IBM"
                }
            }]
        }]
    }]
}

This widget calls the helloParam.js JavaScript file, which is shown here.

define([
    'jquery',
    'dashboard/widgets/CustomWidget'
], function( $, Base) {

    var Widget = Base.extend({
        onInit: function(params) {
            this.name = params.name;
        },
        onRender: function() {
            var root = this.getContentRootNode();
            $(root).append('<h1 class="titleColor titleFontSize">Hello ' + this.name + '!</
h1>');
        }
    });
    
    return Widget;
});

The images folder contains the ibm.png graphic image.

After the extension is installed, users who create a dashboard will see a new icon, Custom widgets( ).

After they click Custom widgets( ), they can drag the custom widget onto the dashboard canvas. The
custom widget is shown here.
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Perspective
A perspective is a specific view within the product.

For example, when you are creating a dashboard object, you are in the dashboard perspective.

All of the sample extensions contain a perspective element in their spec.json file. The value of the
perspective element indicates which views will use this extension. A value of common means that the
extension is used for all views.

The current perspective is found in the URL in your browser:

http://myserver:9300/bi/?perspective=dashboard&id=iC2094F0D0...

Perspective examples

• Home: occurs when viewing the Home page.
• Content: occurs when viewing the Content page (e.g., navigating My Content, Team Content, or

Samples)
• Dashboard: occurs when viewing or editing a dashboard.
• Authoring: occurs when viewing or editing a report.
• Story: occurs when viewing or editing a story.
• Explore: occurs when viewing/editing an exploration.
• Ca-modeller : occurs when viewing/editing a data module.
• CreateBoard : occurs on the first screen of dashboard creation, when choosing a template

Creating views
The IBM Cognos Analytics user interface consists of views, such as home, sign-in, authoring, dashboard,
and modeling. You can create custom views to augment the built-in views.

Views are defined in a spec.json file that is contained in the root of the view .zip file. Custom views
also include an HTML div element that replaces the central pane of the Cognos Analytics user interface.
Custom views can also add or remove menus and buttons from the Application and Navigation bars,
or remove one or both of these bars altogether. The structure and contents of the spec.json file is
described in “spec.json description” on page 224. The high-level structure of the file is show here.

{
    "name": "<name>",
    "schemaVersion": "2.0",
    "extensions": [{
        "perspective":"<view_name>",
        "type":"<home_or_login>",
        "excludeCommon": true,
        "features": [{
            "id": "<id>",
            "toolItems": [<tool_item1>,<tool_item2>,...],
            "content": {
                "type":"<path_to_javascript_file>",
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                "options": {
                    ...
                    }
                }
            },
            "cssStyles": [
                "<path_to_css_file>"
                ]
        }]
    }]
}

Views are packaged as extensions and a view .zip file can contain extension elements as well. For
example, the SampleExtensionButtonOpenPerspective.zip sample defines a custom view and
also adds a button to the Navigation bar of the home view that displays the custom view.

The content element contains the path to, and the name of, the JavaScript file that runs in order to
create the custom view. The options element contains any options required by the JavaScript file. The
JavaScript files uses the Asynchronous module definition (AMD) API.

A special type of view is a sign-in view. This type of view allows you to create a custom sign-in page for
Cognos Analytics. The value of the type element determines if a view is a sign-in view (value is login) or
not (value is home).

Unlike extensions, views have to be explicitly invoked in order for them to open. There are three ways to
invoke a view.

• A button or menu item can be defined to open the view.
• The view can be opened by using a URL as follows.

http://<server>:<port>/bi/?perspective=<view_name>

• The view can be set to be the default home view for a user or for a role, or for all users. For more
information, see “Applying themes, extensions, and views” on page 223.

Creating a view (other than a sign-in view)
The SampleWelcome.zip sample is an example of a view that replaces the built-in home view with an
alternate version that includes branding for the Sample Outdoors Company.

The SampleWelcome.zip sample contains a spec.json file that defines the view. This file is shown
here.

{
  "name": "Sample_Welcome",
  "schemaVersion": "2.0",
  "extensions": [{
    "perspective":"Sample welcome",
    "type":"home",
    "features": [{
      "id": "com.sample.welcome",
      "excludeItems": ["com.ibm.bi.glass.common.cognosLogo"],
      "toolItems": [{
        "id": "brandLogoHomePage",
        "containerId" : "com.ibm.bi.glass.appbarLeadingGroup",
        "type": "bi/glass/app/plugins/GlassPlugin",
        "class": "cognosIcon cognosLogo",
        "label":"theme.current.brandTextSmall",
        "icon": "theme.current.images.brandIconSmall",
        "weight": 995
        }],
      "content": {
        "type":"v1/ext/Sample_Welcome/js/views/SampleWelcomeView",
        "options": {
          "info":{
            "title":"Sample welcome",
            "icon":"v1/ext/Sample_Welcome/images/bee_blue.svg"
          }
        }
      },
      "cssStyles": [
        "v1/ext/Sample_Welcome/css/SampleWelcomeCSS.css"
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        ]
    }]
  }]
}

The view is referred to as Sample welcome in the managing customization panels. The spec.json file
links to a SampleWelcomeView.js file in the js/views subfolder of the view. The "type":"home"
entry indicates this view can be set to be the default home view. The cssStyles element defines the .css
file used when displaying the view.

The SampleWelcomeView.js file is shown here.

/**
 * Licensed Materials - Property of IBM
 *
 * IBM Cognos Products: BI Glass
 *
 * Copyright IBM Corp. 2015
 *
 * US Government Users Restricted Rights - Use, duplication or disclosure restricted 
 * by GSA ADP Schedule Contract with IBM Corp.
 */
define(['q',
  'text!./SampleWelcomeView.html',
  ], function(Q, html) {
  'use strict';

  var ContentView = function(){
    
    /**
     * Called by the AppController whenever this view is created
     *
     * @public
     * @returns {Promise} promise resolved to the root DOM element for this view.
     */
    this.open = function(context, options) {
      this.logger = context.logger;
      this.options = options;
      var deferred = Q.defer();
        
      var root = document.createElement('div');
      root.setAttribute('class','welcome');
      
      root.innerHTML = html;
      deferred.resolve(root);
      return deferred.promise;
    };
    
    /**
     * Called by the AppController whenever this view is destroyed
     *
     * @public
     */
    this.close = function() {
      this.logger.info('close');
    };
    
    /**
     * Called by the AppController whenever this view is shown
     *
     * @public
     */
    this.onShow = function() {
      this.logger.info('onShow');
    };
    
    /**
     * Called by the AppController whenever this view is hidden
     *
     * @public
     */
    this.onHide = function() {
      this.logger.info('onHide');
    };
    
    /**
     * Called by the AppController whenever display Info is required for this view
     *
     * @public
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     * @returns {Object} displayInfo - The displayInfo for this view.
     * @returns {string} displayInfo.title - The title.
     * @returns {string} displayInfo.icon - The icon.
     */
    this.getDisplayInfo = function() {
      this.logger.info('getDisplayInfo');
      return {
        'title':this.options.info.title,
        'icon': this.options.info.icon
      };
    };

  };

  return ContentView;

});

This file refers to the SampleWelcomeView.html that is displayed when the view is invoked.

This JavaScript code uses the View API in a JavaScript AMD module. This implementation uses the
JavaScript Q library. The View API consists of the following methods. methods.

promise open(content. options)
This method is invoked when the view is opened. It returns a Q promise object with the DOM
element that represents the view as the resolved value.
context

Contains the context object.
options

Contains the options included in the spec.json file.
void close()

Invoked just before closing the view.
void onShow()

Invoked just before showing the view.
void onHide()

Invoked just before hiding the view.
getDisplayInfo()

Returns the title and associated icon of the view.

Creating a sign-in view
With a custom sign-in view, you can replace the default IBM Cognos Analytics sign-in page. You can use
your own branding and make other changes to the sign-in page.

A high-level overview of the structure of the JavaScript required to perform a sign-in is shown here.

The SampleLogin.zip sample is an example of a view that replace the built-in sign-in view with an
alternate version. The SampleWelcome.zip sample contains a spec.json file that defines the view.
This file is shown here.

{
    "name": "Sample_Login",
    "schemaVersion": "2.0",
    "extensions": [{
        "perspective":"sampleLogin",
        "type": "login",
        "excludeCommon": true,
        "features": [{
            "id": "com.sample.login",
            "toolItems": [],
            "content": {
                "type":"v1/ext/Sample_Login/login/js/views/SampleLoginView",
                "options": {
                    "info":{
                            "title":"Sample login"
                            }
                }
            },
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            "cssStyles": ["v1/ext/Sample_Login/login/css/SampleLoginCSS.css"]
        }]
    }]
}

This spec.json file is similar to the same file for the SampleWelcome.zip sample except that the value
of the type element is login and the Application and Navigation bars are excluded from this view.

A high-level overview of the structure of the JavaScript required to perform a sign-in is shown here.

   /**
   * @typedef {Object} LoginError
   * @property {string} message - error message
   */
   /**
   * performs a login
   *
   * @public
   * @param {Object[]} loginPrompts - object containing the login prompts
   * @param {string} loginPrompts[].name - name of the login prompt
   * @param {string} loginPrompts[].value - value of the login prompt
   * @return {Promise<undefined|LoginError} promise resolved with no object when 
   * the login is successful, rejected with an error when it fails.
   *
   */
   signin: function(loginPrompts)

The SampleLoginView.js file is shown here.

/**
 * Licensed Materials - Property of IBM
 * IBM Cognos Products: BI Glass
 * Copyright IBM Corp. 2017
 * US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP 
Schedule Contract with IBM Corp.
 */
define(['q',
    'text!./SampleLoginView.html',
    ], function(Q, html) {
    'use strict';

    var ContentView = function(){
        
        /**
         * Called by the AppController whenever this view is created
         *
         * @public
         * @returns {Promise} promise resolved to the root DOM element for this view.
         */
        this.open = function(context, options) {
            this.logger = context.logger;
            this.options = options;
            var deferred = Q.defer();
                
            var root = document.createElement('div');
            root.setAttribute('class','welcome');
            
            root.innerHTML = html;
            
            var loginBtn = root.getElementsByClassName('sample.loginBtn')[0];
            loginBtn.onclick = function() {
                document.getElementsByClassName('sampleIncorrectLoginText')[0].innerHTML='';
                var uid = document.getElementsByClassName('sample.username')[0].value;
                var pwd = document.getElementsByClassName('sample.password')[0].value;
                var loginPrompts = [
                    {name:'CAMNamespace',value:'CognosEx'},
                    {name:'h_CAM_action',value:'logonAs'},
                    {name:'CAMUsername',value:uid},
                    {name:'CAMPassword',value:pwd}
                ];
                this.signin(loginPrompts).catch(this._loginError.bind(this));
            }.bind(this);

            deferred.resolve(root);
            return deferred.promise;
        },
        
        /**
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         * Called by the AppController whenever this view is destroyed
         *
         * @public
         */
        this.close = function() {
            this.logger.info('close');
        },
        
        /**
         * Called by the AppController whenever this view is shown
         *
         * @public
         */
        this.onShow = function() {
            this.logger.info('onShow');
        },
        
        /**
         *
         * The live code below retreives the product's error message.
         * If you would like to include your own error message, use the following commented 
code instead:
         *
         * this._loginError = function() {
         *      document.getElementsByClassName('sampleIncorrectLoginText')[0].innerHTML='You 
have entered an invalid username/password combination.';
         *     this.logger.error('loginError',arguments);
         *   },
         *
         *
         */
        this._loginError = function(error) {
            document.getElementsByClassName('sampleIncorrectLoginText')
[0].innerHTML=error.message;
            this.logger.error('loginError',arguments);
        },
        
        /**
         * Called by the AppController whenever this view is hidden
         *
         * @public
         */
        this.onHide = function() {
            this.logger.info('onHide');
        },
        
        /**
         * Called by the AppController whenever display Info is required for this view
         *
         * @public
         * @returns {Object} displayInfo - The displayInfo for this view.
         * @returns {string} displayInfo.title - The title.
         * @returns {string} displayInfo.icon - The icon.
         */
        this.getDisplayInfo = function() {
            this.logger.info('getDisplayInfo');
            return {
                'title':this.options.info.title,
                'icon': this.options.info.icon
            };            
        }

    };

    return ContentView;

});

A sign-in view uses one additional method.

promise login(credentials)
This method submits a sign-in request and returns a promise object that is rejected if the sign-in
attempt fails.
credentials

Contains the sign-in information.

[{name:'CAMNamespace',value:'<namespace>'},
{name:'h_CAM_action',value:'logonAs'},
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{name:'CAMUsername',value:<username>},
{name:'CAMPassword',value:<password>}]

Creating a sign-in view with a namespace prompt
Using a custom sign-in view with a namespace prompt, you can replace the default IBM Cognos Analytics
sign-in page. You can specify that the user must select from a list of namespaces when signing in. You can
also use your own branding and make other changes to the sign-in page.

A high-level overview of the structure of the JavaScript required to perform a sign-in is shown here.

The SampleLoginMultiple.zip sample is an example of a view that replace the built-in sign-in view
with an alternate version. The SampleLoginMultiple.zip sample contains a spec.json file that
defines the view. This file is shown here.

{
    "name": "Sample_Login_Multiple",
    "schemaVersion": "2.0",
    "extensions": [{
        "perspective":"sampleLoginMultiple",
        "type": "login",
        "excludeCommon": true,
        "features": [{
            "id": "com.sample.login.multiple",
            "toolItems": [],
            "content": {
                "type":"v1/ext/Sample_Login_Multiple/login/js/views/SampleLoginView",
                "options": {
                    "info":{
                            "title":"Sample login namespaces"
                            }
                }
            },
            "cssStyles": ["v1/ext/Sample_Login_Multiple/login/css/SampleLoginCSS.css"]
        }]
    }]
}

This spec.json file is similar to the same file for the SampleLogin.zip sample in that the Application
and Navigation bars are excluded from this view.

Sample views
The following examples are available that illustrate the use of views.

These sample files are installed with the product in an Easy Installation, and are an option in a Custom
Installation. After product installation, you can find them in the installation_location/samples/
extensions folder.

SampleLogin.zip
A replacement view for the Cognos Analytics sign-in page.

SampleLoginMultiple.zip
A replacement view for the Cognos Analytics sign-in page that prompts the user for a namespace.

SampleWelcome.zip
A replacement view for the Cognos Analytics welcome page.

Using the customized welcome view
This task shows you how to install and use the custom welcome view.

Procedure
Upload the Samples_for_Install deployment archive. (If not already done.)
1. Use Manage > Administration console to open IBM Cognos Administration.
2. On the Configuration tab, click Content Administration.
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3. On the toolbar, click the New Import button.
4. Select Samples_for_Install in the first step of the New Import wizard and complete the remaining

steps of the wizard.
Upload the sample extensions.
5. In the Manage > Customizations slide-out panel, select the Extensions tab, click Upload

extension( ), browse to the <installation_location>/samples/extensions folder, and
select SampleWelcome.zip.

6. Repeat the preceding step for SampleExtensionsAll.zip.
7. In your web browser, type <webserver_name>:<port_number>/bi/?
perspective=sampleWelcome to view the customized welcome view.

Results
The customized welcome view is shown here. It has a new menu (Quick links) on the application bar
and new buttons on the navigation bar (Line dashboard, QTD revenue, 2016 reports, and Website). The
Notifications button on the navigation bar is removed. The main screen has a new image, new text, and a
link to a video.

Using the customized sign-in view
This task shows you how to install and use the custom sign-in view.

Procedure
1. Extract the files in SampleLogin.zip.
2. Edit login/js/views/SampleLoginView.js and locate the line that contains
{name:'CAMNamespace',value:'CognosEx'}.

3. Replace CognosEx with the name of one of your authentication namespaces (as defined in IBM
Cognos Configuration).

4. Save SampleLoginView.js and re-create the .zip file.
5. In the Manage > Customizations slide-out panel, select the Extensions tab, click Upload

extension( ), browse to the <installation_location>/samples/extensions folder, and
select SampleLogin.zip.

6. On the Views tab, click  next to the default sign-in view. Select the Sample login view as the default
sign-in view.

7. Sign out of IBM Cognos Analytics.
8. Access your Cognos Analytics server.
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Results
The customized sign-in view is shown here. It has a customized background and new text in the sign-in
dialog box.

Applying themes, extensions, and views
You manage themes, extensions, and views with the Managing > Customization slide-out panel. You can
upload, delete, and modify themes, extensions, and views. You can also set a default theme for all users,
and set default home and sign-in views.

The Managing > Customization slide-out panel has four tabs, Themes, Extensions, Views, and
Parameters. You upload themes on the Themes tab, and you upload extensions and views on the
Extensions tab.

Uploading themes

To upload a theme, on the Themes tab, click Upload theme ( ) and browse to the theme in the file
system. The theme is uploaded and validated. If the theme is invalid, an error message is displayed.

Otherwise, the theme is added to the list of available themes. You can click More ( ) next to a theme, to
update, delete, or download the theme.

Tip: If you apply a theme to a distributed environment, wait at least five minutes for it to take effect.

Setting a default theme
You can select a theme to be the default theme for all users. On the Themes tab of the Managing >
Customization slide-out panel, select the check box next to a theme, and them click Apply.
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You can also set default themes for roles in the Manage > Accounts slide-out panel. If a user has a
role which has a default theme, that theme is used instead of the theme selected for all users. For more
information, see “Customizing roles” on page 7.

Uploading extensions and views

To upload an extension or a view, on the Extensions tab, click Upload extension( ) and browse to the
extension or view in the file system. The extension or view is uploaded and validated. If the extension is
invalid, an error message is displayed. Otherwise, the extension is added to the list of uploaded themes.

You can click More ( ) next to an extension or view to update, delete, or download the extension or view.

Setting a default home view

On the Views tab of the Managing > Customization slide-out panel, click  next to the default home
view. You can now browse for a dashboard or report to be the default home view, or you can select a view
in the list of home views to be the default home view for all users.

You can also set default home views for roles in the Manage > Accounts slide-out panel. If a user has a
role which has a default home view, that view is used instead of the home view selected for all users. For
more information, see “Customizing roles” on page 7.

A user can also select a personal default home view from any view. In any view, a user can click More
( ), and then click Set as home to define a personal default home view. This default home view takes
precedence over default home views created for roles or all users.

Setting a default sign-in view

On the Views tab of the Managing > Customization slide-out panel, click  next to the default sign-in
view. You can now select a view in the list of sign-in views to be the default sign-in view for all users.

Running Cognos Analytics with customized extensions and views disabled
If an uploaded extension or view contains errors, it can render IBM Cognos Analytics unusable. In this
case, you can run Cognos Analytics with customized extensions and views disabled.

Procedure
Start Cognos Analytics by typing the URL <webserver_name>:<port_number>/bi/?
factoryMode=true.

Results
Cognos Analytics starts with all extensions disabled. You can now correct or delete your customized
extensions or views before you restart Cognos Analytics with the standard URL.

spec.json description
The spec.json file in an extension defines the additions and deletions the extension makes to the
default IBM Cognos Analytics user interface. The structure and contents of this file are explained here.

The structure and contents that are described here are provisional. They can change in future releases of
Cognos Analytics. These changes may not be backward compatible.

name
Specifies the name of the extension. The name can contain alphanumeric characters, underscores (_),
and spaces ( ).

224  IBM Cognos Analytics Version 11.1: Managing User Guide



schemaVersion
Specifies a numeric value for the schema version. Can be 1.0 or 2.0. The default value is 1.0.

extensions
Contains an array of perspective objects.
perspective

Specifies the view that is being extended. The options are the following.
common

Applies to all views.
<view_name>

Applies to the <view_name> view, which can be a built-in view (home, authoring,
dashboard, or modeller) or an uploaded view.

type
If the extension is a view, specifies the type. The possible values are login for a sign-in view
and home for a home view. This element is only used in schema version 2.0. If it is omitted and
schema version 2.0 is specified, then the view is not included in the list of possible default home
or sign-in views.

excludeCommon
Specifies whether view contributions are received from the /common folder. The possible
values are false to receive all contributions or true to receive no contributions. Any missing
contributions can be added to the extension.

lensable
If false, this view is not included in the list of views for which features can be omitted. For more
information, see “Customizing roles” on page 7.

The default value is true.

comment
An optional comment.

features
Contains an array of feature groupings.
id

Specifies the unique identifier of the feature.
toolItems

Contains an array of user interface elements that are being added.
id

The unique identifier for the new user interface element.
containerId

Specifies the placement of the user interface element.

• If the user interface element is a menu or a button, the element is located in the
application or navigation bars as shown in the following graphic.
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The values of containerId corresponding to the button or menu placement are shown
in the following list.

1. com.ibm.bi.glass.navbarLeadingGroup
2. com.ibm.bi.glass.navbarTrailingGroup
3. com.ibm.bi.glass.appbarLeadingGroup
4. com.ibm.bi.glass.appbarCenterGroup
5. com.ibm.bi.glass.appbarTrailingGroup

• If the user interface element is a menu item, the value of containerId is the id of the
menu that contains the menu item.

label
Specifies the text label for the user interface element. This text cannot be localized.

type
Specifies the user interface element type. The possible values are shown here.

• Button
• Menu
• MenuItem

icon
Specifies the user interface element image to be displayed. The path is relative to the
image file in the extension zip archive.

weight
Specifies a numeric value that determines the placement of the user interface element in
the container. A higher value moves up the element in the container.

push
Specifies whether when the button is pressed a second time, the action of the first press is
undone. For example, opening and then closing a folder. The value can be true or false.
The value must be true for a button that opens a folder.

coachMark
Specifies a coach mark.
title

Specifies the title of the coach mark.
contents

Specifies the contents of the coach mark.
actionController

Specifies the action to be taken when the user interface element is clicked. The available
actions are listed here.
bi/glass/api/IFrameOpener

Opens a web page.
bi/glass/api/ReportOpener

Opens a particular report.
bi/glass/api/DashboardOpener

Opens a particular dashboard.
bi/glass/api/FolderOpener

Opens a particular folder.
v1/ext/<name>/js/controllers/controller_name

Runs the custom controller that is packaged in the extension. The controller is the file
js/controllers/controller_name.js.
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options
Contains an array of options to pass to the action controller. The options vary depending on
which action controller is used. For the options used by the built-in action controllers, see
“Using built-in action controllers” on page 204.

collectionItems
Contains an array of user interface elements that are being added.
containerId

Specifies where the user interface element is located.
id

Specifies the unique identifier of the user interface element.
content

Contains definitions for a view.
type

Contains a link to the JavaScript file to run when this view is invoked.
options

Contains parameters to be passed to the JavaScript file.
cssStyles

Contains an array of links to .css files to be used for this view.
excludeFeatures

Contains an array of ids of user interface features to exclude. This feature cannot be applied to
the common view.

excludeItems
Contains an array of ids of user interface items to exclude. This feature cannot be applied to
the common view.

JSON schema validation
When you upload a spec.json file, it is validated against the following schema.

{
  "type": "object",
  "definitions": {
    "extType": {
      "type": "string",
      "minLength": 1,
      "pattern": "^v1/ext/.+$"
    },
    "noEmptyString": {
      "type": "string",
      "minLength": 1
    },
    "toolItem": {
      "type": "object",
      "properties": {
        "id": {
          "$ref": "#/definitions/noEmptyString"
        },
        "title": {
          "type": "string"
        },
        "type": {
          "$ref": "#/definitions/noEmptyString"
        },
        "actionController": {
          "$ref": "#/definitions/noEmptyString"
        },
        "label": {
          "$ref": "#/definitions/noEmptyString"
        },
        "containerId": {
          "$ref": "#/definitions/noEmptyString"
        },
        "icon": {
          "type": "string"
        },
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        "weight": {
          "type": "number"
        },
        "class": {
          "type": "string"
        },
        "comment": {
          "type": "string"
        },
        "options": {
          "type": "object"
        },
        "push": {
          "type": "string",
          "enum": [
            "true",
            "false"
          ]
        },
        "coachMark": {
          "type": "object",
          "properties": {
            "title": {
              "type": "string"
            },
            "contents": {
              "type": "string"
            }
          },
          "additionalProperties": false,
          "required": [
            "title"
          ]
        },
        "lensable": {
          "type": "boolean"
        }
      },
      "required": [
        "id"
      ]
    },
    "collectionItem": {
      "type": "object",
      "properties": {
        "id": {
          "$ref": "#/definitions/noEmptyString"
        },
        "containerId": {
          "$ref": "#/definitions/noEmptyString"
        },
        "label": {
          "$ref": "#/definitions/noEmptyString"
        },
        "lensable": {
          "type": "boolean"
        }
      },
      "required": [
        "id",
        "containerId"
      ]
    },
    "collectionContainerItem": {
      "type": "object",
      "properties": {
        "id": {
          "$ref": "#/definitions/noEmptyString"
        },
        "label": {
          "$ref": "#/definitions/noEmptyString"
        },
        "lensable": {
          "type": "boolean"
        }
      },
      "required": [
        "id"
      ]
    },
    "collectionContainer": {
      "type": "object",
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      "properties": {
        "id": {
          "$ref": "#/definitions/noEmptyString"
        },
        "items": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/collectionContainerItem"
          }
        },
        "lensable": {
          "type": "boolean"
        }
      },
      "additionalProperties": false,
      "required": [
        "id"
      ]
    },
    "feature": {
      "type": "object",
      "properties": {
        "id": {
          "$ref": "#/definitions/noEmptyString"
        },
        "excludeItems": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/noEmptyString"
          }
        },
        "excludeFeatures": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/noEmptyString"
          }
        },
        "toolItems": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/toolItem"
          }
        },
        "content": {
          "type": "object",
          "properties": {
            "type": {
              "$ref": "#/definitions/extType"
            },
            "options": {
              "type": "object"
            }
          },
          "additionalProperties": false,
          "required": [
            "type"
          ]
        },
        "cssStyles": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/extType"
          }
        },
        "collectionItems": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/collectionItem"
          }
        },
        "collectionContainers": {
          "type": "array",
          "items": {
            "$ref": "#/definitions/collectionContainer"
          }
        },
        "comment": {
          "type": "string"
        },
        "lensable": {
          "type": "boolean"
        }
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      },
      "additionalProperties": false,
      "required": [
        "id"
      ]
    },
    "extension": {
      "type": "object",
      "properties": {
        "perspective": {
          "$ref": "#/definitions/noEmptyString"
        },
        "features": {
          "type": "array",
          "minItems": 1,
          "items": {
            "$ref": "#/definitions/feature"
          }
        },
        "type": {
          "type": "string",
          "enum": [
            "home",
            "login"
          ]
        },
        "excludeCommon": {
          "type": "string",
          "enum": [
            "true",
            "false"
          ]
        },
        "lensable": {
          "type": "boolean",
          "default": true
        },
        "comment": {
          "type": "string"
        }
      },
      "additionalProperties": false
    }
  },
  "properties": {
    "schemaVersion": {
      "type": "string",
      "enum": [
        "1.0",
        "2.0"
      ]
    },
    "name": {
      "type": "string",
      "pattern": "[a-zA-Z0-9_ ]+$"
    },
    "extensions": {
      "type": "array",
      "minItems": 1,
      "items": {
        "$ref": "#/definitions/extension"
      }
    },
    "comment": {
      "type": "string"
    }
  },
  "additionalProperties": false,
  "required": [
    "name",
    "extensions"
  ]
}
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Creating a global color palette
 Administrators can create global color palettes that are available to report, dashboard, and story

authors.

About this task
You can create the following types of color palettes:
Categories

Used for visualizations that support discrete colors, like a bar or pie chart.
Continuous

Used for visualizations that support color transitions, like a map or a heat map.

Some visualizations support both types of color palettes. For example, if you drop a measure on to
the color slot of a bar chart, you can add a color gradient to the bars for that measure. The following
visualizations support both types of color palettes:

• Bar, floating bar, stacked bar
• Floating column, stacked column
• Bubble, packed bubble, hierarchical packed bubble
• Marimekko
• Radial
• Scatter plot
• Tree map

Color palettes are grouped into the following categories:
Custom

Created by a user (report, dashboard, or story author). Available only to the user who created them.
For more information about custom palettes, see Creating a color palette in the Dashboards and
Stories Guide.

Global
Created by the system administrator. A global palette is available to all users but only an administrator
can modify it. A user can duplicate a global palette and then modify the duplicated version.

System
Default palettes available in IBM Cognos Analytics. A system palette can't be changed but a user can
duplicate it and then modify the duplicated version.

Procedure
1. Click Manage > Customization, and then select the Palettes tab.

2. Click Create a custom palette .

The Create categorical color palette window opens.

3. To create a continuous color palette, click Continuous palette .
4. Enter a name for your palette.
5. Click the Grid or Wheel tab.

In the Grid tab, you can select colors from a grid of color swatches. In the Wheel tab, you can select
a color by doing one of the following things:

• Clicking the color wheel
• Typing the color in HSB (hue, saturation, brightness) or RGB (red, green, blue) notation
• Typing the color in hex code

6. Under Color guide, click Automatic or Custom.
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Categorical color palette
Contains a set of swatches. In Automatic, when you select a color from the grid or wheel, all
swatches in the palette are filled with colors that are related to the color you selected, starting
from the currently selected swatch. In Custom, you must select each swatch and then select a
color for it.

Continuous color palette
Contains one continuous swatch. In Custom, when you select a color from the grid or wheel, the
swatch is filled with the color you selected. The color gradually increases in intensity from one
end of the swatch to the other. Automatic is not available for a continuous color palette.

7. To undo a selection, click Remove swatch .

8. To add more swatches to the palette, click Add swatch .

9. To reverse the colors in the palette, click Reverse palette .
10. Click Save when you are finished.

Results
The color palette appears under Global and is available to all report, dashboard, and story authors.

Managing User Profiles
A user profile defines the portal tabs that the user can access and specifies user preferences, such as the
product language, preferred output format of reports, and the style used in the user interface.

A user profile is created when the user logs on to IBM Cognos software for the first time. It can also be
created by an administrator. Initially, the profile is based on the default user profile.

Users can view and change the preferences associated with their profile.

To copy, edit, or delete user profiles, an administrator must have write permissions for the namespace
that contains the applicable users. The IBM Cognos predefined role, Directory Administrators, does not
have write permissions for namespaces other than the Cognos namespace. System Administrators must
grant write permissions to Directory Administrators so that they can administer user profiles for the
namespace.

For more information, see Chapter 1, “Managing people,” on page 1..

Edit the default user profile
The default user profile is defined in the Cognos namespace. It contains settings that apply to all new
users. You can edit the default user profile for your users to minimize the number of changes you need to
make to individual user profiles.

After you change the default user profile, it applies only to users who log on to IBM Cognos software for
the first time. The existing user profiles of other users are not affected.

Procedure

1. Click Manage > Customization, and then select the Profiles tab.
2. Update any settings in the Regional options section that you want to change.

3.  To change the default location for uploaded files, click  next to Default upload location.

Tip: By default, uploaded files are saved in My content. When the upload was initiated from a specific
folder in Team content or My conten, the files can be saved to that folder.

If you specify a new shared location in Team content for uploaded files at the role, tenant, or global
level, users can save the uploaded files to this new default location.

4. If you want to change the permissions of the default user profile:
a) Click Permissions > Edit.
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b) Click  or  to add or remove users, groups, or roles to the default user profile.

c) Click  for a user, group, or role and then select Read, Run, Write, or Full, as necessary.
5. Click Apply.

Results
Each user who logs on to IBM Cognos software for the first time will automatically inherit these settings
but can change them later.

Viewing or changing a user profile
You can view or change a user profile.

About this task
You can delete specific items in the user's profile. This may be useful in the following situations:

• The user's content is taking up so much space that performance is affected. You want to delete some or
all of the content.

• You want to view a user profile before deleting it to ensure that you do not delete any important content.

If a user was deleted in your authentication provider, the user no longer appears in IBM Cognos software
and you cannot change the user profile.

You can only see the profiles of users who logged on at least once. When users log on, a date is displayed
in the Modified column.

To view a user profile, delete content, or change content, you must have traverse permissions for the user
account and any folder containing content owned by the user. You must have write permissions for the
entry and the parent of the entry that you want to delete.

You can change the user profile for individual users, but not for groups or roles.

Procedure
1. Click Manage > People, and then select Accounts.
2. Click the namespace that contains the user.
3. Click the name of the user whose preferences you want to view or change.
4. Click the General, Personal, or Permissions tabs to view or change the settings.
5. Click away from the slide-out panel to exit.

The slide-out panel closes. If you made changes, the message username was edited. appears.

Deleting a user profile
You can delete user profiles from the content store.

When deleting a user in your authentication provider, you may first want to delete the user profile from the
content store so that it no longer uses storage space.

You should delete the user profile from IBM Cognos software before deleting the user in the associated
namespace. After the user is deleted, the user information no longer appears in IBM Cognos software and
you cannot manage the user profile in IBM Cognos Analytics.

If the user account was already deleted from the associated namespace, you can use content store
maintenance to find, and optionally remove, all associated user account information from IBM Cognos
software.

If a user with a deleted user profile logs on, an account is created using defaults. If a user is logged on
while the associated user profile is being deleted, the user's passport expires and the logon page appears.
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Before you delete a user profile, you may want to view its contents to ensure that you are not deleting
anything important.

You can work only with profiles of users who logged on at least once.

Before you begin
To delete a user profile, you must have write permissions for the parent object.

Procedure
1. Click Manage > People, and then select Accounts.
2. Click the namespace that contains the user.
3. Find the user whose user profile you want to delete. You can use the Search feature to find a user. For

more information, see “Finding users, groups, and roles” on page 18.

4. Click the More icon  next to the user's name and then select  Delete profile.
5. Click OK to confirm you want to delete the user's profile.

Results
When the user next logs on, they will be assigned the current default user profile. They can later modify
their own profile.their profile if they wish.

Copying user profiles
You may want to copy a user profile.

Copying a user profile is useful in the following situations:

• A user changes names and you are setting up an account in the new name.
• A user moves to another namespace or your organization changes namespaces and you must set up

new accounts.
• You are creating many new similar user accounts.

If you plan to delete the source user in your authentication provider, copy the user account information
before you delete it. After you delete the user, the user no longer appears in IBM Cognos software and you
cannot copy the user's account information.

You can only work with profiles of users who have logged in at least once. When users log on, a date is
displayed in the Modified column and the user name changes into a link.

Before you begin
To copy user profiles, you must have write permissions for the namespaces for both the source and target
users.

Tip: When you copy a user profile, trusted credentials are not copied.

Procedure
1. Click Manage > People, and then select Accounts.
2. Click the namespace that contains the user.
3. Find the source user whose user profile you want to copy. You can use the Search feature to find a

user. For more information, see “Finding users, groups, and roles” on page 18.

4. Click the More icon  next to the user's name and then select  Copy user profile.
5. Select the settings that you want to copy:
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• regional settings and view options
• all content in the user's My content folder
• any portal pages that the user may have migrated from a old version of Cognos Business

Intelligence.

Tip: For information about enabling My portal pages, see “Configuring appearance” on page 75.
6. Specify whether you want the user profile of the source user to be deleted after you finish copying it

to other users.
7. Click Next.
8. Select one or more target users who you want to receive the copied user profile and then click Add.

Tip: To select multiple users, hold down the Ctrl key while you click each user's name.
9. If you want, on the Summary page, change any settings, including the source and target users.

10. Click Apply.

Setting global parameters
Administrators can set global parameters that can be used across reports by all roles.

Note: You can also set default report parameters for specific roles in theManage > Accountsslide-out
panel. If a user has a role with customized parameters, when they run any report with those parameters,
they will see the default values that you set. For more information, see “Customizing roles” on page 7.

Procedure
1. Go to Manage > Customization, and select the Parameters tab.
2. Depending on the version of Cognos Analytics, perform one of the following steps:

• In version 11.1.4 and later, click the New link, and type the parameter name in the space provided.
Press Enter on the keyboard.

• In version 11.1.3 and earlier, click the Import link, and import the parameter from your report,
located in either My content or Team content.

3. From the parameter context menu , click Properties.
4. Specify a custom label for the parameter. To specify a language-specific label, next to Languages, click

Set. You can also add a description of the parameter, or disable it.
5.  Select the Applied to all roles check box.

When you select this property, all system and tenant user roles can use this parameter.

Tip: If you are a Cognos Analytics on-premises user, and want to customize this parameter for specific
roles, don't select the Applied to all roles check box. Instead, proceed to step 6.

6. Customize the parameter for specific roles in the following way:
a) In Manage > People, select the Accounts tab.
b) Locate the role for which you want to customize this parameter, and in the role Properties panel,

select the Customization tab.
c) Next to Parameters, click Settings.
d) Select the check box next to the parameter that you specified in step 2.

Click OK to finish setting this parameter without changing the default value. To set a specific value,
select the Set values link, change the value, and then click Apply.

e) If needed, repeat steps b to d for other roles. The parameter values that you select can be different
for different roles.

7. Log out, and log back in.
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Results
Report authors can use the My parameters  pane to tailor reports according to their role and to
maintain consistency across reports.

Setting the _as_of_date global parameter
You can set up the global parameter _as_of_date, and make it available to all system and tenant roles.
The on-premises administrators can customize this parameter for specific user roles.

Procedure
1. Go to Manage > Customization, and select the Parameters tab.
2. Depending on the version of Cognos Analytics, perform one of the following steps:

• In version 11.1.4 and later, click the New link, and type _as_of_date in the space provided. Press
Enter on the keyboard.

• In version 11.1.3 and earlier, click the Import link, and import the _as_of_date parameter from the
sample "Global parameter date picker" report. This report is located in Team content > Samples >
Relative dates > Tools.

3. From the _as_of_date parameter context menu , click Properties.
4. Specify a custom label for the parameter. To specify a language-specific label, next to Languages, click

Set. You can also add a description of the parameter, or disable it.
5.  Select the Applied to all roles checkbox.

When you select this property, all system and tenant user roles can use this parameter.

If you are a Cognos Analytics on-premises user, and want to customize this parameter for specific
roles, don't select the Applied to all roles checkbox. Instead, proceed to step 6.

6. Customize the as_of_date parameter for specific roles in the following way:
a) In Manage > People, select the Accounts tab.
b) Locate the role for which you want to customize this parameter, and in the role Properties panel,

select the Customization tab.
c) Next to Parameters, click Settings.
d) Select the checkbox next to the _as_of_date parameter that you specified in step 2.

Click OK to finish setting this parameter without changing the default date, which is the current
date. To set a specific date, select the Set values link, select the date, and click Apply.

e) If needed, repeat steps b to d for other roles. The date that you select can be different for different
roles.

7. Log out, and log back in.

Results
All users in the system or tenant can now see the My Parameters dialog box, and the _as_of_date
parameter is available to users when they run reports or dashboards that include the relative date
filters and measures. The users can customize this parameter for their needs. For more information, see
"Customizing the reference date" in the Cognos Analytics Modeling Guide.
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Chapter 10. Managing cloud storage
 You can configure Cognos Analytics to connect to a cloud storage service that is offered by a third

party company. Cognos Analytics users can then save their reports to the cloud.

To manage cloud storage, you must be assigned the Manage connections secured function, which is
associated with the Save to Cloud capability. For more information, see “Save to Cloud” on page 134.

Cloud storage at a glance 
Cloud storage, also known as Cloud Object Storage (COS), is a technology that companies offer as a
service to other companies or applications.

First, as the administrator, you create an instance of a storage service with a Cloud Object Storage
provider.

Second, you configure a storage connection in Cognos Analytics that is integrated with the Cloud Object
Storage service.

The integration of Cognos Analytics servers and a Cloud Object Storage server is shown in this diagram:

Client computerCloud Object 
Storage server

Cognos Analytics 
servers

On-premises networkThe cloud

Creating a connection with a Cloud Object Storage provider
Create a connection with a Cloud Object Storage provider to establish a storage service that you can then
integrate with Cognos Analytics.

This is the first stage in enabling the save to cloud feature in Cognos Analytics.

Client computerCloud Object 
Storage server

Cognos Analytics 
servers

On-premises networkThe cloud

Choose the company that you want as your Cloud Object Storage provider:

• IBM
• Amazon
• MinIO
• Google



Creating an IBM storage connection
Create a connection to an IBM Cloud Object Storage (COS) service so that Cognos Analytics users can
save their reports on the cloud.

For an overview of the IBM COS service, see About IBM Cloud Object Storage (https://cloud.ibm.com/
docs/cloud-object-storage?topic=cloud-object-storage-about-cloud-object-storage).

Step 1: Create an IBM Cloud Platform account
Create an IBM Cloud Platform account (https://cloud.ibm.com/docs/services/cloud-object-storage/
basics?topic=cloud-object-storage-provision#provision-account).

Step 2: Create a COS service instance
Create a service instance (https://cloud.ibm.com/docs/services/cloud-object-storage/basics?
topic=cloud-object-storage-provision#provision-instance).

Tips for Cognos Analytics administrators:

• Initially, a COS service instance has no service credentials. Before you can configure Cognos Analytics to
connect to your Cloud Object Storage service, you must assign it a service credential.

Step 3: Create your service credentials
Create your COS service credentials (https://cloud.ibm.com/docs/services/cloud-object-storage?
topic=cloud-object-storage-service-credentials).

Tips for Cognos Analytics administrators:

• Make a note of the values of the COS properties listed in the following table. You will need these values
later when you configure Cognos Analytics to connect to this IBM Cloud Object Storage connection.

Table 77. IBM COS access key and secret access key

Property in IBM COS service credentials Related property when you configure Cognos
Analytics

apikey Access Key ID

resource_instance_id Secret access key

Step 4: Create a bucket
Create some buckets to store your data (https://cloud.ibm.com/docs/cloud-object-storage?topic=cloud-
object-storage-getting-started-cloud-object-storage) .

Tips for Cognos Analytics administrators:

• Choose a predefined, standard bucket
• When you create a bucket you select a Resiliency value, for example: Regional, and then a Location

value, for example: eu-gb.

Important:

Make a note of the Location value. You must select this same value later when you configure Cognos
Analytics to add a location to your connection.
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Creating an Amazon storage connection
Create a connection to an Amazon Simple Storage Service (S3) so that Cognos Analytics users can save
their reports on the cloud.

For an overview of Amazon Simple Storage Service (S3), see Amazon S3 Basics on the Amazon Web
Services (AWS) web site (https://docs.aws.amazon.com/AmazonS3/latest/gsg/AmazonS3Basics.html).

Step 1: Create an AWS account
Create an Amazon Web Services (AWS) account on the AWS web site (https://portal.aws.amazon.com/
billing/signup#/start).

Step 2: Create an Amazon S3 service
Create an Amazon Simple Storage Service (S3) on the AWS web site (https://docs.aws.amazon.com/
AmazonS3/latest/gsg/SigningUpforS3.html).

Step 3: Create your service credentials
Create a new access key and secret access key (https://docs.aws.amazon.com/general/latest/gr/
managing-aws-access-keys.html#create-aws-access-key) as part of your service credentials.

Tips for Cognos Analytics administrators:

• Even if you already have an access key, you must create a new one so that you can also record your
secret access key.

• Make a note of the values of the AWS properties listed in the following table. You will need these values
later when you configure Cognos Analytics to connect to this IBM Cloud Object Storage connection.

Table 78. AWS access key and secret access key

Property in Amazon Web Services (AWS)
Management Console

Related property when you configure Cognos
Analytics

AWSAccessKeyId Access Key ID

AWSSecretKey Secret access key

Step 4: Create a bucket
Create a Bucket on the AWS web site (https://docs.aws.amazon.com/AmazonS3/latest/gsg/
CreatingABucket.html).

Tips for Cognos Analytics administrators:

• Choose a predefined, standard bucket.
• When you create a bucket you select a region, for example: Asia Pacific (Tokyo).

Important:

Make a note of the region. You must select this same value later when you configure Cognos Analytics to
add a location to your connection.

Creating a MinIO storage connection
Create a connection to a MinIO Storage environment so that Cognos Analytics users can save their reports
on the cloud.

For an overview of MinIO Object Storage server , see MinIO. (https://www.ibm.com/support/
knowledgecenter/SSBS6K_3.1.2/manage_cluster/minio.html).
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Step 1: Install MinIO
Install MinIO (https://docs.min.io/docs/minio-quickstart-guide).

Step 2: Run MinIO
Note: For details. see the MinIO Quickstart Guide (https://docs.min.io/docs/minio-quickstart-guide.html).

Example of retrieving MinIO parameters

In this example, we install MinIO on Windows and note the values that are required to configure Cognos
Analytics:

1. Install MinIO server on a Windows computer.
2. Create a folder C:\my_data_folder.
3. In a command line window, cd to the directory where you installed MinIO server.
4. Type minio.exe server C:\my_data_folder.

A list of parameters for your MinIO instance appears in the command window.
5. To configure Cognos Analytics later, make a note of these parameters:

• Access key
• Secret access key
• Endpoint

Tip: You will use these values to create a MinIO storage connection in Cognos Analytics.

Step 3: Create a bucket
Example

1. Enter the MinIO endpoint URL that you noted previously in a browser window.

The MinIO browser appears.
2. Enter the access key and secret access key that you noted previously.
3. Follow the instructions to create a bucket.

Creating a Google Cloud Platform storage connection
Create a connection to a Google Cloud Platform (GCP) S3 storage connection so that Cognos Analytics
users can save their reports on the cloud.

For more information about GCP storage connections, see Cloud Storage Overview (https://
cloud.google.com/storage/docs).

Step 1: Create a Google Cloud Platform account
1. Go to the Google Cloud Platform page (https://console.cloud.google.com).
2. Follow the instructions to create a GCP account.

Step 2: Create a project
1. Go to the Project selector page (https://console.cloud.google.com/projectselector2)
2. Click CREATE PROJECT.
3. Enter a project name and then click CREATE.
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Step 3: Create a storage service account
1. In the Navigation menu, select Storage to go to your Storage browser page (https://

console.cloud.google.com/storage/browser)
2. .Click Enable Billing, if you haven't already enabled billing.
3. Click CREATE SERVICE ACCOUNT.

a. Enter a service account name and description.

Note: The Service account ID field is populated automatically.
b. Click CREATE.
c. Grant the service account access to your project.
d. Grant users access to the service account.
e. Click DONE.

Step 4: Create an HMAC key
Create an HMAC key for your service account.

1. In the Google Cloud console, go to the Cloud Storage Buckets page.
2. Click Settings.
3. Select the Interoperability tab.
4. In the Request endpoint section, copy and save in a text file the value in the Storage URI field.

Note: You will use this value when you create the storage connection in Cognos Analytics.
5. Click + Create a key for a service account.
6. Select the service account you want the HMAC key to be associated with.
7. Click Create key.
8. Copy and save in the text file the values of these two fields:

• Access key
• Secret

Note: You will use these values when you create the storage connection in Cognos Analytics.

Table 79. Mapping service credentials from GCP to Cognos Analytics

Property in GCP service credentials Related property when you configure Cognos
Analytics

Access key Access key ID

Secret Secret access key

Storage URI Service endpoint

Step 5: Create a bucket
Follow the steps in Creating storage buckets.

Tips for Cognos Analytics administrators:

• When you select from the Location list, make a note of the region. You must select this same value later
when you configure Cognos Analytics to add a location to your connection.

• In the Access control field, choose Uniform, so that all content in the bucket has the same permissions.
• In the Advanced settings (optional) > Encryption field, select Google-managed key, and then click

CREATE.
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Creating a storage connection in Cognos Analytics
Create a storage connection in Cognos Analytics to integrate an existing cloud storage service with
Cognos Analytics.

This is the second stage in configuring Cognos Analytics to save to cloud.

Client computerCloud Object 
Storage server

Cognos Analytics 
servers

On-premises networkThe cloud

Before you begin
You must set up a storage service with a Cloud Object Storage provider before you can configure Cognos
Analytics to connect to it.

Procedure
1. Click Manage > Storage.

The Cloud storage page appears. If any connections exist, they appear in the Connection list.

2. Click the Create connection icon .
3. Enter a name for your connection.
4. In the Type field, select the cloud object storage provider with which you created a connection.
5. Enter the access key ID and the secret access key.

Tip: These values were generated when you created your credentials in your cloud object storage
account. For more information, see “Determining the access key ID and the secret access key” on
page 242.

6. If you selected Other in the Type field, enter the MinIo service endpoint.

Tip: For more information, see “Determining the service endpoint (MinIO only)” on page 244

7. Click  Test.

•  Test success indicates that the connection is configured properly.

•  Test failed indicates that the connection is not configured properly. Try this solution.
8. Click Create and continue.

The connection is created and the wizard advances to the Add location page.

What to do next
Your next step is to add a location to the connection that you just created.

Determining the access key ID and the secret access key
You must find out the access key ID and the secret access key for your storage provider before you can
configure Cognos Analytics to connect to the storage service.

Choose the procedure for your storage object provider:

• IBM
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• Amazon
• MinIO

Procedure for IBM Cloud Object Storage
1. If you haven't yet done so, create your service credentials.

a. Log in to the IBM Cloud console and navigate to your instance of Object Storage.
b. In the side navigation, click Service Credentials.
c. Click New credential and provide the necessary information. If you want to generate HMAC

credentials, click on Advanced Options to reveal the 'Include HMAC Credential' option. Verify
the option is selected before continuing.

d. Click Add to generate service credential.
2. Make a note of the values of the COS properties listed in the following table. You will need these values

later when you configure Cognos Analytics to connect to this IBM Cloud Object Storage connection.

Table 80. IBM COS access key and secret access key

Property in IBM COS service credentials Related property when you configure Cognos
Analytics

apikey Access Key ID

resource_instance_id Secret access key

Procedure for Amazon Simple Storage Service
1. Create a new access key and secret access key (https://docs.aws.amazon.com/general/latest/gr/

managing-aws-access-keys.html#create-aws-access-key) as part of your service credentials.

Tip: If you previously created an access key but did not record the secret access key, you must create
a new one and record the new secret access key.

2. Make a note of the values of the AWS properties listed in the following table. You will need these
values later when you configure Cognos Analytics to connect to this IBM Cloud Object Storage
connection.

Table 81. AWS access key and secret access key

Property in Amazon Web Services (AWS)
Management Console

Related property when you configure Cognos
Analytics

AWSAccessKeyId Access Key ID

AWSSecretKey Secret access key

Procedure for MinIO
In this example, we install MinIO on Windows and note the values that are required to configure Cognos
Analytics:

1. Install MinIO server on a Windows computer.
2. Create a folder C:\my_data_folder.
3. In a command line window, cd to the directory where you installed MinIO server.
4. Type minio.exe server C:\my_data_folder.

A list of parameters for your MinIO instance appears in the command window.
5. To configure Cognos Analytics later, make a note of these parameters:

• Access key
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• Secret access key
• Endpoint

Determining the service endpoint (MinIO only)
The service endpoint is a URL that is required when you configure Cognos Analytics to connect to a MinIO
storage environment.

In the following example, we install MinIO on Windows and note the Endpoint value.

Procedure
1. Install MinIO server on a Windows computer.
2. Create a folder C:\my_data_folder.
3. In a command line window, cd to the directory where you installed MinIO server.
4. Type minio.exe server C:\my_data_folder.

A list of parameters for your MinIO instance appears in the command window.
5. Make a note of the Endpoint value.

What to do next
You will enter the Endpoint value in the Service endpoint field when you create a MinIO connection in
Cognos Analytics.

Managing the connection list
After you create one or more connections, view the connection list to check each connection's properties
and status.

Before you begin
You must have created at least one connection.

Procedure
1. Click Manage > Storage.

The Connection list appears.

For example, see the following figure:
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Important: You may need to clear your browser's cache if the Modified date and time is not updated
correctly after you click Refresh.

In Firefox, open a private window. In Chrome, open an incognito window.

2. At the end of the row for your connection, click the ellipsis icon  and then click Properties.

A panel opens for the connection, showing the General tab.

• To grey out the connection name in the list and make the connection temporarily unavailable, click
Advanced and then select the Disable this entry check box.

Tip: The connection between the Cognos Analytics server and the cloud storage service is not
broken. If you deselect the check box, users can resume using the connection.

• To change the name of your connection, click the Edit icon  at the top of the panel and type a new
name.

3. Click the Connection tab.

• To reset the Access key ID and Secret access key fields, first update the security credentials for
your cloud storage service. Then determine the key values that you need to enter.

Important: For MinIO storage environments only, you must also update the Service Endpoint field in
your MinIO cloud storage environment. For more information, see “Determining the service endpoint
(MinIO only)” on page 244.

• Click  Test, and then click Save to ensure that any changes you made keep the connection up and
running.

4. To remove the connection from the list, click the ellipsis icon  at the end of the row, and then
click Delete.

Note: The storage service that you created in the cloud storage environment is not affected by the
removal of the Cognos Analytics storage connection.

Adding a location to a connection
Add a location to your connection that will serve as a container for reports that are saved to cloud. The
location in Cognos Analytics maps to a bucket that you created in your Cloud Object Storage environment.
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Procedure
1. Click Manage > Storage.

The Cloud storage page appears.
2. Click the connection to which you want to add a location.

The Location list page appears.

Tip: If this message appears:  Error accessing cloud storage connection 'connection_name', try this
solution.

3. Click the Create location icon  or, if no locations exist yet, click Add location.
The Add location page appears.

4. Enter a name for your location.
5. In the Select bucket field, select a bucket that you created using your Cloud Object Storage service.
6. If you want, enter a key prefix.

Tip: Key prefix is an optional field that acts like a folder in your cloud object storage environment. If
you do not enter a key prefix value, your objects are saved at the root of your bucket.

• If you enter a key prefix for an Amazon S3 bucket, and a user saves a report to that bucket:

– The report is copied to a folder in the bucket in the Amazon S3 environment.
– The folder name is the same as the key prefix value.
– Example

A Cognos Analytics user saves the report Product line revenue to the cloud, and selects an
AWS service and a bucket that was assigned the key prefix value Revenue. The user selects PDF
and Excel formats and English (New Zealand) as the language.

Result

The report output files Product line revenue-en-nz.xlsx and Product line revenue-
en-nz.pdf appear in the Amazon Management Console, in the location aws_service_name/
aws_bucket_name/Revenue.

• If you enter a key prefix for an IBM COS bucket, and a user saves a report to that bucket:

– Note: A folder is not created in the bucket in the IBM COS console. Instead, the report appears in
the list of bucket objects with key_prefix_value/ prepended to the report name.

– Example

A Cognos Analytics user saves the report Product line revenue to the cloud, and selects an
IBM COS service and a bucket that was assigned the key prefix value Revenue. The user selects
PDF and Excel formats and English (New Zealand) as the language.

Result

The report output files Revenue/Product line revenue-en-nz.xlsx and Revenue/
Product line revenue-en-nz.pdf appear in the IBM COS console, in the location
ibm_cos__service_name/ibm_cos_bucket_name.

• If you enter a key prefix for an MinIO bucket, and a user saves a report to that bucket:

– The report is copied to a folder in the bucket in the MinIO browser.
– The folder name is the same as the key prefix value.

7. Select the region.

Important: You must choose the same region that was used when you created your bucket in your
cloud object storage environment. For more information, see “Determining the region for your Cognos
Analytics bucket” on page 247.

8. Click  Test.
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•  Test success indicates that the location is configured properly.

•  Test failed indicates that the location is not configured properly. Try this solution.

What to do next
After you add a location successfully, Cognos Analytics users can save their report output in this cloud
location. For more information, see “Saving output to cloud” on page 249.

Determining the region for your Cognos Analytics bucket
For AWS or IBM storage types, you must ensure that the region you select in your Cognos Analytics
location matches the region or location that you chose when you created a bucket in your cloud storage
environment.

Choose the procedure for your storage object provider:

• IBM
• Amazon

Note: MinIO storage configuration does not contain a region value.

Steps for IBM Cloud Object Storage
1. Go to your IBM Cloud Resource List (https://cloud.ibm.com/resources).
2. Expand Storage and click on your Cloud Object Storage (COS) service.

A list appears showing the buckets for your COS service.
3. In the row for the bucket you want, find the value in the Location column.
4. Make a note of the Location value.

Tip: You will enter this value in the Region field when you add an IBM location in Cognos Analytics.

Steps for Amazon Simple Storage Service
1. Go to your list of S3 buckets in the AWS Management Console. (https://

s3.console.aws.amazon.com/s3/home).
2. In the row for the bucket you want, find the value in the Region column.
3. Make a note of the Region value.

Tip: You will enter this value in the Region field when you add an Amazon location in Cognos Analytics.

Using a key prefix
If you want, you can specify a key prefix when you configure a bucket in Cognos Analytics. If you plan
on storing many reports on the cloud, a key prefix provides a method of sorting many report objects into
different categories.

A key prefix can result in different file structures of saved report output, depending on which storage
solution you are using:

• If you enter a key prefix for an Amazon S3 bucket, and a user saves a report to that bucket:

– The report is copied to a folder in the bucket in the Amazon S3 environment.
– The folder name is the same as the key prefix value.
– Example

A Cognos Analytics user saves the report Product line revenue to the cloud, and selects an
AWS service and a bucket that was assigned the key prefix value Revenue. The user selects PDF and
Excel formats and English (New Zealand) as the language.
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Result

The report output files Product line revenue-en-nz.xlsx and Product line revenue-
en-nz.pdf appear in the Amazon Management Console, in the location aws_service_name/
aws_bucket_name/Revenue.

• If you enter a key prefix for an IBM COS bucket, and a user saves a report to that bucket:

– Note: A folder is not created in the bucket in the IBM COS console. Instead, the report appears in the
list of bucket objects with key_prefix_value/ prepended to the report name.

– Example

A Cognos Analytics user saves the report Product line revenue to the cloud, and selects an IBM
COS service and a bucket that was assigned the key prefix value Revenue. The user selects PDF and
Excel formats and English (New Zealand) as the language.

Result

The report output files Revenue/Product line revenue-en-nz.xlsx and Revenue/
Product line revenue-en-nz.pdf appear in the IBM COS console, in the location
ibm_cos__service_name/ibm_cos_bucket_name.

• If you enter a key prefix for an MinIO bucket, and a user saves a report to that bucket:

– The report is copied to a folder in the bucket in the MinIO browser.
– The folder name is the same as the key prefix value.

Managing the location list
After you create one or more locations, view the location list to check each location's properties and
status.

Before you begin
You must have created at least one location.

Procedure
1. Click Manage > Storage.

The Connection list appears.
2. Click a connection.

The Location list appears.

For example, see the following figure:

3. Click a location.
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4. At the end of the row for your location, click the ellipsis icon  and then click Properties.

A panel opens for the location, showing the General tab.

• To grey out the location name in the list and make the location temporarily unavailable, click
Advanced and then select the Disable this entry check box.

Tip: The connection between the Cognos Analytics server and the cloud storage service is not
broken. If you deselect the check box, users can resume using the location.

• To change the name of your location, click the Edit icon  at the top of the panel and type a new
name.

5. Click the Location tab.

• If you want to switch to a different bucket, select it from the pulldown menu.

Important: For IBM and Amazon storage environments only, you must then select the region that
you selected when you created the bucket in your cloud storage environment. For more information,
see “Determining the region for your Cognos Analytics bucket” on page 247.

• If you want to add or modify a key prefix, enter the value in the Key prefix field. For more
information, see “Using a key prefix” on page 247.

• Click  Test, and then click Save to ensure that any changes you made keep the location up and
running.

6. To remove the location from the list, click the ellipsis icon  at the end of the row, and then click
Delete.

Note: The storage service that you created in the cloud storage environment is not affected by the
removal of the Cognos Analytics storage connection.

Testing saved outputs to cloud
To test that you enabled cloud storage correctly, you can perform these tasks:

1. Save a report to the cloud
2. Confirm that the output was saved to the cloud

Saving output to cloud
Save a report to cloud as the first step in testing that you enabled cloud storage correctly.

Before you begin
Before you can save report output to the cloud, you must first create a connection with a Cloud Object
Storage provider and then second create a storage connection in Cognos Analytics.

Procedure

1. In a folder, for the report that you want to run, click the More button  and then click  Run as.
2. Select an output format.
3. Select Run in background, click Advanced, and then follow these steps:

a) Select Now for when you want the report to run.
b) In the Languages field, select one or more output languages.
c) In the Delivery field, select the Save to cloud check box and then click Done.
d) If you want, change the report name.
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For example, append the current date and time to the name.
e) Click the Connection name field and select a connection that you configured in Cognos Analytics.
f) Click the Location name field and select a location that you configured in the connection.
g) Click Done.

4. Click Run.

Results
The report is saved to the cloud location.

What to do next
Your next step is to confirm that the output was saved to cloud.

Confirming that output was saved to cloud
Confirming that output was saved to cloud is the second step in testing that you enabled cloud storage
correctly.

Before you begin
Ensure that you saved a report to the cloud.

Procedure

1. In the application bar, click the Personal menu icon  icon, and then click My schedules and
subscriptions.

2. Click Schedule, click the Type icon , and then click Past.

The status (Succeeded or Failed) of the report run is shown in a list and on a graph.

3. To see additional details about the report run, click the More icon  next to the listing, and then click

 View versions.

4. Click the Open details icon  for the report version.

Additional information appears, such as:

• Start time of the report run
• End time of the report run
• Starting upload message for each version
• Finished upload message for each version

5. To view the output, go to your cloud storage location and navigate to the bucket or folder in which you
saved your Cognos Analytics output.

Tip: If you want users to view their saved output on the cloud, you must assign them appropriate
permissions to access the cloud storage location.

What to do next
After you confirm that Cognos Analytics output can be saved successfully to your cloud location, inform
other Cognos Analytics users that they can use this feature.

Troubleshooting cloud storage
You may encounter problems when managing cloud storage in Cognos Analytics.

This section describes some common issues and their potential solutions.
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Error accessing cloud storage connection
You try to create a location, but this error message appears:

 Error accessing cloud storage connection 'connection_name'.

Solution
Try these steps:

• Check that your access key and secret access key match the current values of your Cloud Object
Storage connection.

• Click  Test to test your connection.
• Clear your cache, or open a Private window (in Firefox) or Incognito window (in Chrome), restart Cognos

Analytics, and then try again to add a location.
• Check that your Cloud Storage environment is operating properly.

Test failed
You click  Test to test your connection or location, but this message appears:

 Test failed

Solution
Try these steps:

• If your failed test was for a new location, ensure that you selected the correct region. The region must
match the one you selected when you created a bucket in your Cloud Object Storage environment. For
more information, see “Determining the region for your Cognos Analytics bucket” on page 247.

Tip: If you think you know what the correct region should be, select that region and try the test again.
• If your failed test was for a new connection, check that your connection parameters were entered

correctly.
• Clear your cache, or open a Private window (in Firefox) or Incognito window (in Chrome), restart Cognos

Analytics, and then try again to add a location or connection.
• Check that your Cloud Storage environment is operating properly.

Cannot upload file to cloud
You try to upload a file to a cloud storage location, but the message Error uploading report_name
appears.

For example, you try to upload a file to an Amazon S3 storage service. The following message appears:

Error uploading report_name. Part number must be an integer between 1
and 10000, inclusive (Service: Amazon S3; Status Code: 400; Error Code:
InvalidArgument; Request ID: request_id)

This message can occur if the default size of data chunks delivered to the cloud during file uploads is too
small.

Solution
To prevent this issue, you can adjust the chunk size of uploaded files.
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Chapter 11. Cognos Analytics on Cloud On-Demand
Cognos Analytics on Demand is a version of Cognos Analytics on Cloud that is available to you digitally,
via self-service. The product is updated to the latest version upon availability. This offering has two tiers:
Standard and Premium.

Who should use Cognos Analytics On Cloud On-Demand?
You may want to register for Cognos Analytics On Cloud On-Demand if you meet these criteria:

•  You are willing to connect to data sources only when connected through a Secure Gateway or to one
of the supported on Cloud databases.

•  Your organization uses only one namespace.

•  You are willing to authenticate using IBMid or with an identity provider that is federated to IBMid.

•  You are not an existing on Demand customer.

•  You are willing to migrate all of your content in one move. You cannot perform partial imports.

Functionality
For a full list of functions and whether they are supported by Cognos Analytics On Cloud On-Demand, see
Cognos Analytics offerings.

Limitations
You should be aware that the Cognos Analytics On Cloud On-Demand offering has the following
limitations:

• If you are migrating from Cognos Analytics on Cloud Hosted:

– Your capability settings are not transferred.
– Default Cognos groups and roles are migrated. However, they lose all capabilities that were assigned

to them.
– If your default Cognos groups and roles were used to secure content, that security is maintained.

• You cannot secure certificates.
• Cognos Analytics On Cloud On-Demand does not support the following:

– Jobs
– IBM Cognos Administration console
– Default Cognos groups and roles. You can create new custom roles. However, you can use them only

to secure content; you cannot change the capabilities of a user, group, or role.
– Images and fonts
– Secure File Transfer Protocol (SFTP)
– Framework Manager
– Data sources that require SSL certification
– Power cubes and Transformer
– Compatible query mode (CQM)

https://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/prereqsForProduct?deliverableId=DA295E70A6F611E88A70560C75A2DCDE
https://ibm.ent.box.com/notes/78040808400?v=IBMid-Federation-Guide


Migrating to Cognos Analytics on Cloud On-Demand
If you are the administrator of Cognos Analytics on Cloud Hosted environment, you may want to migrate
to a Cognos Analytics on Cloud On-Demand environment.

Before you begin
Review information about the intended audience, functionality, and limitations of Cognos Analytics On-
Demand.

Important: You must be a member of the Directory Administrators role to perform this task.

About this task
Some Cognos data is not transferred during migration:

• Your capability settings are not transferred.
• Default Cognos groups and roles are migrated. However, they lose all capabilities that were assigned to

them.
• If your default Cognos groups and roles were used to secure content, that security is maintained.

Procedure
1. Contact your IBM sales representative to discuss whether a Cognos Analytics on Demand subscription

is a good fit for your organization.

Tip: If you decide to proceed with the migration, remember that you will be working closely with your
sales rep. You will be informed whenever there is something that you need to do. When you have a
question, your sales rep is your primary resource!

2. If your organization does not already authenticate using IBMid, you must federate your identity
provider to IBMid before migration begins.
For more information, see IBMid Enterprise Federation (https://www.ibm.com/docs/en/ief).

3. Ensure that you receive an invitation to your on Demand subscription and that you complete these
tasks:

• Accept your invitation as the on Demand subscription administrator.
• Invite all of your users to join the on Demand subscription.

Note: The users do not need to accept the invitations immediately. However, they must all be invited
so that the IBM team can validate their IBMIDs.

4. In your Cognos Analytics Hosted environment, remove any content and user profiles that you don't
want exported to your On-Demand environment.

5. If you want to import your samples to on Demand, rename the Samples folder.
6. Create a .csv file that contains information about every user in your namespace.

a) Obtain the file user-export-extension.zip from your sales rep and copy it to your computer.
b) Select Manage > Customization and then click the Extensions tab.

c) Click the Upload extension icon , navigate to the the file user-export-extension.zip, and
then click Open.

The name appears in the list of extensions.
d) Log out and then log back in to Cognos Analytics for the extension to take effect.

The User export view category appears in the navigation bar.
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e) Click User export view, and then navigate to Accounts > Namespaces > your_namespace_folder >
People

f) In the People panel, under your_namespace_folder, copy the value in the ID field.
g) Paste the ID value into the Namespace ObjectID field.

The User export view category appears in the navigation bar.

h) Click Query Users to review the list of users.

Tip: Remove or modify any users, as required.
i) Click Download CSV and save the .csv file to your computer.
j) Send the .csv file to the IBM team.

k) Remove the User export view extension after you are finished using it.
7. Create a deployment of your current environment:

a) In IBM Cognos Administration, on the Configuration tab, click Content Administration.

b) On the toolbar, click the New Export icon .
c) Name the archive.
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d) Select both Select the entire content store and Include user account information and then click
Next.

e) Set an encryption password that you will give to the IBM team so that they can import the content,
and then click Next.
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f) Review the summary information and click Next.
g) Under Action, select Save and run once and then click Finish.

A .zip deployment file is created in installation_location/deployment.
h) Copy the .zip deployment file and send it to the IBM team.

Tip: The IBM team will import this deployment to your On Demand environment.
8. If the IBM team discovers assets in your Team content folder without valid owners, they will send you

a list of the invalid owners and ask you how to proceed.

If this happens, proceed as follows:

a) Open the list in an editor.
b) Next to each invalid user name, enter the name of a valid user to whom the invalid user's content

can be reassigned.
c) Send the list back to the IBM team.

9. After the IBM team informs you that the migration is complete, re-establish your data source
connections by creating a Secure Gateway or by connecting to a supported database on the cloud.
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Managing your On-Demand subscription (for Subscription
administrators)

If you are a designated Subscription administrator for IBM Cognos Analytics on Cloud On-Demand, you
receive an email invitation to use the On- Demand version. You can then add and remove users to the
subscription, assign users, upgrade your subscription, and manage other subscription details.

Accepting an invitation to join a Cognos Analytics on Cloud On-Demand
subscription

After you accept an email invitation to join an IBM Cognos Analytics on Cloud On-Demand subscription,
you can log in to the subscription.

Note: The steps in this task are mostly the same for the two On-Demand subscription roles:

• Subscription administrators
• Licensed users

If you receive an email from IBM Cognos Analytics <noreply@us.ibm.com> inviting you to use IBM
Cognos Analytics on Demand, follow these steps:

Procedure
1. Open the invitation email and click Accept invite.

2. Log in with your IBM ID, if you have one. Otherwise, create your IBM account now (https://
www.ibm.com/account/profile).
The IBM Cognos Analytics Welcome page appears.

3. If you are a License user, you can start using Cognos Analytics right away. For more information, see
the Getting Started Guide.

4. If you want to view details about your subscription (if you are a License user) or manage the
subscription (if you are a Subscription administrator), do the following:
a) Click the Personal menu icon  in the application bar.
b) Click Manage product subscription.
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The Overview page for your IBM Cognos Analytics subscription appears.

If you are a Subscription administrator, the Overview page looks like this:

The following subscription levels appear:

• Cognos Analytics on Cloud - Premium
• Cognos Analytics on Cloud - Standard

Note: To help you plan your user assignments, note the number of seats already Assigned and the
number of seats still Available that are shown for the subscription you choose.

If you are a License user, the Overview page looks like this:

Note: The License user does not see any subscription level information. As they are not a
Subscription administrator, the License user cannot make any subscription changes or invite other
users.
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Logging in to your subscription
If you previously accepted the an email invitation and want to make changes to your subscription, you can
log in to your subscription Overview page from your IBM dashboard.

Follow these steps:

Procedure
1. Go to your My IBM dashboard (https://myibm.ibm.com/dashboard).
2. Log in to your IBM account, if you have one. Otherwise, create your IBM account now (https://

www.ibm.com/account/profile).

Your IBM dashboard appears, including a tile for your Cognos Analytics on Cloud subscription:

3. In the tile for your IBM Cognos Analytics on Cloud product, click Manage.

The Overview page for your IBM Cognos Analytics subscription appears:
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The following subscription levels appear:

• Cognos Analytics on Cloud - Premium
• Cognos Analytics on Cloud - Standard

Note: To help you plan your user assignments, note the number of seats already Assigned and the
number of seats still Available that are shown for the subscription you choose.

On-Demand subscription roles
There are two types of subscription roles in Cognos Analytics on Cloud On-Demand: subscription
administrators and license users.

Subscription administrator role
As the Subscription administrator, you can make the following changes to your registered IBM Cognos
Analytics on Cloud On-Demand plan:

• Add or remove users to the Standard or Premium subscription

Note: For a list of features available for each on Demand subscription level, see Cognos Analytics
offerings.

• Assign users to one of these role combinations:

– Subscription administrator role
– License user role
– Both the Subscription administrator role and the License user role

• Send an email to users inviting them to use Cognos Analytics on Cloud On-Demand
• Cancel the Cognos Analytics on Cloud On-Demand plan

License user role
License users can use Cognos Analytics on Cloud On-Demand with the functionality that is defined for
their subscription level. For example, if you registered them for a Standard subscription, License users will
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not be able to create reports. If you want the users to be able to create reports, you must upgrade them to
a Premium subscription.

The following table shows the Cognos Analytics functionality that is available for the Standard and
Premium subscription levels:

Functionality Standard Premium

Dashboarding Yes Yes

Stories Yes Yes

Exploration Yes Yes

AI Assistant Yes Yes

Mobile app Yes Yes

Reporting: Create or Edit reports No Yes

Reporting: Run reports (in html, csv, Excel, and other formats) No Yes

Reporting: Schedule reports and jobs No Yes

Reporting: Save report output in Cognos No Yes

Reporting: Set report bursting No No

Reporting: Receive burst reports No No

Reporting: View saved report output (1) Yes Yes

Reporting: Receive reports sent by email (2) Yes Yes

Reporting: View and interact with active reports Yes Yes

Note: Please note the following clarifications:

1. Viewing the saved report output is not the same as running a report. Standard users can view a report
output file (html, csv, and so on) if it was saved by a Premium user in Team content.

2. Receiving reports by email is not the same as receiving burst reports. For example, the Premium users
can choose the Send report by email delivery option, and add standard users' emails to the list of
recipients.

The License users can perform these tasks:

• Remove themselves from the subscription.
• Launch and use Cognos Analytics on Cloud On-Demand.
• In Cognos Analytics on Cloud On-Demand, create custom groups and roles in the Cognos namespace to

which content can be secured.

Important notes about Cognos namespace groups and roles:

– The two Cognos Analytics on Cloud On-Demand subscription roles (Subscription administrators and
License users) serve a different purpose than the Cognos namespace roles.

– In Cognos Analyticson Cloud On-Demand, the standard built-in groups and roles in the Cognos
namespace do not exist.

Adding users to your On-Demand subscription
If you are a Subscription administrator for IBM Cognos Analytics on Cloud On-Demand, you can add users
to your subscription. During this task, you assign each user to the Subscription administrator role, the
License user role, or both.

Important notes about Cognos namespace groups and roles:
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• The two On-Demand subscription roles (Subscription administrators and License users) serve a
different purpose than Cognos namespace roles.

• In Cognos Analytics on Cloud On-Demand, the Standard built-in groups and roles in the Cognos
namespace do not exist.

About this task
After you complete this task, an email is sent to the user(s) inviting them to use IBM Cognos Analytics on
Cloud On-Demand

Procedure
1. Log in to your subscription.
2. In the navigation pane, click Manage users.

The Manage Users page appears:

3. If you want to add a single user, follow these steps:
a) Click Add new user.
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b) Enter the first name, last name, and email of the user.
c) Select one or both of these check boxes:

• Subscription administrator

Tip: It's a good practice to have at least two Subscription administrators.
• License user for one of these subscriptions:

– Cognos Analytics on Cloud - Premium
– Cognos Analytics on Cloud - Standard

d) Click Submit.

e) Click the down chevron icon  at the end of the row containing the user's name to expand the
user's information.
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In the figure above, notice that the user Status now listed as Pending, as the invitation has not
been accepted yet. Also, you have the option of resending the invitation if it was not received or it
has expired.

4. If you want to add several users at once, follow these steps:
a) Click Add multiple users.
b) Click Use this CSV file to upload multiple users.
c) Edit the template add-multi-users.csv to list each user's name, email address, and license

role(s).
d) Save the file.
e) Click Select file and then browse to the file you just edited.
f) Click Upload.

Tip: You may need to wait a few minutes for the subscription to be updated with the new users.

Results
When you are done, the list of users is refreshed on the Manage users page.

An email is sent to all of the users inviting them to use IBM Cognos Analytics on Cloud. A Licensed user
receives the same email invitation that you received and accepted as the Subscription administrator.

After users accept the invitation, the number of Assigned seats and the number of Available seats
shown on the Overview page are updated accordingly.

Removing users from the On-Demand subscription
If you are a Subscription administrator for IBM Cognos Analytics On Cloud On-Demand, you can remove
users from your subscription.

When a user is removed, any public content they created will remain. However, any content in the My
Content folder will be lost. Adding a user back to the subscription will not restore their My Content.

For each user you want to remove, follow these steps:
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Procedure
1. Log in to your subscription.
2. In the navigation pane, click Manage users.

The Manage Users page appears:

3. Locate the user.

Tips:

• Search on partial text in the user's name, email, or IBM ID.
• Click License users, Subscription administrators, or Pending invitations to filter on that category.
• Click Filter to filter on the user's status.

4. Click the down chevron icon  at the end of the row containing the user's name to expand the user's
information.
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5. If you want to remove the user from your subscription, click Remove user.
6. If you want to change the role of the user, change the check box selections in the Roles section.

Note: If you leave both the Subscription administrator and the License user check boxes unselected,
the user will be removed from the subscription.

7. Click Save.

Results
The user is removed from the subscription or their role is updated, depending on what you selected.

Note: Users can also remove themselves from the subscription by selecting Remove me as a user in the
navigation menu their my dashboard menu. See the following figure:

Upgrading your trial subscription
If you have an IBM Cognos Analytics Cloud Trial subscription, you can upgrade at any time to a plan that
provides you with a richer user experience.

Note: The Trial subscription provides the same capabilities as the Premium offering, so keep that in mind
when you upgrade.

Procedure
1. Go to your My IBM dashboard (https://myibm.ibm.com/dashboard).
2. Log in to your IBM account.
3. In the tile for IBM Cognos Analytics on Cloud, click Manage.

The Overview page for your IBM Cognos Analytics Trial subscription appears:
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4. Click Upgrade or scroll down to view details about available IBM Cognos Analytics On Demand or
Enterprise solutions.

5. Click Purchase now or Contact us to proceed with your upgrade.

Securing your content (for on On-Demand License users)
If you are a designated License user for IBM Cognos Analytics on Cloud On-Demand, you can secure your
Cognos Analtyics content. You can accomplish this in Cognos Analytics on Cloud On-Demand by assigning
permissions to custom groups and roles that you created in the Cognos namespace folder.
Custom groups and roles in the Cognos namespace

Groups  and roles in the Cognos namespace folder represent collections of users that perform
similar functions, or have a similar status in an organization. Examples of groups are Employees,
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Developers, or Sales Personnel. Members of groups can be users and other groups. When users
log on, they cannot select a group they want to use for a session. They always log on with all the
permissions associated with the groups to which they belong.

Roles  in IBM Cognos software have a similar function as groups. Members of roles can be users,
groups, and other roles.

The following diagram shows the structure of groups and roles.

Role

User

Group

Group Group RoleUser

Figure 6. Structure of groups and roles

Users can become members of groups and roles defined in IBM Cognos software, and groups and
roles defined in authentication providers. A user can belong to one or more groups or roles. If users
are members of more than one group, their access permissions are merged.

Procedure
1. Create custom groups and roles in the Cognos namespace folder.

Tip: You cannot change the capabilities of a user, group, or role. Capabilities are determined by the
user's on Demand subscription level.

2. Decide which groups or roles should have access to your content.
3. assign group or role permissions to your selected content.

IBM Secure Gateway (On-Demand only)
Use IBM Secure Gateway to maintain an encrypted connection between an on-premises Secure Gateway
Client and the Secure Gateway Servers that IBM maintains on Cloud. This allows you to use IBM Cognos
Analytics on Cloud On-Demand to securely consume your on-premises data.

Secure Gateway at a glance 
First, you install the Secure Gateway Client in your on-premises network and configure an encrypted
(TLS v1.2) bi-directional connection with the on Cloud Secure Gateway server. Next, you establish a
secure connection between the Secure Gateway Client and an on-premises database. This on-premise
database is called the "destination database". Your on-premises data can then be securely accessed and
manipulated by Cognos Analytics on Cloud On-Demand.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Note: IBM Secure Gateway is only available for use with Cognos Analytics on Cloud On-Demand. IBM
Secure Gateway is not supported for Cognos Analytics on Cloud Hosted users. For more information, see
Chapter 6, “Tenant administration,” on page 111.
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For more info
For more information about IBM Secure Gateway, see the following resources:

• About Secure Gateway (https://cloud.ibm.com/docs/services/SecureGateway?topic=securegateway-
about-sg

• Frequently Asked Questions (https://cloud.ibm.com/docs/services/SecureGateway?
topic=securegateway-sg-faq)

• Troubleshooting (https://cloud.ibm.com/docs/services/SecureGateway?topic=securegateway-
troubleshooting)

Creating a Secure Gateway instance
Creating a Secure Gateway instance is the first step in establishing a connection between the IBM Secure
Gateway server and your on-premises data.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Procedure
1. Click Manage > Secure Gateway.

• If no Secure Gateway instances exist yet, the Secure Gateway page appears.
• If other gateways exist, the Secure Gateway list appears.

2. Launch the Connect to an on-premises database wizard.

• If you are on the Secure Gateway page, click Create.

• If you are on the Secure Gateway list page, click the Add Gateway button .
3. Enter a name for the gateway.

Note: You can ignore the token expiration value for now. It refers to the security token that will be
generated for your new gateway.

4. Click Create.

The gateway instance is created and the wizard advances to the next page.

What to do next
Your next step is to install and configure the Secure Gateway Client.
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Viewing the Secure Gateway list
After you create one or more Gateways, view the Secure Gateway list to check each gateway's properties
and status.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
You must have created at least one Secure Gateway instance.

Procedure
1. Click Manage > Secure Gateway.

The Secure Gateway list appears.

Important: You may need to clear your browser's cache in these cases:

• if the message below appears, and you have not yet hit the maximum number of gateways allowed
for your user license type:

You have exceeded the maximum number of secure gateways.
• if the Gateway connection value was not refreshed

In Firefox, open a private window. In Chrome, open an incognito window.
2. Check the Gateway connection value for your gateway:

• If the value is Connected, you are ready to add a destination database.

• If the value is  Not connected, you must:

a. Install the Secure Gateway Client.
b. Configure the Secure Gateway Client to connect to your gateway.

• If the value is  Token expired, you must refresh your token:

a. At the end of the row for your gateway, click the ellipsis button .
b. Click Properties.
c. Click Refresh security token.

A new security token is generated for your secure gateway.

• If the value is Invalid, the gateway cannot be used. At the end of the row for your gateway, click

the ellipsis button , click Delete and then create a new gateway.
3. Check the Status value for your gateway:

• If it is Enabled, your gateway is available for connection to a destination database.

• If it is  Disabled, your gateway is not available.
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Tip: You can enable the gateway in step “4” on page 272.

4. At the end of the row for your gateway, click the ellipsis button  and then click Properties.

The Secure Gateway properties page appears, showing information such as:

• the Gateway ID and the Security token. Use these values to configure your Secure Gateway Client.
• whether there is a connection with a Secure Gateway Client
• the gateway status

Tip: Click this field to toggle between Enabled and Disabled.
• The Secure Gateway client list. To expand a Secure Gateway Client connection, click the chevron

button  next to the name of the client host.

What to do next
To view the Destinations list, click the gateway name.

Installing and configuring the Secure Gateway Client
Installing and configuring the Secure Gateway Client is the second step in establishing a connection
between the IBM Secure Gateway server and your on-premises data.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.

Install and configure the Secure Gateway Client so that it can establish connections with both the IBM
Secure Gateway on Cloud server and with an on-premises database that will use the Secure Gateway.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Installation requirements
For information about system and network requirements, see Requirements to run the Client (https://
cloud.ibm.com/docs/services/SecureGateway?topic=securegateway-client-requirements).

Installing Secure Gateway Client using IBM Installer
You can run the IBM Installer to install Secure Gateway Client on several different platforms:

• AIX
• Ubuntu
• Windows
• Red Hat
• Macintosh
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Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Installing on Windows using IBM Installer
On Windows, use the IBM Installer to install IBM Secure Gateway Client.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
Install the Secure Gateway into your IT environment where your corporate security policy allows. This
would typically be in a protected yellow zone or DMZ where your company can institute the appropriate
security controls to protect on-premises assets. Always follow your corporate security policies and
instructions when you install the Secure Gateway client.

Procedure
1. Ensure that you created a Secure Gateway instance.
2. Select IBM Installer and then click Next.
3. Under Operating system, select Windows.
4. Click Download client.
5. Follow the prompts to install the IBM client.

6. Copy  the Gateway ID and Security token values into a text file for later use.

Tip: You will need these values when you configure the client.
7. Click Next.

The Secure Gateway Client is installed and configured and the wizard advances to the next page.

What to do next
Your next step is to add an on-premises destination database.
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Installing on AIX using IBM Installer
On AIX, use the IBM Installer to install IBM Secure Gateway Client.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
Install the Secure Gateway into your IT environment where your corporate security policy allows. This
would typically be in a protected yellow zone or DMZ where your company can institute the appropriate
security controls to protect on-premises assets. Always follow your corporate security policies and
instructions when you install the Secure Gateway client.

Procedure
1. Ensure that you created a Secure Gateway instance.
2. Select IBM Installer and then click Next.
3. Under Operating system, select AIX.
4. Click Download client.
5. Follow the prompts to install the IBM client.

6. Copy  the Gateway ID and Security token values into a text file for later use.

Tip: You will need these values when you configure the client.
7. Click Next.

The Secure Gateway Client is installed and configured and the wizard advances to the next page.

What to do next
Your next step is to add an on-premises destination database.

Installing on Ubuntu using IBM Installer
On Ubuntu, use the IBM Installer to install IBM Secure Gateway Client.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.
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Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
Install the Secure Gateway into your IT environment where your corporate security policy allows. This
would typically be in a protected yellow zone or DMZ where your company can institute the appropriate
security controls to protect on-premises assets. Always follow your corporate security policies and
instructions when you install the Secure Gateway client.

Procedure
1. Ensure that you created a Secure Gateway instance.
2. Select IBM Installer and then click Next.
3. Under Operating system, select Ubuntu.
4. Click Download client.
5. Follow the prompts to install the IBM client.

6. Copy  the Gateway ID and Security token values into a text file for later use.

Tip: You will need these values when you configure the client.
7. Click Next.

The Secure Gateway Client is installed and configured and the wizard advances to the next page.

What to do next
Your next step is to add an on-premises destination database.

Installing on Red Hat using IBM Installer
On Red Hat, use the IBM Installer to install IBM Secure Gateway Client.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database
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Before you begin
Install the Secure Gateway into your IT environment where your corporate security policy allows. This
would typically be in a protected yellow zone or DMZ where your company can institute the appropriate
security controls to protect on-premises assets. Always follow your corporate security policies and
instructions when you install the Secure Gateway client.

Procedure
1. Ensure that you created a Secure Gateway instance.
2. Select IBM Installer and then click Next.
3. Under Operating system, select Red Hat.
4. Click Download client.
5. Follow the prompts to install the IBM client.

6. Copy  the Gateway ID and Security token values into a text file for later use.

Tip: You will need these values when you configure the client.
7. Click Next.

The Secure Gateway Client is installed and configured and the wizard advances to the next page.

What to do next
Your next step is to add an on-premises destination database.

Installing on Macintosh using IBM Installer
On Macintosh, use the IBM Installer to install IBM Secure Gateway Client.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
Install the Secure Gateway into your IT environment where your corporate security policy allows. This
would typically be in a protected yellow zone or DMZ where your company can institute the appropriate
security controls to protect on-premises assets. Always follow your corporate security policies and
instructions when you install the Secure Gateway client.

Procedure
1. Ensure that you created a Secure Gateway instance.
2. Select IBM Installer and then click Next.
3. Under Operating system, select Macintosh.
4. Click Download client.
5. Follow the prompts to install the IBM client.
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6. Copy  the Gateway ID and Security token values into a text file for later use.

Tip: You will need these values when you configure the client.
7. Click Next.

The Secure Gateway Client is installed and configured and the wizard advances to the next page.

What to do next
Your next step is to add an on-premises destination database.

Installing a Docker image that contains the Secure Gateway Client
Instead of using the IBM installer to install Secure Gateway Client, you can install a Docker image that
contains the Secure Gateway Client.

Note: If you are viewing the Add client page on the wizard, but already installed Secure Gateway Client,
do the following:

1. Select I have already installed the client and click Next.
2. Proceed to “Adding a destination” on page 281.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Procedure
1. Ensure that you created a Secure Gateway instance.
2. Select Install Docker and follow the prompts.

For more information, see About Docker CE (https://docs.docker.com/install/).

Tip: On Linux, you can add -h `hostname` to your Docker bash shell. This will return the name of the
system that Docker is hosted on, rather than the Docker ID.

3. Open a command window.

4. Copy  and run the Docker pull command.

5. Copy  and run the Docker run command with security token.
6. Click Next.

The Secure Gateway Client is installed and configured and the wizard advances to the next page.

What to do next
Your next step is to add an on-premises destination database.
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Configuring Secure Gateway Client
Configure your Secure Gateway Client to connect to your Secure Gateway instance.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Procedure
1. Start the Secure Gateway Client that you installed on your on-premises computer.

2. In the upper-right corner of the Secure Gateway Client window, click the plus sign button .

You are prompted for the Gateway ID and the Security Token.

3. Enter the Gateway ID and Security Token values from the Properties page when you view the Secure
Gateways list.

4. Click CONNECT.
5. Go to the Secure Gateways list page,.

The status shows as Not connected.

6. Click  Refresh.
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The status changes to Connected. This confirms that your Secure Gateway client is connected to
your Secure gateway instance on the cloud.

What to do next
You can now connect to a destination or view the properties of your Secure Gateway Client.

Viewing the Secure Gateway Client properties
After you create a Secure Gateway instance and connect one or more Secure Gateway Client instances
to it, you can view the Secure Gateway properties. This allows you to check on the gateway-client
connection or troubleshoot issues.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
You must have created at least one Secure Gateway instance and configured at least one Secure Gateway
Client connection.

Procedure
1. Click Manage > Secure Gateway.

The Secure Gateway list appears.

2. At the end of the row for your gateway, click the ellipsis button  and then click Properties.

The Secure Gateway properties page appears. At the bottom, is a list of all Secure Gateway client
connections to the current gateway.

3. To expand a Secure Gateway Client connection, click the chevron button next to the name of the
client host.

Client properties appear, such as the its connection status and the client ID.
4. To check the performance of your Secure Gateway client-server connection, click Latency test.
5. To troubleshoot client-server connection issues, click View client logs.

Testing latency
You can run a latency test on your Secure Gateway client-server connection. This test measures how long
it takes for data to travel back and forth between your local Secure Gateway Client and the on-cloud
Secure Gateway server.

For more information, see Understanding latency (https://cloud.ibm.com/docs/infrastructure/direct-link?
topic=direct-link-understanding-latency).
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Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Procedure
1. Click Manage > Secure Gateway.

The Secure Gateway list appears.

Tip: If you just completed your connection, but the Gateway connection value for your gateway is 

Not connected, click Refresh to update the value to Connected.

2. At the end of the row for your gateway, click the ellipsis button  and then click Properties.
3. At bottom of the Secure Gateway properties page, under Secure Gateway client, expand the name

of the computer where you installed Secure Gateway Client.
4. Click Latency test.

Results
The Server-Client Latency and the Client-Server Latency times are displayed, in milliseconds.

Client logs
Client logs record events related to the connection between IBM Secure Gateway Client and the IBM
Secure Gateway server.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Viewing log messages
To view the log messages, follow these steps:

1. Click Manage > Secure Gateway.

The Secure Gateway list appears.

Tip: If you just completed your connection, but the Gateway connection value for your gateway is 

Not connected, click Refresh to update the value to Connected.

2. At the end of the row for your gateway, click the ellipsis button  and then click Properties.
3. At bottom of the Secure Gateway properties page, under Secure Gateway client, expand the name

of the computer where you installed Secure Gateway Client.
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4. Click View client logs.

If a log message is unclear, consult with your administrator about possible actions that you should take.

Adding a destination
Adding a destination is the third step in establishing a connection between the IBM Secure Gateway
server and your on-premises data.

Add a destination to define the on-premises database that you will associate with your gateway.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Procedure
1. Ensure that you installed and configured the IBM Secure Gateway Client.

If you clicked Next after installing and configuring the Secure Gateway Client, the Add destination
page appears.

2. If you previously installed and configured the Secure Gateway Client and then exited the wizard, follow
these steps:
a) Click Manage > Secure Gateway.
b) On the Secure Gateway list page, click your gateway.

c) On the Destination list page, click the Add destination button .

The Add destination page appears.
3. Enter a name for your destination.

Tip: Include the database type in the name.
4. Enter the computer host name and port number for your database.
5. Click Next.

The destination is added and will appear on the destination list the next time you view it.

What to do next
Your next step is to specify valid destination databases that can be accessed by the Secure Gateway.
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Viewing the Destinations list
After you create one or more Destinations, view the Destinations list to check each Destination's
properties and status.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Before you begin
You must have added at least one Destination.

Procedure
1. Follow the steps to view the Secure Gateway list.
2. In the Secure Gateway list, click the gateway name.

The Destinations list appears.
3. Check the Destination connection value for your destination:

Important: You may need to clear your browser's cache before the Destination connection value is
refreshed. In Firefox, open a private window. In Chrome, open an incognito window.

• If the value is Connected, you are connected to the destination host.

• If the value is Blocked by ACL, click the Blocked by ACL link to configure the Access Control List
for your destination.

• If it is Invalid, there are two possibilities:

a. The Secure Gateway service may be temporarily unavailable. In this case, the destination

connection is still valid, and will show as Connected after the service becomes available.
If your destination connection originally was valid, check the Destinations list later. You can then
confirm that the Destination connection value is no longer Invalid and that the Secure Gateway
service is therefore running again.

b. The destination cannot be used. At the end of the row for your destination, click the ellipsis

button , click Delete and then add a new destination.
4. Check the Status value for your destination:

• If it is Enabled, your destination is available for connection to a Secure Gateway.

• If it is  Disabled, your destination is not available.

Tip: You can enable the destination in step “5” on page 282.

5. At the end of the row for your destination, click the ellipsis button  and then click Properties.

The Destination properties page appears, showing information such as:

• the Destination host name and port number. Use this value when you create a data server connection
on the destination computer.
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• the Destination status

Tip: Click this field to toggle between Enabled and Disabled.

• The Data server connection list. Click the chevron button to list any data server connections that
you already created.

Connecting to an on-premises destination database
Connecting to an on-premises destination database is the fourth step in establishing a connection
between the IBM Secure Gateway server and your on-premises data.

Connect the Secure Gateway Client to a destination database to allow on-premises data to be shared
securely with Cognos Analytics on Cloud on Demand.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Specifying which databases can be accessed
Edit the IBM Secure Gateway Access Control List (ACL) to identify your on-premises database as a valid
destination database for your Secure Gateway instance. This will allow you to securely access your
on-premises data in IBM Cognos Analytics on Demand.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

The ACL is a file in which you list the names and port numbers of computers that are permitted to host
your on-premises data via the Secure Gateway.

For more detailed information, see Access Control List (https://cloud.ibm.com/docs/services/
SecureGateway?topic=securegateway-acl).

Editing the Access Control List
If you want to use the command line interface (Option 1), follow these steps:

1. Open a command window.
2. Run the following command:

acl allow database_hostname:port_number

where database_hostname is the name of the computer that hosts the database and port_number is
the port number of the database.

3. In the Connect to an on-premises database wizard, click OK.

Chapter 11. Cognos Analytics on Cloud On-Demand  283

https://cloud.ibm.com/docs/services/SecureGateway?topic=securegateway-acl


If you want to use the Secure Gateway Client interface (Option 2), follow these steps:

1. Start the Secure Gateway Client on your local computer.
2. Click Access Control List.
3. Under Allow access, enter the destination computer's name and port number.
4. In the Connect to an on-premises database wizard, click OK.

What to do next
Your next step is to create a data server connection on the destination computer.

Tip: You may already have set up a data server connection that you can use for your destination database.

Creating a data server connection on the destination computer
A data server connection specifies the parameters that are needed to connect to the destination database
for your Secure Gateway.

Note: Only relational databases can be used for Secure Gateway data server connections.

Destination 
database host

IBM Secure 
Gateway Server

Client computer Destination 
database

Each data server can have one or more connections. The connection names must be unique.

For information about data server connections that are not used as Secure Gateway destinations, see
“Data servers” on page 23.

Procedure
1. Click Manage > Data server connections.

2. In the Data server connections pane, click the Add data server icon  .
3. Select the data server type from the list of supported types.

Tip: You must select a relational data server type.
4. In the field New data server connection, type a unique name for the connection.
5. Beside Connections details, click Edit and enter the connection details for the type of connection that

you are creating.

Specify the JDBC URL. You can view the syntax and example URL under connection details. You might
need to ask the database administrator for more details, or check the database vendor documentation.

Important: The JDBC URL must contain only one host name and only one static port number.
6. In the Edit dataserver_type connection pane, under Secure Gateway destination, select the Gateway

and Destination names that you created.
7. Under Authentication method, specify how to access the data server.

You can select one of the following options.
Connect anonymously or Integrated security

Choose the Connect anonymously option when anonymous access to the data server is allowed.
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Prompt for the user ID and password

Choose this option when the user must be prompted for database credentials with each use.

Use an external namespace

Choose this option to secure the connection against a namespace that is configured for Cognos
Analytics. Use the drop-down menu to select one of the available namespaces.

Use the following signon

Choose this option to assign a signon for the connection.

Select the signon from the drop-down list, or create a new signon by clicking the add icon . In
the New data server connection window on the Credentials tab, type a user ID and password.

To restrict the signon to particular users, roles, or groups, on the Permissions tab, click the add

icon , and specify the access permissions for the signon.

Results
The new connection name is displayed in the Data server connections panel. To edit the data server
connection, including adding or modifying its signon, click the connection name.

What to do next
You are now ready to use Cognos Analytics on Demand with your on-premises data.

For more information, see the Cognos Analytics Data Modeling Guide.

Installing and configuring Framework Manager for Cognos
Analytics on Demand

Framework Manager can be used with the IBM Cognos Analytics on Demand offering only if the customer
has an existing support and subscription (S&S) for the on-premises offering. Otherwise, Framework
Manager is not available with the on demand offering.

The following conditions must be met for Framework Manager to connect to the Cognos Analytics on
Demand offering:

• You need an entitlement for the on-premises Framework Manager software.

For more information, see "Cognos Analytics offerings" in the IBM Cognos Analytics Getting Started
Guide.

• The dynamic query mode (DQM) must be enabled in Framework Manager.

Compatible query mode (CQM) is not supported on Cloud.
• Data source connections must be created from the Manage Cognos Analytics administration interface.

Data source connections that are created in Framework Manager are not visible in the Manage user
interface. For more information, see "Creating a data server connection" in the IBM Cognos Analytics
Manage Guide.

Before you begin
Cognos Analytics on Demand is always on the latest release. As a best practice, check IBM Fix Central
(www.ibm.com/support/fixcentral) first to see if there is a version of Framework Manager for the current
version of Cognos Analytics on Demand. If not, download the general release version of Framework
Manager from Passport Advantage (www.ibm.com/software/passportadvantage/index.html).
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Procedure
1. Download the latest version of the Framework Manager installation files from Passport Advantage for

general releases, or from Fix Central for an interim fix.

The names of files that you need to download use the format analytics-installer-
x.x.xxxxxxxx-win.exe and caclient-xx.x.x-xxxxxxxxxx.zip. An example of file
names for the 11.1.7 version of Cognos Analytics on Demand might be analytics-
installer-2.0.20100517-win.exe and caclient-11.1.7-2101190846.zip.

2. Run the installer file analytics-installer-x.x.xxxxxxxx-win.exe.
3. In the installation wizard, choose a language, and click Next.
4. Browse to the client installation media that you downloaded, and click Next.
5. Choose Cognos Analytics tools, and click Next.
6. Choose IBM Cognos Framework Manager, click Next, accept the license agreement, and click Next

again.
7. Set your installation location and shortcut folder, and click Next. Follow the rest of the wizard to

install Framework Manager.
8. Launch IBM Cognos Configuration for Framework Manager.
9. In the Explorer pane, click Environment.

10. In the Properties pane, set the Encrypt temporary files to True (as a best practice).
11. Set the following properties:

Gateway URI
Set this property to https://CA_Cloud_Name.ca.analytics.ibm.com:443/bi/v1/disp,
where CA_Cloud_Name should be replaced by your data center name.

Dispatcher URI for external applications
Set this property to https://CA_Cloud_Name.ca.analytics.ibm.com:443/bi/api/
soap, where CA_Cloud_Name should be replaced by your data center name.

In the following example, the CA_Cloud_Name is specified as us1.

12. From the File menu, click Save.

The Framework Manager configuration should be saved without error. However, if you receive the
following warning: “The cryptographic information cannot be encrypted. Do you want to save the
configuration in plain text?”, or encounter any general connectivity issues with Framework Manager,
ensure that the following is correct:
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• The Gateway URI and Dispatcher URI for external applications properties in Cognos
Configuration for Framework Manager.

Ensure that the data center portion of the URIs and the port number are correct.
• The Framework Manager version.

The Framework Manager version must be compatible with the Cognos Analytics on Demand
version.
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